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About This OptiInk User’s Guide
This OptiInk User’s Guide offers you a complete description of the OptiInk inter-
face and provides procedures and settings so you can work efficiently.

NOTE: The User’s Guide (CG+0955680001) is now a separate document from 
the Installation Guide (CG+0956910001).

Keyboard Conventions

All key names are shown in capital letters. For example, the Control key is shown 
as CTRL.

Keys are frequently used in combinations or sequences as shortcut keys. For 
example, SHIFT+F3 means to hold down the SHIFT key while pressing F3.

Mouse Conventions

To... Do this...

Click Point to an item, and then quickly press and release the mouse 
button without moving the mouse.

Double-click Point to an item, and then quickly press and release the mouse 
button twice.

Context-click on Windows Click the right mouse button.

Context-click on Macintosh Hold down the CTRL key while clicking the mouse button.

Drag Point to an item. Press and hold down the mouse button as you 
move the mouse to a new location, then release the mouse but-
ton.
3
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CHAPTER
1 :Arkitex OptiInk Setup

This manual is intended for qualified OptiInk and OptiInk Essentials operators. 
The main focus of this Guide is the use of the full product OptiInk client. Some 
server functions are also described. The OptiInk operator should have sufficient 
permissions to access the OptiInk functions covered in this Guide.
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10 OPTIINK ESSENTIALS
OptiInk Essentials

OptiInk Essentials provides a low-cost entry version of the OptiInk product. The 
main differences from the full product are:

A single hot folder for job entry

A single active workflow configuration to process all jobs

A single selection of the workflow configuration from a supplied set

Limitation of the configuration of the chosen workflow set ups

Limitation of the scalability of processing performance (number of 
processors)

The user interface layout, menus, views, and interaction are identical to the full 
product. Where functionality is restricted, then it will be grayed out or, where 
appropriate, hidden from the user.

OptiInk Essentials functionality will be indicated with the following icon at each 
feature point:

Launching OptiInk

After installation an OptiInk icon will appear on the desktop.

Launch OptiInk The following procedure describes how to launch OptiInk.

Steps

1 Click the OptiInk icon.

The launcher window will display.
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The time difference is 10 minutes for the client not to connect. A pop up will 
display.

The Launcher Script is set to warn on > 600 seconds (10 minutes). This can be 
changed by adjusting the number TIMEDIFF_WARNING at the start of the script.

Load License File The following procedure describes how to load the OptiInk license file.
:ARKITEX QUALITY OptiInk User’s Guide



12 LAUNCHING OPTIINK
Steps

1 Click Licensing > License Management.

NOTE: Product will be 
OptiInkEssentials when 
using OptiInk Essentials.

2 Select Load License File.

3 Locate the license file. It will have an *.alf extension.

o
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1 :ARKITEX OPTIINK SETUP 13
4 Click Open.

5 A Confirm message will appear. Click OK.

6 Click the “X” in the upper right-hand corner to close the License Management 
Utility.

7 To verify the license, refer to “Show License Info” on page 33.

Start Tasks The following procedure describes how to Start Tasks.

Steps

1 Select Tasks > Start All.
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2 Services will start to load. You will see messages appear on the screen.

Start the Client The following procedure describes how to start the Client.

Steps

1 Select Tasks > Start Client.
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2 The Client service will turn green when it starts.

3 The logon menu will display.

4 Enter the Administrator password, and click Login.

The OptiInk/OptiInk Essentials application will display.

0
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16 THE OPTIINK/OPTIINK ESSENTIALS LAUNCHER
NOTE: File paths in the database now reference localhost rather than the 
machine name where applicable to make it easier to move databases to different 
servers.

The OptiInk/OptiInk Essentials Launcher 

From the OptiInk/OptiInk Essentials Launcher you can do the following tasks:

Set Preferences

Start Tasks

Perform Database Maintenance

Load Licenses and Generate Fingerprint files.

Check the Version Level of OptiInk

-

Menu Options Description

File Refer to “Set Preferences” on page 17.

Preferences... Use to set the Licensing and J2EE Server 

hosts.

Exit Exits the OptiInk/OptiInk Essentials 

Launcher application.

Tasks “Start Tasks” on page 19.

Start All Starts all service components. The Start All 
menu item is disabled in Pure client mode.

Stop All Stops all service components.
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Set Preferences Preferences controls licensing and exiting Launcher.

Set Host

1 Select File > Preferences from the Launcher menu bar.

Start Client Starts the Client service.

Stop Client Stops the Client service.

Maintenance “Performing Database Maintenance” on 

page 21.

Remove Jobs And Logs Removes jobs and system logs from the 

database.

Backup Database Backs up the database to a defined location. 

All tasks must be stopped before backup.

Output Database to Text 
File

Exports workflows and hot folder settings to 

a text file.

Restore Database Restored the database from a pre-defined 

location.

Delete Database Deletes the database.

ZIP Logs The database can be backed up to a ZIP file. 

This will preserve all workflow and hot folder 

settings.

Licensing “Licensing” on page 28.

License Management Used to generate clean fingerprint files, fin-

gerprint files for dongle-less configurations, 

load the license file, and view license file 

information.

SISR “SISR” on page 33

Install ICC Profile... Used to install ICC profiles.

Remove ICC Profile... Used to remove ICC profiles.

Help “Help” on page 35

About Displays copyright information on OptiInk/

OptiInk Essentials, including version.

Menu Options Description
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Preferences supports primary and secondary licensing, and J2EE server set 
ups, as well as selecting the Role and number of Processors.

2 Under Licensing in the Primary Host field, enter the host ID. By default this 
is localhost.

3 Enter the Primary Port.

4 In the Secondary Host field, enter the host ID.

5 Enter the Secondary Port.

NOTE: You can point the server client away from the local server and display 
a different server installation. Enter the IP or host look-up name of a running 
ITX server (not the localhost). The client will operate fully as a remote client 
with the server entered in the J2EE host field.

6 Under J2EE Server, enter the Primary Host field. By default this is 
localhost.

7 Enter the Primary Port.

8 In the Secondary Host field, enter the host ID.

9 Enter the Secondary Port.

10 Under Role select the Role type:

Primary
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Secondary

Processing

Client Only

NOTE: The radio buttons may be grayed out depending on what software 
components have been installed.

NOTE: OptiInk Essentials is 
limited to one processor.

11 Enter the number of Processors for the Primary, Secondary, or Processing 
roles.

12 Select a number under Started.

13 Click OK to accept the entry, or Cancel to exit.

Start Tasks Tasks controls starting/stopping service components, auto start, and auto start 
client. By default when Launcher is first opened, no tasks are started.

Launch Service Components

1 Select File > Tasks > Start All.

2 The service components will begin to start, and messages will display across 
the screen.
:ARKITEX QUALITY OptiInk User’s Guide



20 THE OPTIINK/OPTIINK ESSENTIALS LAUNCHER
Activating Auto Start

1 To automatically start tasks when OptiInk is launched, select File > Tasks, 
then select the Auto Start option.

2 When the Tasks menu is displayed again, this item will display with a check 
mark.

Client

1 Select File > Tasks > Start Client.

o
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2 To stop the Client, select File > Tasks > Stop Client. Or use the shortcut 
menu and select Stop.

Stop Service Components

1 Select File > Tasks from the Launcher menu bar.

2 Select Stop All.

3 An application message will display. Click OK.

4 The service components will be grayed out as they are stopped.

Performing 
Database 
Maintenance 

When all the service components have been stopped, clicking File > 
Maintenance brings up the following selections:
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Remove Jobs And Logs Jobs and Log files will be removed.

Backup Database The database will be backed up as a Zip file to a location of your choice.

The database should be minimal with the least amount of jobs possible in the 
folder. The purpose is to restore the workflow.

CAUTION: No extra files should be placed in the hypersonic folder. Extra files 
placed in this folder will cause the Launcher to error with duplicate entries.

C:\Program Files\AGFA\optiink\jboss\server\default\data\hypersonic

Output Database to Text
File

The workflow and hot folder settings will be output to a text file.

Restore Database The database will be restored from the backup location.

To restore a database (from a previous backup, or an Agfa supplied ZIP), use the 
Maintenance > Restore Database menu in the Launcher while OptiInk is 
shutdown. Follow this with Maintenance > Remove Jobs and Logs before 
starting OptiInk up.

A database saved from one PC can be restored onto a different PC.

CAUTION: The Root Folders that a user can create as an input or parent input 
folder are not restored by the DB restore action. Root Folders must be manually 
created and manually shared with all Permissions for Everyone set to Allow ON.

Proofer folders are not created by a Restore DB maintenance action. The user 
must manually create Proofer folders, and manually share Root folders with all 
permissions.

Delete Database The database will be deleted. You will be prompted to backup the database prior 
to deletion.
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ZIP Logs The database can be backed up to a ZIP file using the Maintenance > Backup 
Database menu in the Launcher while OptiInk is shutdown. This will preserve all 
workflow and hot folder settings.

To minimize ZIP file size, make a backup when there are not many jobs in the 
system.

NOTE: OptiInk performs automatic maintenance on startup, removing unused 
files from File Store, and compacting the database. The application should be 
shutdown and restarted periodically, daily if possible, to allow automatic 
maintenance to take place.

Remove Jobs And Logs

1 Click Remove Jobs And Logs.

2 A warning message will display.

1 Click Yes to remove Jobs and Logs.

2 Click No to cancel.

Backup Database 

1 Click Backup Database.

2 A Save dialog box will display.
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3 Choose the folder location in the Save In box and the File name for the 
backup.

4 Click Save.

Output Database to Text File

1 Click Output Database to Text File.

2 A Save dialog box will display.
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3 Choose the folder location in the Save In box and the File name for the 
backup.

4 Click Save.

Restore Database 

1 Click Restore Database.

2 A Open dialog box will display.

3 Choose the folder location in the Look In box and the File name of the 
database to restore.

4 Click Open.

5 A prompt displays asking if you want to clean the database.

1 Click Yes to clean the database (preferred choice)
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NOTE: All tasks must be stopped before running Clean Database or a warning 
will display.

2 Click Yes to clean the database. The OptiInk filestore folder is cleaned.

3 If No is clicked, the database is restored without cleaning the filestore 
folder.

4 A log will display in the lower portion of the Launcher window.

Delete Database 

1 Select Delete Database.

A prompt will display asking if you are sure.

2 Click Yes.

A prompt displays asking if you want to backup the database.

3 Click Yes.
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4 A Save dialog displays.

5 Select the location for the backup.

6 Click Save.

ZIP Logs

1 Click ZIP Logs.

2 A Save dialog box will display.
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3 Enter the file name.

4 Click Save.

Licensing Before using OptiInk, load the license file.

Load License File

1 Click Licensing > License Management.

2 Select Load License File.

3 Locate the license file. It will have an *.alf extension.

o
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4 Click Open.

5 A Confirm message will appear. Click OK.

6 Click the “X” in the upper right-hand corner to close the License Management 
Utility.

Generate Clean Fingerprint File

CAUTION: If a clean fingerprint file is created, you will be resetting the license 
state to Null. A valid license must be reinstalled after using Clean Fingerprint 
File.

1 Launch the OptiInk/OptiInk Essentials application.
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2 From the Menu bar select Licensing > License Management.

3 Select Clean.

4 Click Generate. A clean fingerprint file deletes the license file, which must be 
reloaded.
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5 When prompted enter a file name (e.g., Customer name or Server name) and 
an extension of fpf (i.e., FT.fpf) to generate the Finger Print File. Click Save.

6 At the Fingerprint generated successfully message, click OK.

7 Click the “X” in the upper right-hand corner to close the License Management 
Utility.

NOTE: You will have to reload the license file.

Generate Fingerprint for dongle-less configuration

8 From the Menu bar select Licensing > License Management.

NOTE: The Product will be 
OptiInkEssentials when 
using OptiInk Essentials.
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9 Select Clean.

10 Select Platform Key.

NOTE: This is only valid for Arkitex OptiInk/OptiInk Essentials trials. Select 
Clean and Dongle for systems with dongles.

11 Click Generate. A clean fingerprint file deletes the license file, which must be 
reloaded.

12 A warning message will display. Click Yes.

13 When prompted enter a file name (e.g., Customer name or Server name) and 
an extension of fpf (i.e., FT.fpf) to generate the Finger Print File. Click Save.
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14 At the Fingerprint generated successfully message, click OK.

15 Click the “X” in the upper right-hand corner to close the License Management 
Utility.

NOTE: You will have to reload the license file.

Show License Info

1 Select License > License Management.

2 To confirm the license information, click View License Info.

3 Click Close.

4 Click the “X” in the upper right-hand corner to close the License Management 
Utility.

SISR SISR profiles are installed using the SISR Install and Remove menu items on 
the launcher. The relevant menu items will only be visible if a processor is 
installed. Only profiles that have been installed in the system ICC profile folder 
should be used.

Install ICC Profile

When the Install ICC Profile menu item is selected, the contents of the system 
ICC Profile folder will be displayed. Profiles can be selected from the list and 
installed to the processor SISR input profiles folder using the Install button.

1 Select Install ICC Profile from the menu.
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2 Select the ICC Profile from the list.

NOTE: Multiple selections can be made, and the user will be warned if a 
profile already exists in the destination folder. Only CMYK profiles should be 
selected for install.

3 Click Install.

Remove ICC Profile

When the Remove ICC Profile menu item is selected, the contents of the 
processor SISR input profiles folder will be displayed. Select profiles from the list 
and remove using the Remove button.

1 Select Remove ICC Profile from the menu.
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NOTE: Multiple selections can be made for removal.

2 Select the ICC Profile to be removed.

3 Click Remove.

4 A prompt will appear asking you to confirm the removal.

1 Click Yes to confirm.

2 Click No to cancel.

3 Click Cancel to cancel the operation.

Help Help displays information about the OptiInk Launcher.

Launch Help

1 Click File > Help and select About.

2 The About dialog box will display.
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The version and copyright information displays.

3 Click OK to close the dialog box.

Changing Users and Passwords 

User Administration allows for the maintenance of users, their login details, and 
their capability levels.

The functions are accessed by clicking the User Administration toolbar button, 
or its menu item. This brings up a dialog box like the following for users who 
have full administrative privileges. This dialog allows users to be added, deleted 
and updated.

Enabling the 
Administration 
Functions

Initially all functions are disabled. To enable them, you must enter your current 
login password in the top entry box. As soon as this is correct, then the Update 
and Delete buttons become enabled. This is designed to prevent unintended 
user changes if a client is left logged in unattended.

Add a New User To add a new user type in a new name into the Username entry box. As soon as 
the name is different from that shown in the current user selector, then the Add 
user button is enabled, and the Delete and Update buttons are disabled.

Complete the New user's details by entering and confirming the password, and 
by selecting the privilege level.

Click the New User button, and the New user will be created and appear on the 
list of current users. A confirmation message will appear in the message line at 
the bottom.

Update an Existing 
User

To update a current user, select the user with the Current users' selector. The 
Delete and Update buttons are enabled.
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You may update the password and the privilege level. If you just want to change 
the level, then leave the password entry boxes blank; and only the level will be 
updated.

NOTE: The user called Administrator cannot have the privilege level changed.

Press the Update User button, and the user will be updated. A confirmation 
message appears in the message line at the bottom.

Delete an Existing 
User

To delete an existing user, select the user from the list of current users, and press 
the Delete user button. A confirmation box will appear. Click Yes to proceed 
with the deletion.

Non-Adminis-
trative Users

If a user with non-administrative rights logs in and enters User Administration, 
then a simplified administration dialog is used. It operates in an identical fashion 
to the administrator, except that only updates of the logged-in user’s password 
may be performed.

Levels Four levels are available with Administrator permission: Administrator, Level 1, 
Level 2, and Level 3.

The Administrator level allows you to:

Create new users

Delete users

Assign and change levels, logins, and passwords

Level 1 allows you to:

Create and edit set up parameters

Create hot folders

Level 2 allows you to:

Select different pre-defined setups and resubmit (i.e., change image settings 
without being able to edit setups)

Perform interactive edit
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Edit User Preferences

NOTE: Editing of Hot Folder Settings is not allowed for level 2 users.

Level 3 allows you to:

Open images

View images

Approve/unapprove images

Accept/reject images

Edit User Preferences

NOTE: Editing of Hot Folder Settings is not allowed for level 3 users.

To Add a New User

1 Choose Tools > User Administration, or click the User Administration tool.

The following window appears.

2 Enter the Administrator password. the Delete User and Update User 
controls will activate.
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3 Clear the Username field. The Access Level dropdown will activate.

4 Select an Access Level.

5 Enter the Username and Password. Enter the password again in the 
Confirm New Password field.

CAUTION: The password must be 6 characters or longer.

6 Click the New User control.

7 A “User added successfully” message will display, and the new user will 
appear in the User dropdown list.
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8 Click Close.

To Delete a User

1 Enter the Administrator password.

2 Select the user from the Current Users dropdown list.

3 Click the Delete User control.

NOTE: The user Administrator cannot be deleted.

4 A confirmation box will display.

5 Choose Yes to delete the user.

NOTE: The user name is removed from the Current Users dropdown list.

To Change a Password

1 Enter the Administrator password.

2 Select the user from the Current User dropdown list.
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3 Enter the new password in the New Password field.

4 Confirm the password in the Confirm New Password field.

5 Click the Update User control.

6 Click Close to close User Administration.

To Change the Administrator Password

You can only change the password, not the access level for Administrator.

1 Enter the Administrator password.

2 Enter the new password in the New Password field.
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3 Confirm the password in the Confirm New Password field.

4 Click the Update User control.

NOTE: A “User updated successfully” message will display.

5 Click Close to close User Administration.

Setting System Preferences 

NOTE: Users can access System Preferences, but not change them without the 
right privilege.

The System Preferences window allows you to specify the following 
characteristics:

Storage / Proofer Hard proofer input (watch) folders can be configured. The target folder must be 
created using the standard Windows procedure. A browser button in Create 
Proofer and Edit Proofer dialogs are used to point to the input folder. If the 
input folder exists on a network share, the Windows folder must be shared with 
open permissions.

NOTE: Entering the input folder path manually may not create the folder 
correctly in this build version.

You can create storage areas to hold output by defining the Name and Share of 
the storage area.

Storage Area OptiInk allows you to create storage areas to hold output. You can define the 
Host, Share, and Name of the storage area.
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Working Space You can browse for the correct colorspace profile. OptiInk image processing is 
done in the RGB colorspace. Images in different digital formats and quality 
levels are received that need uniform RGB colorspace. This uniform colorspace 
is called the RGB working space.

Input GRAY Colorspace You can tag images with a default GRAY profile if they do not have an embedded 
profile. If you select this option, you also have to specify the rendering intent, 
which can be the default rendering intent (i.e, the rendering intent as specified 
in the default GRAY profile, or a specific rendering intent: perceptual, satura-
tion, relative colorimetric, absolute colorimetric, or restore dynamic range).

NOTE: When the user selects a profile from the list of available profiles, only 
profiles corresponding to the colorspace are displayed; for example, the user will 
not see any other profiles except Gray profiles from the list of "Default Gray Input 
Profile".

Input CMYK Colorspace You can tag images with a default CMYK profile if they do not have an embedded 
profile. If you select this option, you also have to specify the rendering intent, 
which can be the default rendering intent (i.e, the rendering intent as specified 
in the default CMYK profile, or a specific rendering intent: perceptual, satura-
tion, relative colorimetric, absolute colorimetric, or restore dynamic range). You 
can select a user-specified profile and intent for CMYK values.

Email Settings You can define an Email host, specify username and password, and the IP 
address. When Alert on Error is set in the post-process operation, an email will 
be sent to the specified email address to alert the user of the job status.

System Log Purge The System Log can be deleted at a specified time by day, hour, or minutes.

Job Delete Jobs can be deleted at a specified time limit by day, hour, or minute. The default 
is off.

Which Jobs are eligible for purging is determined Time Limit and Time Of Day.

NOTE: Time Of Day is used to select which Jobs to Purge. It is NOT a scheduled 
time when purging takes place. Purging is always happening continuously as 
described above.

If the Time Limit mode is used, a Job becomes available for purging when it has 
"completed" more than x time ago (where x is determined by the settings). This 
provides for a continuous purging cycle where jobs are there for a defined 
amount of time.
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If Time Of Day mode is used, a Job becomes available for purging when it 
completed BEFORE the last configured Time Of Day setting. This provides for 
clearing out material on a daily cycle. If this has been set to 03:00 in the morning, 
at 02:00 AM the expiry limit is 03:00 of the day before. If it is now 04:00, the 
expiry is 03:00 of the same day. The purge operation is not actually scheduled 
for 03:00, as it is takes place continuously.

However if the scheduler is active at 03:00, then a new days worth of purgeable 
jobs becomes available and should start purging at the rate and interval deter-
mined by the scheduler.properties file. If the scheduler is not active at this time, 
the purgeable jobs will start purging as soon as the scheduler is activated; they 
do NOT wait for the next 03:00 time. If the server is reactivated at the start of 
production, it may well have a backlog of purgeable jobs.

Hot Folder Preferences can be set for processing files in hot folders: Scan period, Stability 
count, Notification frequency, and Max files per scan.

Miscellaneous Preferences can be set to control “warning when scale is more than” message, 
file sync intervals, image processing timeout, “skip PDF if image count is more 
than”, enabling external PDF rendering, processor message timeouts, thumbnail 
size, PDF processing timeouts, Render timeouts, External PDF render method, 
and enabling advanced debugging.

Job Logging Used to control the location of Job Files and allow them to be produced automat-
ically under various conditions. A log purge setting is used to remove old files.

CSV Logging Used for generating raw event data from the main application in CSV format 
compatible with Analyst, LogViewer, and Excel. The logging interval is 100000 
seconds.

NOTE: This feature is enabled by ticking the CSV Log Enabled checkbox.

XML Status Used for maintaining the status of the application and its current Jobs in XML 
format compatible with integrating with other Arkitex workflow products 
including Producer, Portal and Vantage. This feature is enabled by ticking the 
XML Status Enabled checkbox.

Ink Reporting This controls how Ink reporting data is exported to other applications. It only 
applies to workflows that have ink reporting active.

Proofer The list of proofers is configured to define new proofers, edit existing proofers, 
or delete existing proofers.

The Proofers element shows the logical name followed by the UNC path associ-
ated with it.
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New, Edit, and Delete buttons allow the user to add a new proofer item, edit the 
properties of an existing item, or delete the currently selected item.

This allows the entry of the Name of the Proofer, and then to browse or enter the 
UNC path where files will be sent when this Proofer is invoked.

To Configure System Preferences

1 Choose Tools > System Preferences, or click the System Preferences tool.

The System Preferences display opens at Storage / Proofer.

Storage / Proofer

1 Select Storage / Proofer.

2 To add a storage area, click New.

3 The Create Storage Area dialog opens.

4 Enter the Share, Host, and File Name fields.
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Share - Folder

Host - The host field can be refilled by the value from the Share field if the 
value is //hostname, or \\hostname, or browsing from network.

File Name - Storage area name.

5 Click OK.

6 To add a proofer, click New.

7 Enter the Share Folder, Host, and Proofer Name fields.

Share Folder - Folder

Host - The host field can be refilled by the value from the Share field if the 
value is //hostname, or \\hostname, or browsing from network.

Proofer Name - Proofer area name.

8 Click OK.

Delete Storage Area

9 Select a storage area from the dropdown list.

10 Click Delete.

11 A warning displays.
:ARKITEX QUALITY OptiInk User’s Guide



 

1 :ARKITEX OPTIINK SETUP 47
NOTE: The Edit button is disabled if there are no items in the list.

12 Click Yes.

Edit Storage Area

1 Select a storage area from the dropdown list.

2 Click Edit.

3 Edit the Name and Share fields, and click OK.

NOTE: The Edit button is disabled if there are no items in the list.

Delete Proofer Area

1 Select a proofer area from the dropdown list.
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2 Click Delete.

3 A warning displays.

4 Click Yes.

Edit Proofer Area

5 Select a proofer area from the dropdown list.

6 Click Edit.

7 Edit the Name and Share fields, and click OK.

NOTE: The Edit button is disabled if there are no items in the list.
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Working Space

1 Select Working Space.

2 Choose a profile from Working Space Profile.

Input GRAY Colorspace Preferences

1 Select Input GRAY Colorspace Preferences.

2 Select a profile from the Default Input GRAY Profile list.

3 Select a rendering intent from the GRAY to Working Space intent that is 
best suited for the images.
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Input CMYK Colorspace Preferences

1 Select Input CMYK Colorspace Preferences.

2 Select a profile from the Default Input CMYK Profile list.

3 Select a rendering intent from the CMYK to Working Space intent that is 
best suited for the images.

4 The Saturation Boost value is preset to 30.0. To change this value, you must 
select RestoreDynamicRange from the CMYK to Working space intent list.

5 User-Specified Profile for CMYK values and User-Specified Intent for 
CMYK values are typically used in an RGB workflow. The CMYK profile and 
rendering intent can be selected. They are used to display the CMYK values 
in job editing.

NOTE: If the user selects None from the list of available profiles, no CMYK 
values will be displayed.
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Email Settings

Email Host SMTP host name.

Email Username Site specific.

Email Password Site specific.

Send to Address Email address where messages will be sent.

1 Select Email Settings.

2 Enter the following information: 

Email Host - SMTP host name

Email Username - Site specific

Email Password - Site specific

Send to Address - Email address where messages will be sent

3 Check Send emails when license enters grace period to send an email alert 
when the grace period has been entered.

o
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System Log Purge

Time Limit By default Time Limit is set to a value of 2 days.

NOTE: Time Limit can have a value set to Days, Hours, or Minutes.

Job Delete 
Preferences

This panel defines the strategy for removing Jobs which are completed or have 
failed.

The purging strategy may be set to Off, Time Limit, or Time of Day. If it is set to 
Time Limit, then Jobs which completed will be removed as soon as the Time 
Limit interval from when they completed has past. If it is set to Time of Day, then 
Jobs which completed before the Time of Day set up will be removed from the 
system. This effectively means that Jobs will get purged shortly after this Time 
of Day.

Off Disables job deletion.

By default Off is enabled. If you select an option, a warning message will display.
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Click OK to clear the message.

Time Limit can have a value set to Days, Hours, or Minutes.

Time Of Day The Time Of Day is set in <hh:mm:ss>.

Purge Scan Interval (s) Purge Scan Interval (s) sets the interval at which Job purging is checked for new 
Jobs to purge.

Max Purge Jobs per Scan Max Purge Jobs per Scan sets the maximum number of Jobs to purge in any one 
interval and may be used to spread out purging large numbers of Jobs to reduce 
impact on performance if production is active.

Miscellaneous

Warning when scale is
more than

Enter a value to display a warning if the scale exceeds the entered value.

File Sync Interval (s) File Sync Interval (s) configures the interval at which a Primary server will 
synchronize its database and active file set over to a Secondary server in a 
Primary / Secondary configuration. Use a low value to keep the two servers in 
tight synchronization and minimize any data loss if failure occurs between sync 
intervals. Use a larger value to minimize impact on performance.

Image processing timeout
(s)

Image processing timeout (s) Sets the maximum time that the Application will 
wait for an image to be processed. This is a safety mechanism that allows any 
rogue image files which are causing processing problems to be aborted automat-
ically rather than tying up resources.

PDF processing timeout (s) PDF processing timeout (s) Sets the maximum time that the Application will 
wait for a PDF file to be processed. This is a safety mechanism that allows any 
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rogue image files which are causing processing problems to be aborted automat-
ically rather than tying up resources.

Skip PDF if Image Count > Sets an image count which will cause a PDF to skip processing if this is exceeded. 
Some PDFs may contain large numbers of tiny images which are very time 
consuming and inappropriate to process. A value of -1 means that no PDFs will 
be skipped. If one could encounter PDFs with say 10000 images then one can use 
this control to skip that type of PDF.

Render Timeout (s) Render Timeout (s) Sets the maximum time that the Application will wait for a 
PDF file to be rendered to softproof. This is a safety mechanism that allows any 
rogue image files which are causing processing problems to be aborted automat-
ically rather than tying up resources.

External Rendering

System preferences control two alternative External rendering options: Ghost-
script or folder-based RIPS, including Grafix RIPs. These may give higher 
performance; and it may be useful to use the same RIPs as will eventually be 
used to render the PDFs downstream.

A system preference selects the external render option and a parameter associ-
ated with it.

The external rendering is controlled by a vbs script. This will select Ghostscript 
or folder-based RIP operation. For Ghostscript it will invoke the RIP function 
directly. For folder-based RIPs it will direct the PDF to be rendered to one of a 
number of configured folders at preset resolutions and colorspaces. It will collect 
the resulting file and signal the application that the rendering is complete.

NOTE: Refer to “OptiInk / OptiInk Scripting” on page 283.

Enable external PDF
Render

Enable external PDF Render.

External PDF Render Processor Msg Timeout (s) Sets the maximum time a module will wait for an 
internal message to be processed and acknowledged before repeating the 
message. This is a safety mechanism to make the system more resilient if any 
messages get lost.

Processor Msg Timeout (s) Processor Msg Timeout (s) Sets the maximum time a module will wait for an 
internal message to be processed and acknowledged before repeating the 
message. This is a safety mechanism to make the system more resilient if any 
messages get lost.
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Enable advanced debug Debug files are renamed Enable Advance Debug and are now also used to 
enable previous scheduler trace messages. By default with this control off, they 
are hidden. This should only be turned on for debug purposes, not for 
production.

Used to turn on more verbose logging for debug purposes and capture internal 
XML job descriptions. Do not turn on for normal use.

Thumbnail Size Thumbnail Size controls the basic size at which thumbnails will be generated. If 
larger thumbnails are to be used in the clients then they can become pixellated 
when upscaled. Increasing the raw thumbnail size will improve this. It should 
not be increased unnecessarily as it will increase system load and file sizes. 
Range is 50 to 300.

Client Message Priority This allows giving extra priority to handling client messages. Higher values 
mean the scheduler handles more client messages per cycle. The special value -
1 means that the priority is automatically raised as more clients log in (default 
setting).

Hot Folder 
Preferences

Use these preferences to determine the interval between checks for new files in 
hot folders, to determine when files are stable for processing, and to set the delay 
between successive messages from the scanning process to the Scheduler when 
there are a large number of files in hot folders.

Scan period The interval in seconds between checks on the Hot folders for new files, or the 
stabilization of existing files. Increasing this from the default value can lower the 
processing load caused by scanning large numbers of hot folders, but will also 
cause files to take longer to be recognized when entered into folders.

Range is 1-60 seconds. Default is 2 seconds.

Stability count The number of Scan Periods that a file must be seen as unchanged (size and 
modification date) for it to be recognized as stable and ready for further 
processing. The total time given by Stability Count and Scan period determines 
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the delay before a file can begin processing. Normally, this should be kept small. 
Sometimes applications writing files slowly and incrementally into hot folders 
can cause them to be recognized as stable before they actually are stable. 
Increasing the Stability count can prevent this from happening.

Range is 1-10 scan periods. Default is 3 scan periods.

Notification frequency A delay in milliseconds between successive messages from the Scanning process 
to limit the load on the scheduler when large numbers of files are present in the 
hot folders.

Range is 10-5000 milliseconds. Default is 100 milliseconds.

CAUTION: The Notification frequency value is for advanced performance tuning 
purposes and should not normally be changed.

Max Files Per Scan Set the number of files that will be scanned.

Range is 1-250. Default is 250 files per scan.

Processing Queue Depth Processing Queue Depth configures the maximum number of Jobs that can be 
active at any one time and suspends scanning for new Jobs until some Jobs 
complete. If set to a low value like 4 then approximately only 4 jobs will get 
scanned in batches. This is useful if multiple instances of the applications are set 
to scan common folders as it allow more effective load sharing.

Job Log 
Preferences

Job Logging function allows System Preferences to control the location and 
condition when logs are written. You can define the folder where logs are 
written, the number of days the log is retained, and the condition to write the 
log.

Whenever a job finishes processing, it may cause a Job Log to be written 
automatically depending upon the System Preference settings.

The condition which triggers the log write is determined by the three check 
boxes at the bottom of the panel (Always, Error Jobs, and Rejected Jobs). 
When the Always box is checked, the other two are disabled. Otherwise, either 
or both other boxes can be selected. If the Error Jobs box is checked, all jobs that 
Fail have their log written. If the Rejected Jobs box is checked, a log is written 
for each job that is not approved (see “Approving Jobs” on page 134). The 
default is “nothing checked”.
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Job Log Export Folder Path to where Job Logs are written for automatic or manual operation. You can 
select a folder using Browse, or type in a specific location. The default is Program 
Files/Agfa/OptiInk/server/logs.

Job Log Purge Days Job Logs older than this will be purged. Old job log files should be purged 
according to the system preferences. This should be checked periodically (e.g., 
once per hour). Any files in the current Job Log folder with a modification date 
older than the “current time - purge setting” should be deleted.

Job Log Purge Days defines the number of days to retain the log. The default is 
2.

All Jobs Export logs for all Jobs. If 'All Jobs' is checked, then a Job Log should be written 
when all Jobs finish processing no matter their state.

Error Jobs Export for jobs going into Error. If 'Error Jobs' is checked, a Job Log should be 
written when a job finishes in an Error state. Any internal retries on errors 
should be attempted first.

Rejected Jobs Export Logs for Rejected Jobs. If 'Rejected Jobs' is checked, a Job Log should be 
written when a job is rejected from a workflow, including approval.

NOTE: It is possible to check any combination of these options, but a Job Log will 
only be written once when it finishes.

Job Log Name Both Manual and Automatic Job Logs are named as: 
OriginalFileName_InternalIDNumber.txt 

The InternalIDNumber is 6 digits in length with leading zeros as needed; e.g., a 
source file TestImage.jpg may produce a JobLog file named 
TestImage.jpg_000789.txt.

Manual Job Logging The Export button is used to manually write Job Logs. The Log will be written to 
the folder specified in System Preferences. If an automatic Job Log is present, it 
is overwritten. If a job is manually retried, the Job Log will be rewritten.
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Job logs are named using the Internal Job Number reference (e.g., JOB1530.txt).

The original Export button on the View Job Log window (right click a job in the 
Job List window) is still active. It is written to the same location defined in 
System Preferences. If a log file exists for a particular job, it is overwritten.

CSV Logging Used for generating raw event data from the main application in CSV format 
compatible with Analyst, LogViewer and Excel.

CSV Log Enabled This feature is enabled by ticking the CSV Log Enabled checkbox.

CSV Log Folder Selects where the CSV event files are placed.

SiteName Site Name controls the Site name in each CSV record and may be used to deter-
mine where the main application is situated.

Instance Name Instance Name controls the Instance Name in each CSV record and may be used 
to identify particular installs if there are multiple installs on the same site.

Update Interval (s) Update Interval (s) configures the frequency at which CSV event files are 
written. The application queues up records internally, and then writes them out 
to a new event file at this interval. The logging interval is 100000 seconds.
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Millisecond timing Set a small interval to get rapid export of small event files, which are to be 
accumulated in an external reporting application. Set a large interval to get 
infrequent but large event files if this is more convenient for say importing into 
Excel.

XML Status XML Status is used for maintaining the status of the application and its current 
Jobs in XML format compatible with integrating with other Arkitex workflow 
products including Producer, Portal and Vantage.

XML Status Enabled This feature is enabled by ticking the XML Status Enabled checkbox.

XML Status Folder Selects where the XML Status files is placed.

Update Interval (s) Update interval configures the minimum time the XML status file is updated. Use 
a low value to get frequent updates and a higher value if the real time aspect is 
less important as this lowers the loading on the application.

Purge Jobs older (s) Purge Jobs older (s) sets the time when Jobs that have completed will be 
removed from the XML status file. This is NOT the same as when they have been 
purged from the application. Setting a low value will keep the list of Jobs in the 
XML down to the minimum required but means their status will not be available 
after this period.

Purge Interval (s) Purge Interval is the interval at which older jobs eligible for purging will be 
removed.

Ink Reporting This controls how Ink reporting data is exported to other applications. It only 
applies to workflows that have ink reporting active.
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Text Reporting Enabled Text Reporting Enabled turns on an accumulating text file of results with the 
data formatted one job per line in TAB separated format. 

Text File The Text File allow configuring the name and location of this Ink report text file.

XML Reporting Enabled XML reporting Enabled turns on exporting Ink reports in an XMLformat one for 
every job ink reported. This format is compatible with Analyst. XML Folder.

XML Folder XML reporting Enabled turns on exporting Ink reports in an XMLformat one for 
every job ink reported. This format is compatible with Analyst. The XML folder 
field determines where these XML reports are written.

Ink Cost Ratio Ink Cost ratio is used in the calculation of actual ink cost saved. It represents the 
relative cost of CMY inks against the cost of black ink.

To Accept Settings

1 To accept settings and continue making changes, click Apply.

2 To accept settings all at once, click OK.

3 To cancel settings, click Cancel. A Save message will display.

Click Yes to confirm and close the dialog box.

Click No cancel changes.

Click Cancel to return to the System Preferences dialog box.
:ARKITEX QUALITY OptiInk User’s Guide



 

1 :ARKITEX OPTIINK SETUP 61
Specifying User Preferences 

Once you have successfully installed OptiInk, you can specify the display settings 
according to your monitor, your preferred working method, and your personal 
preferences. The display settings relate to:

The system display profile you want to use, together with the rendering 
intent. You can define a rendering intent to go from working space to system 
display, and a rendering intent to go from output colorspace to system 
display with an option to simulate ink black (for relative colorimetric 
rendering intent), and to adjust saturation for viewing.

The display size mode at which images have to be displayed at processing 
time.

Image scrolling and locking is used to control the behavior of the client Job 
List view. Adjusting these settings can optimize job editing and job viewing 
between multiple clients.

Deferred processing of job edit for Advanced and Interactive Edit is 
controlled by the Deferred Processing Of Edit checkbox.

Unit Conversion can be chosen from centimeters, millimeters, inches, and 
pixels. Image width and height will display according to the selected unit in 
the Details view and in Job Edit view. The position of X and Y in Job Edit view 
displays in the selected unit for TIFF and JPEG files only. PDFs are shown as 
0 dpi.

Hot Folder path in the job name in List View.

Size of thumbnail display can be controlled for Thumbnail View.

Softproofing of CMYK images.

To Specify Display Settings

1 Start OptiInk.

2 Choose Tools > User Preferences, or click the User Preferences tool.
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The following window displays.

3 Choose a profile from the Default Display Profile list.
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4 Choose a rendering Intent from the Working Space to Display Rendering 
Intent list.

This rendering intent will be used for displaying RGB images on the screen.

5 Choose a rendering intent from the Output Profile to Display Rendering 
Intent list.

NOTE: A Perceptual rendering intent is preferred for display profiles. If you 
select the default rendering intent, it will be used as it has been specified in 
the display profile itself.

6 Check or uncheck Simulate ink black for relative colorimetric rendering 
intent.

NOTE: Simulate ink black is the opposite from black point compensation. 
Refer to “Black Point Compensation” on page 227.
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7 Viewing sat is defaulted to 30.

8 Under Image scroll options, choose the radio button for Scroll all images 
(default), or Scroll only held images.

9 Under Image lock options, choose the radio button for Lock on view, or Lock 
on edit (default).

NOTE: To prevent two operators from opening and editing the same job, use 
User Preferences to set Lock on edit.

10 Deferred Processing controls job edit processing for Advanced Edit.

If checked, the OK button will be shown in the Advanced Edit dialog. 
Changes will not be applied until exiting from editing.

If unchecked, the Apply button will be shown, and changes will take 
effect immediately after clicking the button.

11 Job List Date Format is used to customize the Job List’s date and time.

12 Select the Units value (cm, mm, inches, pixels). When converting a unit from 
pixel to mm, cm, or inches, the resolution of the image is used to calculate the 
displaying units.
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NOTE: Because the TIFF files rendered from PDF jobs do not contain 
resolutions, the units will be displayed in pixels in this release.

13 Enter the Number of Columns in Manual Select Mode. Refer to “Select” on 
page 155.

14 Check Soft proof original to create a soft proof of the original image.

15 Check Show Hot Folder Paths in Job List if you want the paths to display as 
part of the job name in the Job List view at the top level local hot folder. Refer 
to “List” on page 94.

16 Use the slider to adjust the List Thumbnail Size in the Thumbnails view.

17 Check Auto Start Client if you want the client to start automatically the next 
time OptiInk is launched.

18 Select Auto Terminate Launcher if you want Launcher to terminate after 
launching the client in a pure client installation.

Accepting Settings

1 To accept settings and continue making changes, click Apply.

2 To accept settings all at once, click OK.

3 To cancel settings, click Cancel.

4 If you have made any changes and click Cancel, a warning message will 
display.

Click Yes to close without saving the data.

Click No to close the warning dialog and continue making changes.
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System Log 

The System Log contains message filters and an export button. The following 
types of messages can be displayed by checking the appropriate box:

Trivial These messages are low level messages in the log. The default is OFF.

Info A message containing information.

Warning A warning message that will not stop processing.

Error An error message that means processing has stopped.

Columns 

Timestamp Date and Time the message was received.

Message Text of the message.

Severity The message type is displayed here.

Location Which service generated the message. Services include J2EE Server, Scheduler, 
Image Processor, Hot Folder Scanner, and Client.

NOTE: Message check boxes act as both screen and log filters. If you export logs, 
unchecking a filter will prevent those messages from being exported. 
Unchecking all filters results in a log containing only a job number and 
timestamp information.

Displaying Messages

1 To display a particular message, click the appropriate checkbox.

2 Clicking the Export button exports the log to the location set in System 
Preferences, “Job Log Preferences” on page 56.
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3 Click the Close button in the upper right corner to close System Log.

•

Closing the OptiInk Application 

OptiInk can be closed using Exit from the menu bar, the Close button, or 
Ctrl+Q.

The OptiInk Launcher window will display. The Client service component will 
be grayed out.

o
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Looking at the OptiInk Work Area

In this section you will find a brief overview of the OptiInk work area. Take a few 
minutes to read through this section.

Menu Commands The table below gives an overview of all the OptiInk menu commands. You can 
easily use this table as a quick reference.

Menu Options Description

File

Exit Exits the application.

Shortcut Key: Ctrl-Q

Tools

User Administration... Opens the User Administration dialog box.
Shortcut Key: Ctrl-A
Refer to “Changing Users and Passwords” on 
page 36.

System Preferences... Opens the System Preferences dialog box.
Shortcut Key: Ctrl-S
Refer to “Setting System Preferences” on 
page 42.

User Preferences... Opens the User Preferences dialog box.
Shortcut Key: Ctrl-M
Refer to “Specifying User Preferences” on 
page 61.

View System Log... Opens the System Log display. Logs can be 
displayed for Information, Warning, and 
Errors.
Shortcut Key: Ctrl-L
Refer to “System Log” on page 66.

Folder The display will vary based on what level you 

have clicked on to create the new folder.

Delete Hot Folder Deletes the selected hot folder.

New Hot Folder... Creates a new hot folder.

Edit Hot Folder Details... Opens the details window for editing. 
Appears only at the Local Folders and Sub-
folder levels

Delete Unknown Subfold-
ers

Deletes the selected subfolder.

Delete All Hot Folder Jobs Deletes all hot folder jobs.

Abort All Hot Folder Jobs Aborts all hot folder jobs.
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Hold All Hot Folder Jobs Holds all jobs in the hot folder. Hold must be 

placed on jobs in the incoming state. If sta-

tus reaches Active state, a hold cannot be 

placed.

Release All Hot Folder Jobs Releases all held jobs in the hot folder.

Change All Job Priorities Changes job priorities in the job list.

Job Grayed out unless there is a job in the job 

list.

Job Edit... Edits the selected job.

Shortcut Key: Ctrl-E

Delete Job Deletes the job from the job list.

Abort Job Aborts the job from the job list.

Hold Job Holds the selected job. Hold must be placed 

on a job in the incoming state. If status 

reaches Active state, a hold cannot be 

placed.

Release Job Releases the selected job.

Retry Job Reprocesses the job from the job list.

Skip Job Skips the job.

Expedite Job Expedites the job in the queue. The priority 

level increases.

Approve Job Approves the selected job(s). If multiple jobs 

are selected for approval, a confirmation 

message displays.

Held For Retouch For OptiInk only. 
"Held For Retouch" should be worked in 
conjunction with "Held For Approval". Its 
primary purpose is to put images, rather than 
PDF files, in a state for retouching later. 
Editing the held image in Photoshop or 
advanced/interactive edit will lead it to the 
"Held For Approval" state. Approving a "Held 
For Retouch" job will transition it to 
"Complete" state.

Proof Source Used to send one or more source images to 
the selected proofer.

Proof Result Used to send one or more result images to 

the selected proofer.

Change Job Priority Changes the job priority.

View Job Log... Opens the Job log.

Select All Jobs Selects all the jobs in the job list.

View Job Result In Acrobat Opens the job in Adobe® Acrobat®.

Menu Options Description
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Shortcut Menus 

Right-clicking on a hot folder, workflow, operation, or job brings up a shortcut 
menu.

View

List Displays the jobs in a list view.

Shortcut Key: Ctrl-F1

Details Displays the jobs in a details view.

Shortcut Key: Ctrl-F2

Thumbnail Displays the jobs in thumbnails.

Shortcut Key: Ctrl-F3

Details View Displays the column header view options for 

the List view. Refer to “Details View” on 

page 98.

Help

About Displays copyright informationon OptiInk.

Shortcut Key: Ctrl-F12

Menu Options Description
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Hot Folder 

Depending on what level you right click on, a different shortcut menu will 
display.

Root

Local or Remote Share

Workflow Input Folders
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Root Shortcut Menu

New Root Folder Defines a folder that is set up on another server. Refer to “Create a New Root 
Folder” on page 110.

NOTE: This folder will be created at the same level as localhost/
optiink_hotfolders, which was created when OptiInk was installed.

Opens the New Root Folder window.

Host: The IP address or path of the host.

Browse: Browse to the path of the host.

Share: Name of the share.

Name: The display name of the folder.

Delete Root Folder Used to delete a root folder. This option only displays when a new root folder has 
been created.

A confirmation message displays.
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Local or Remote OptiInk Share Shortcut Menu 

Delete Root Folder Used to delete a root folder. A prompt appears asking for confirmation.

New Hot Folder Creates a new hot folder at the same level as Default BW and Default RGB.

Edit Hot Folder Details Refer to “Edit Hot Folder Details” on page 77.

Delete All Hot Folder Jobs Deletes all jobs in the selected hot folder.

CAUTION: All jobs in all workflows are deleted.

This action will delete or modify all eligible jobs in all workflows under the ITX 
share. Thorough knowledge of ITX operation is needed before using these 
commands.

Abort All Hot Folder Jobs Aborts all jobs in the selected hot folder.

Hold All Hot Folder Jobs Holds all jobs in the selected hot folder.

Release All Hot Folder Jobs Releases all jobs in the selected hot folder.

Change All Job Priorities Changes all job priorities in the selected hot folder.
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Edit Hot Folder Details 

Edit Hot Folder Details simplifies gives extra flexibility in handling different set 
up requirements of hot folders.

Configuration and behavior is directly controlled from the individual hot folder 
properties.

The scan tree becomes a series of one or more parent folders, which themselves 
may or may not have children, etc. Parents have the original path name to the 
scanning point, and their children just add to this path.

Host Network name or IP address of a host-machine.

Share Path Share is a share name + path to the hot folder to be scanned. A browse button is 
provided to set the host name and share path by browsing where applicable.

Folder Hot Folders now have a display name distinct from their folder.

Display Name Name is a logical name to appear on the client tree display. The default is newhf.
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Job Priority Priority is the default priority to give to jobs scanned from this folder. Enter a 
value (0 lowest priority - 9 highest priority) in Job Priority to assign a priority to 
the hot folder. The default is 5.

Workflow Name of the workflow to apply to the hot folder. Default BW, Default, and 
Default RGB are the default workflow choices. When a new Workflow is created, 
the Workflow name is added to this list.

Script and Parameters

Each Hot folder had a check box enabling PS to PDF conversion that invoked a 
specific script, PSConvertToPDF. The script passed the input file, the output file, 
the original scan folder, and a fixed parameter containing a conversion profile 
(ITX_Default.joboptions). The sequence of operations did not allow the script to 
produce an accompanying XML to allow for dynamic XML job production.

The HF script sequence allows for image conversion, editing of an incoming XML 
job description, and production of an accompanying XML job file from an image 
file entry.

NOTE: HF scripts are identified starting with HFnn and ending in .vbs, where nn 
is a two digit number from 02 - 15.

Hot Folder Script Allows a choice of None, the existing HF01_PSConvertToPDF.vbs, and up to 14 
further scripts, which are enumerated from the scripts folder.

Script Parameters A text box allowing user entry of the script parameter. The default is 
ITX_Default.joboptions.

NOTE: Each hot folder can have its own script name selected, and its own 
parameter.

Enabled Enable is a check box to enable or disable scanning from this particular hot 
folder.

Enable XML Import Enable XML Files is a check box to determine whether this hot folder accepts 
XML Jobs. The Type II and Type III configuration is supported. Type I cannot be 
processed in a shared input configuration. Refer to “XML Import” on page 246 
for details.

Scan Subfolders Scan Sub Folders is a check box which allows automatic scanning of any sub 
folders below this hot folder.
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Convert (E)PS to PDF If you have licensed PDF processing, checking this option converts PS or EPS to 
PDF. This feature requires additional set up to enable full operation. (Refer to 
the section for Ghostscript installation in the OptiInk Installation Guide.)

Cross Domain Compatible When unchecked the scanning mechanism performs an extra check for file 
stability, which is useful when scanning Apple Mac mounted folders to prevent 
files being picked up before they are complete. The extra check can cause 
failures when shares are accessed across Windows domains; and this control 
should then be checked.

Filter Filter is a configuration table which allows for wild card pattern matching of 
filenames, and allows them to be accepted or ignored. The first pattern in the 
table that applies determines the action to apply.

File Type: Wild card filename matches.

Accept: Accept the file based on the filter.

Ignore: Ignore the file based on the filter.

Add: Add a filter to the table.

Delete: Delete a filter from the table.
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A newly created, top-level hot folder is by default enabled, has XML Jobs 
enabled, scan sub folders disabled, a priority of 5, and the first active workflow 
pre-selected. It allows browsing for the root hot folder point, or allows typing the 
names in explicitly.

A hot folder newly created under an existing hot folder gets the defaults of its 
parent. The host is not changeable, browsing is allowed; but browsing outside of 
immediate children folders of the parent are rejected with a warning message.

The name of a hot folder defaults to the final element in the path name of the 
folder, but can be changed to give the name on the tree a more meaningful 
name.

When creating or editing a folder set up, no action will be performed until Apply 
or OK is pressed. When Apply or OK is used, then the folder is created, if it does 
not already exist.

The new scanning function has the following behaviors:

There is no distinction between roots and hot folders. All nodes created 
below the Top level root are hot folders.

All configured hot folders are scanned for jobs if they are enabled.

If sub folder scanning is enabled, then all folders below the parent that have 
not been explicitly defined are scanned; and this scanning continues to any 
depth. All jobs found in this process belong to the parent folder and are 
processed according to its configuration. The actual path to the file should 
still be retained to control both the organization within the filestore, for use 
on job list displays, and for potential use in preserving the input folder struc-
ture on output.

Where sub folder scanning is used, and there are defined folders within this 
range, then they should be scanned explicitly using the properties associated 
with their configuration.

When the scanner is started up, it should check for the presence of all config-
ured hot folders and attempt to create them. No folders should be deleted.
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Any number of rows of wild card filename matches may be set up, and each 
row is configured to be either an Ignore or Accept match criterion.

The wild card pattern may contain explicit characters mixed with ? and * 
characters. ? matches any single character. * matches a sequence of 0 or more 
of any character. ? may be used a number of times in sequence to match a 
specific wild card length. * may be used multiple times separated by other 
literal characters. Examples are:

*.tif matches any file ending with the .tif extension

*.??? Matches any file with a 3 character extension

temp* matches any file beginning with temp

*temp* matches any file including temp in any position

When a file is recognized, then its name is compared with each filter row in order 
(from the top); and the first row that matches determines whether the file is 
accepted or ignored. If no rows match, then the file is accepted.

The default set up for a new folder matches the existing ignoreFiles set up. This 
is achieved with two rows:

.* ignore
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thumbs.db ignore

OK Applies the settings and closes the dialog box.

Apply Applies the settings.

Cancel Cancels the changes.

Workflow Input Folders Shortcut Menu 

Delete Hot Folder Deletes the hot folder.

New Hot Folder Creates a new hot folder under the Coldset/Heatset hot folder level.

Delete Unknown
Subfolders

Deletes the selected subfolder.

A confirmation message displays.

Edit Hot Folder Details Opens the Hot Folder Details window.
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NOTE: All the comments 
that apply to the Edit Hot 
Folder Details in the section 
above also apply to this 
instance of Edit HF. Refer to 
“Edit Hot Folder Details” on 
page 77.

CAUTION: All jobs in all workflows are deleted.

The following actions will delete or modify all eligible jobs in all workflows 
under the OptiInk share. Thorough knowledge of OptiInk operation is needed 
before using these commands.

Delete All Hot Folder Jobs Deletes all jobs in the selected hot folder.

Abort All Hot Folder Jobs Aborts all jobs in the selected hot folder.

Hold All Hot Folder Jobs Holds all jobs in the selected hot folder.

Release All Hot Folder Jobs Releases all jobs in the selected hot folder.

Change All Job Priorities Changes all job priorities in the selected hot folder.
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Workflow 

CAUTION: New, Import, and Export are disabled in OptiInks Essentials.

When a new workflow is created, the following sub-menu is available:

New Used to create a new operation.

Import Imports an xml file.

The Import function is allowed at the top level across all classes, or at one preset 
class.

When used at the class level, the Import only processes importing presets that 
belong to this class. If there are none present, then the user is messaged.

When used at the top level, then all presets are processed for importing.

Where the name of the preset being imported does not clash with an existing 
preset, then it is silently imported using the name in the XML file.

Where it does clash, the user has a choice of overwriting the existing setting, 
importing with a number added to make unique, or ignoring that import. An 
overwrite all option on this dialog is used to automate further clashes. If not 
used, then the choice should be repeated on further clashes which occur until 
the import is complete.
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An import dialog displays. Select the xml file, and click Import.

Export Exports an xml file. 

An export dialog displays. Select the xml file, and click Export.

NOTE: Exporting XML settings from an empty workflow displays a dialog 
explaining there is no data. No file is produced.
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Edit a Workflow

When a workflow is edited, the following submenu is available:

Duplicate Used to duplicate an existing operation.

Delete Used to delete an existing operation.

Set Operation In Workflow Used to set this operation into the workflow.

You must first remove an operation from a workflow before you can delete that 
operation.

Export Exports as an xml file.

An export dialog displays. Click Export.
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CAUTION: Export is not supported with the Select, PreProcess, Approve, and Post 
Process operations. If these are selected, a message will display:

Operation

Remove Operation From
Workflow

Deletes the operation from the workflow.

NOTE: Some Workflows share operations. If you need to delete a Workflow that 
uses a shared operation, delete the operation from the Workflow, then delete the 
Workflow completely.

An Overview of the 

OptiInk Tools 

In this section you will find a brief overview of the various OptiInk image editing 
tools. Take a few minutes to read through this section.

Main Area

Button Click to

Open User Administration

Open User Preferences
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Hot Folders Tab 

Open System Preferences

View System Log

Close All Job Windows

Open List View

Open Details View

Open Thumbnail View

Button Click to

Create a new hot folder

Delete a hot folder

Job Active

Job Collecting

Job Ready

Job Complete

Job Aborted

Button Click to
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Job Failed

Job OK Warn

Job Purged

Job Edit

Job Edit Abort

Job Edit Failed

Job Edit OK

Job Edit Reject

Job Held

Job Held Approve

Job Held Rejected

Job Held Select

Job Held For Retouch

Release Held For Retouch

Job View

Button Click to
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Workflows Tab 

Job View Abort

Job View Failed

Job View OK

Job View Reject

Close the job

Job Log

Job being edited

Hot folder with completed jobs

Job failed

Job on hold

Job waiting for approval

Button Click to

New Workflow

Copy Workflow

Export

Button Click to
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Hot Folders 

OptiInk comes with four pre-installed hot folders set up for Coldset and Heatset.

CAUTION: OptiInk Essentials comes just with one root hot folder.

When a new hot folder is created, a Details window displays. To organize work 
with hot folders, you can assign a priority to the hot folder. A higher priority 

Import

Delete Workflow

Edit

Select

CMYK/Gray Min Max Dot

Color Management

Output

GCR

PDF

Approve

PostProcess

Button Click to
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number will cause a hot folder to process its jobs before a lower priority number 
hot folder.

NOTE: Avoid making changes to the structure of hot folders while files are 
arriving.

State of Files 

Hot folders have five status numbers that default to 0 when there are no jobs in 
the folder.

The number of jobs processed successfully (green)

The number of jobs awaiting approval (blue)

The number of rejected jobs (magenta)

The number of jobs in error (red)

The total number of jobs in the job list (black)

An example is: Heatset_SISR - Heatset SISR (25 / 50 / 3 / 0 / 78)

It will then be possible to see at a glance what is remaining for operators to 
approve at any time during the production.
:ARKITEX QUALITY OptiInk User’s Guide



 

2 QUICK TOUR OF OPTIINK 93
Job List and Shortcut Menu 

Job Edit Edit the job.

NOTE: When selecting jobs for Job Edit, the maximum number of jobs that can be 
selected is 20. When 21 or more jobs are selected, the menu selection for Job Edit 
turns gray.

View PDF Subjobs View subjobs contained in the PDF job.

Delete Job Deletes the job.

NOTE: The Delete key can also be used to delete jobs from the job list.

Abort Job Aborts the job.

Hold Job Holds the job. When a job is on hold, it cannot be deleted until it has been edited 
and a decision made on the hold.

Release Job Releases the held job.

Retry Job Retries the job if it fails.
:ARKITEX QUALITY OptiInk User’s Guide



94 HOT FOLDERS
Skip Job Skips the job.

Expedite Job Expedites the job in the queue.

Approve Job Approves the job.

Held For Retouch This button allows an operator to set the state of a Job to Held for retouch. The 
purpose of this is that an operator may decide a particular image needs detailed 
Photoshop editing but this needs to be done by another operator. Setting the job 
into this state means that other operators know that the job has already been 
assessed.

Proof Source Image Used to send one or more source images to the selected proofer.

Proof Result Image Used to send one or more result images to the selected proofer.

Change Job Priority Changes the job priority.

View Job Log Opens the job log.

Select All Jobs Selects all jobs in the job list.

List 

Columns

Name of the file If Show Hot Folder Paths in Job List has been selected under User Preferences, 
the path will also display when the top level local folder is selected. Refer to 
“Specifying User Preferences” on page 61.

NOTE: Selecting a subfolder will not display the hot folder path.
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State “State of Files” on page 92.

Workflow Coldset Standard, Coldset SISR, Heatset Standard, Heatset SISR.

Original File Type TIFF, JPEG, JPEG2000, PDF, EPS.

Priority “Priority” on page 95.

Creation Time Date and time the file was input to the system.

PubName The Publication Name will display when an XML import script includes 
PubName.

Operator Host system of the operator who applied any edits to the job. The Approve opera-
tion must be enabled in the workflow.

Saved % Percentage of ink saved.

NOTE: The described column 
headers display by default. 
These can be changed by 
right-clicking on a header 
and selecting different 
options. Any column header 
can be clicked.

Column headers can be click-dragged to another location.
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Details 

PDF

File Name Name of the file.

State “State of Files” on page 92.

Job Created Date and time the job was created.

Workflow Coldset Standard, Coldset SISR, Heatset Standard, Heatset SISR.

Input File Type PDF.

Job Priority Refer to “Priority” on page 95.

PubName The Publication Name will display when an XML import script includes 
PubName.

Operator Host system of the operator who applied any edits to the job. The Approve opera-
tion must be enabled in the workflow.

Saved % Percentage of ink saved.
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Thumbnail 

State Refer to “State of Files” on page 92.

Thumbnail Thumbnails of images. The zoom control can be set from 60 to 150.

Name Name of the file.
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Details View 

Optional details can be selected from the View > Details View, or by right 
clicking on a column heading in the Job List view. Selected details will display as 
additional columns in the Job List.

NOTE: When adding a new column, it is placed and displayed right next to where 
the mouse is situated.

Ink Ink Saved: Average Ink Saved.
Original Ink: Average Ink Totals in Original.
Result Ink: Average Ink Totals in Result.
Saved %: Percentage of ink saved.

Input File Type PDF.

Internal Job Number Internal Job Number.

Job Approved Date Time Job Approved.

Job Completed Date Time Job Completed.
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Job Created Date/Time Job first created.

Job Edited Date Time Job Edited. Blank if not edited.

Job Priority Priority assigned to Job.

Operator Name of operator editing/approving job.

Original File Size Size of Job in Kbytes.

Original Size Width / Height of Job in User Preference Units.

Publication Data extracted from XML PublicationInfo.

NOTE: These options will display when Details has been selected as the view.

Comment: This information will show up in InkSave reports.
Component: Graphic object.
Edition: The edition name.
FromSite: The site originating the publication.
Page: The page number.
Press: The press.
PubDate: The publication date.
PubName: The publication name.
Section: The section name.
Version: The version number.
Zone: The zone.

Process Time Time taken to process Job.

Result Color Space The colorspace of the result file.

Result File Size Size of file in Kbytes.

Result Size Size of file in Kbytes.
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SISR Estimated Profile SISR estimated profile.

Source Color Space The colorspace of the source file.

State Current Job State.

Subjobs PDF subjobs.

Workflow Name of workflow being used.

Changing the View 

Go to the menu bar, and select View.

Or go to the toolbar, and select the desired View tool.

Thumbnail Job Status 

When jobs are submitted, in Thumbnails View they will display in these states.

Button Click to

Open List View.

Open Details View.

Open Thumbnail View.
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PDF Held For Approval

PDF Held For Retouch

PDF Complete

PDF Complete with Warning

PDF Failed

PDF Deleted

Unknown File Type (Failed)
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Closing All Job Windows 

You can close all open jobs in edit mode by clicking the Close All Job Windows 
button.

Workflows 

OptiInk comes with pre-installed workflows (refer to “Default Installations” on 
page 152).

All workflows, task lists, and operations are sorted in ascending order when 
clicking the dropdown list arrow.

CAUTION: OptiInk Essentials comes with a supplied set of workflow 
configurations. Only one workflow can be active at a time to process jobs. 
Available workflows will display in the dropdown list.

Workflows cannot be changed in any way unless the system is in Edit mode. 
Click the Edit icon in the top left of the Workflow panel to enable this.
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The system will leave Edit mode if Edit is clicked again, or if you move to the 
Hotfolders tab.

NOTE: Workflow items can only be deleted if they are not used anywhere. A 
workflow is in use if it is attached to a hotfolder, used by any existing job, or if it 
is referenced in a PDF operation. An operation is in use if it is included in any 
workflow.

Operations 

The following tools are available for processing images in workflows.

Select Refer to “Select” on page 155

CMYK USM “CMYK USM” on page 158

CMYK/Gray Min Max Dot “CMYK/Gray Min Max Dot” on page 162

Artifact Removal “Artifact Removal” on page 163

File Size “File Size” on page 166

Color Management Refer to “Color Management” on page 168

Color Management Default Operations

“CMYK Coldset” on page 175

“CMYK Coldset SISR” on page 176

“CMYK Heatset” on page 177

“CMYK Heatset SISR” on page 178

“CMYK Heatset Commercial” on page 179

“Grayscale Coldset” on page 180

“Grayscale Heatset Commercial” on page 181

“RGB Coldset” on page 182
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“RGB Heatset Commercial” on page 183

Output Refer to “Output” on page 184

Output Default Operations

“Compressed Output” on page 188

“Uncompressed Output” on page 188

GCR Refer to “GCR” on page 189

GCR Default Operations

“Coldset Standard” on page 195

“Heatset Standard” on page 195

PDF Refer to “PDF” on page 196

PDF Default Operations

“Coldset SISR” on page 210

“Coldset Standard” on page 211

“Heatset SISR” on page 212

“Heatset Standard” on page 213

Approve Refer to “Approve” on page 214

PostProcess Refer to “PostProcess” on page 218

PostProcess Default Operations

“Coldset SISR” on page 221

“Coldset Standard” on page 221

“Heatset SISR” on page 221

“Heatset Standard” on page 221
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Create a Workflow

New workflows are created first, and operations are added to the workflow. 
Then hot folders are created. The hot folder can then be linked to the workflow 
through the Hot Folder details pane. The hot folder will then process files based 
on the linked workflow.

Create Workflow

1 Click the Workflows tab. The Workflow editor will display.

2 Click Edit to activate the workflow tools.

NOTE: Only Edit in Workflow 
Tools is enabled for OptiInk 
Essentials.

NOTE: If the Edit button is not on, a system lock message will display if you 
click the New button, or right-click on an operation.

3 Click the New button.

NOTE: 

4 Choose a name for the new workflow.

5 Click OK.
:ARKITEX QUALITY OptiInk User’s Guide



106 CREATE A WORKFLOW
NOTE: The workflow is empty when first created. All operations will perform 
their default behavior, which in most cases is no processing.

Create a New Operation

1 Select the newly created workflow.

2 Be sure the Edit button is turned on.

If the Edit button is not turned on, default operations will be marked as READ 
ONLY and cannot be edited.

3 Right-click an operation icon.

4 Select New from the shortcut menu.

NOTE: The Workflow Steps 
shortcut menu is disabled for 
OptiInk Essentials.

5 Enter a name for the operation.

6 Click OK.

To Configure Operations

7 To configure operations, refer to the “OptiInk Operations Settings” on 
page 151.
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To Set Operation In Workflow

8 Right-click on the operation.

9 Select Set Operation In Workflow from the shortcut menu.

10 An icon for the new operation will display in the workflow pane at the top of 
the window.

NOTE: When the Edit button is off, the operation icon will appear grayed out.

When Edit button is on, the operation icon will not appear grayed. You can 
click the dropdown arrow, and the operation name will display.

Create a Hot Folder

You can automatically run images in a given folder by specifying a source folder 
and a destination folder. The source folder is a hot folder. Upon arrival of one or 
more original images in this folder, OptiInk will automatically process these 
images. Hot Folders can be assigned a priority for processing.
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To Create Hot Folder

1 Click the Hot Folders tab.

2 Right-click on localhost, and select New Hot Folder from the shortcut 
menu.

Or click the New button.

NOTE: A new hot folder will be created initially with the name newHf.

3 In the Hot Folder Details window enter a Folder and Display Name.
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4 Enter a value (0 lowest priority - 9 highest priority) in the Priority box to 
attribute a priority to the hot folder.

5 Click the Workflow dropdown list, and select a workflow to link to the hot 
folder.

6 Click the Hot Folder Script dropdown list, and select a script.

7 Leave the Script Parameters at default, or enter other parameters.

8 Leave Enabled checked so the hot folder will be active.

NOTE: Enable XML Import is 
disabled for OptiInk 
Essentials.

9 Enable XML Import is checked by default. The work flow can be configured 
for XML importing. The Type II and Type III configuration is supported. Type I 
cannot be processed in a shared input configuration. Refer to “XML Import” 
on page 246 for details.

NOTE: Type I XML will not process if shared. Type II and III XML will process 
if shared.

10 Checking Scan Subfolders allows automatic scanning of any sub folders 
below this hot folder.

11 Enable Cross-Domain compatible, if necessary.
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12 Filter is a configuration table which allows for wild card pattern matching of 
filenames, and allows them to be accepted or ignored. The first pattern in the 
table that applies determines the action to apply.

13 Click OK.

The new hot folder will be created under the Coldset/Heatset shares, which 
were created when OptiInk was installed.

Create a New Root Folder

OptiInk already comes with a root folder created so you can begin processing 
files. If you need to create a new root folder, follow these procedures.

Steps

1 Right-click on Hot Folders in the tree.

2 Select New Root Folder from the shortcut menu.
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3 Enter the Host IP Address, or browse to the folder location.

4 Enter the name of the Share Path on the server.

5 Enter the folder display Display Name.

6 Click OK.

7 The root folder appears in the tree below Hot Folders and at the same level 
as localhost/optiink_hotfolders.

Uploading Files 

Once you have established workflows and hot folders that you are going to use, 
you will use them in your production environment. Images will be uploaded to 
source folders based on how your network is configured to receive images.

Upon arrival of jobs in the input folder, OptiInk will automatically process these 
images. You can then view the job from the job list.

Viewing the Processed File 

You can compare the before and after result, select the full-color representation, 
or just the Cyan, Magenta, Yellow, Black, or CMY.

Two tabs are available for editing a job:

Image (Refer to “Image Tab” on page 112)
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Log (Refer to “Log Tab” on page 132)

Image Tab Use the Job Toolbar to view the source file, result file, simulation, compare 
source and result, remove, and approve the job.

NOTE: In single view mode, you can hot key to the source file by using Alt+S, and 
to the result file by using Alt+R.

The Image tab is the default tab view.

nt

Location and Color Coordinates

X/Y The X and Y coordinates of the image part being viewed.

RGB The Red, Green and Blue values of the image coordinates being viewed.
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CMYK The Cyan, Magenta, Yellow and Black values of the image coordinates being 
viewed.

Average Displays in the Source and Results images.

Difference Displays in the results images.

ICC Profile The icc profile in use.

DPI Dots per inch value.

Source/Result Identifies if the image is the source or result.

Job Toolbar

Use the Job Toolbar to view the source, result, and compare.

Button Click to

Show previous job in job queue

Show next job in job queue.
Next job scrolling always checks for new jobs, which are higher 
in the selected sort order. If jobs are sorted on priority, and a new 
higher priority job arrives, it will be the next job opened while 
scrolling rather than the job in the next physical position in the 
job list.

Approve job

Reject job

Held For Retouch (only active in OptiInk)
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Hand Grab Pan
To start panning, click the "Hand Icon" in the toolbar to enter 
"panning" mode. 

Click and drag the cross shaped pointer to move around the 
image.

Hot Key Pan
The "Hot Key" functions similarly but instead of selecting the 
"Hand Tool", the user moves the image by dragging the left but-
ton mouse and pressing the "Shift" key simultaneously.

View in Acrobat

Display in dual view

Show source

Show result

Show Original Pixels. For every image pixel, there is a screen 
pixel

Fit to Window

Button Click to
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Editing Toolbar

Use the Editing Toolbar to control viewing of the image.

Magnify

Zoom In
Press Alt-i to zoom in.

Zoom Out
Press Alt-o to zoom out.

Button Click to

Info (only active in OptiInk)

View All, View Cyan, View Magenta, View Yellow, View Black, 
View CMY

Advanced Edit (active in Result view)

Interactive Edit (only active in OptiInk)

Edit image Photoshop (only active in OptiInk)

Proofer

Button Click to
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Dual View
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Source
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Result
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CMYK Profile View All
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Cyan
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Magenta
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Yellow
o
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Black
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CMY
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Show Original Pixels
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Fit to Window
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RGB Profile View All
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Red
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Green
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Blue
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Show Original Pixels
:ARKITEX QUALITY OptiInk User’s Guide



132 VIEWING THE PROCESSED FILE
Fit to Window

Log Tab The Log tab displays messages about that job. By checking the desired filters 
(Trivial, Info, Warning, and Error), only those messages will display.
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Four message filters are available:

Trivial When checked Trivial messages are displayed.

Info When checked information messages are displayed.

Warning When checked warning messages are displayed.

Error When checked error messages are displayed.

Column Headings

Timestamp: Column displaying the time the file was processed.

Message: Column displaying processing messages.

Severity: Column displaying the severity of the message. Messages are classed as 
trivial, info, warning, and error.

Location: Column displaying java processing locations.

Columns contents can be sorted by clicking the column heading. A sort arrow 
will display. Contents can be sorted in ascending and descending order.
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Export Log information can be exported to a .txt file using Export.

Approving Jobs

Files requiring approval will remain in a "Held for Approval" state until an 
operator accepts, edits, or rejects them. Typically, a job is held for edit and 
approval, but an editing action is not needed to approve a job.

An operator can select, view, edit, and approve a job (or job groups) from the 
list, detail, or thumbnail view of the Job List. A more efficient procedure is to 
scroll between held jobs using the toolbar buttons for "Show previous job" and 
"Show next job". All job operations are available, and the operator can approve 
or reject the job using the toolbar buttons. Scrolling will automatically skip all 
jobs that have already been accepted or rejected. Use User Preferences to 
configure how scrolling moves through the job list.

At this point, the operator has these choices:

Immediate Right-Click Approve

They may, due to time pressure, want to approve the job from the Job List 
without the overhead of softproofing. In this case, a right-click would include the 
choice Approve Job, which would be greyed out unless the job is in Held for 
Approval state.

Approval Following Softproof

The operator can double-click the job, issue a Job Edit, or scroll to the next job 
using the arrow icons. At this point the image compare screen appears, and the 
job goes into a new status - Viewing (Held). Then they may immediately approve 
the job by clicking the Approve icon. Or they would choose to edit via Advanced 
Edit, Interactive Edit, or calling PhotoShop.

Whatever is chosen, the job goes into the status Editing (Held). When a value is 
typed in during edit (for example, Target Gamma), the client will respond to the 
data entry with a short time delay. There is no need to tab out to another field.

On completion of the edit, whether cancelled or not, the operator can click the 
Approve With Edits icon, and job processing is finalized, and shown as 
Completed. Following an Approval, the next available image in "Held for 
Approval" state will be displayed as a softproof.
:ARKITEX QUALITY OptiInk User’s Guide



 

2 QUICK TOUR OF OPTIINK 135
Rejection Following Softproof

The operator may Reject the job, either immediately or following attempts to 
edit it. The original file will then be copied into a folder configured to receive 
rejected jobs, and the job will go into a Rejected state.

NOTE: The magenta color in the User interface indicates how many files have 
been rejected).

Following a Rejection, the next available image in "Held for Approval" state will 
be displayed as a softproof.

Status Flow for Workflow Without Approve

It may be useful to present the job status changes to compare and contrast the 
workflow with and without Approve. This section shows the workflow in a 
system where there is no Approve set up.

The User Interface - Folder Icon Colors

These have been increased to five:

The number of jobs processed successfully.

The number of jobs awaiting approval.

The number of rejected jobs.

The number of jobs in error.

The total number of jobs in the job list.

An example is: Default RGB - Default RGB (25 / 50 / 3 / 0 / 78)

The operator can see at a glance what is remaining to approve at any time during 
the production.

The User Interface - Folder Icon Colors

With more available statuses, the hierarchy of folder overview is important. If 
everything is going well with no errors, each icon folder is shown as green. 
Otherwise, the following hierarchy is used from highest to lowest:
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Job in error

Job held awaiting approval

Job rejected

Job being edited (by any client on the system, visible to all)

Job being viewed (by any client on the system, visible to all)

The User Interface Icons

The icon arrangement of the User interface is based on the following:

Lifetime of Viewing and Editing Status

Any job in Viewing or Editing status shall be returned to its pre-editing status 
(either Completed, or Held for Approval) if the client should voluntarily be 
closed, if the connection to the server is lost, or if the client freezes or crashes out 
for any reason. This includes a reboot of the machine while the client is still 
running.

Multi-Operator 
Considerations

The following should be considered in a multi-operator OptiInk environment.

Edit image in Photoshop or Acrobat.

The edit buttons. These are generic, and do not depend on the 
Approve workflow being active. These buttons do not, in themselves, 
scroll the edit/view to the next available image.

The Next/Previous buttons will scroll to the next image in the Job 
List. This allows an operator/manager to quickly scroll through and 
review all images that have been edited. Scrolling will stop at end of 
the job edit list.

The Approve/Reject buttons are active only when viewing/editing a 
job that is in Held for Approval state. Otherwise they are either grayed 
out, or do not appear at all. The use of these always scrolls to the next 
available "Held for Approval" image. In the case that there are no fur-
ther images to approve, the operator view returns to the job list.
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Image Already Being Edited

If an operator tries to edit an image that is being edited by another operator, a 
dialog box will appear asking the operator whether to proceed or cancel.

If the operator cancels having selected the job from the job list, the screen will 
return to the preview of that image, and the operator returned to the job list 
view.

If an operator cancels the edit/view without having issued an approval or rejec-
tion, OptiInk will automatically progress to the next available image as if the 
operator had pressed the scrolling arrow key.

Client-Specific 
Configuration 
Options

There are two client-specific options that allows the operator to select how to 
scroll, edit and lock.

Operator Scrolling

The first option is for operator scrolling. The default will be to scroll through all 
images, whatever status they are in. Or the operator can select so that the Next/
Previous arrow keys can only scroll through images with status "Held for 
Approval".

NOTE: For this setting jobs that have not been approved, but are in Viewing 
(Held) and Editing (Held) status, will also be skipped when scrolling. They are 
explicitly not in Held for Approval status.

Lock on View

The second option is for the lock itself. The default is to only apply the lock when 
the image is being edited by another operator. Or the operator can choose to 
apply the lock when another operator is also viewing the same image.
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Logging of Approve and Reject

All approval and rejection actions are recorded, along with the login name of the 
user who initiated the action. This appears in the system log, each job log, and 
optionally in the LogViewer record output.

The lock will not be necessary when an operator scrolls if the option to only see 
jobs waiting for approval is set (as a job being edited will never be selected, 
subject perhaps to unusual conditions).

As long as remote clients have their status updated in a responsive manner, an 
operator will usually see in advance whether a job is currently being viewed, or 
edited before selecting it for viewing.

As long as the status flow and options are implemented, the edit and view lock 
are likely to be very rare events, and this enables multiple operators to work 
seamlessly together on a production run.

Advanced Edit

Advanced Edit is available for PDF jobs and PDF subjobs. Profiles can be 
changed, disabled, or enabled.

NOTE: Under User Preferences Deferred Processing of Edit controls job edit 
processing for Advanced Edit. Refer to “Specifying User Preferences” on 
page 61.

If checked, the OK button will be shown in the Advanced Edit dialogs. Changes 
will not be applied until exiting from editing.

If unchecked, the Apply button will be shown, and changes will take effect 
immediately after clicking the button.

Import/Export

A facility is available to Export all the workflow settings and new presets from 
the Advanced Edit control panel to the same XML file format, including the 
workflow name with the Advanced edit identifier and the individual presets for 
each class.

An Import button on the workflow toolbar allows the workflow name and new 
presets to be imported.
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To Use Advanced Edit without Deferred Processing

1 From the job list open a PDF Job or subjob.

2 Click the Advanced Edit tool.

3 The Workflow operations will display.
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4 The Advanced Edit window defaults to the first operation (color manage-
ment), and opens with the Details visible.

NOTE: Clicking Details closes the operation display. The next time Advanced 
Edit is opened, OptiInk will remember if Details was visible or not.
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5 Select an Operation from the display, and click Details.

6 Make a change in a parameter. Click Okay.

7 Close the Workflow display.

8 Close the image.

NOTE: If a job requires approval, use the Approve Job button.

To Use Advanced Edit with Deferred Processing

1 From the job list open a PDF Job or subjob.
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2 Click the Advanced Edit tool

3 The Workflow operations will display.

4 Select an Operation from the display, and click Details, if necessary.
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5 Make a change in a parameter. Click OK.

6 Close the Workflow display.

7 Close the image. Changes will be applied.

Use Advanced Edit with Output

1 From the job list open a PDF Job or subjob.

2 Click the Advanced Edit tool

3 The Workflow operations will display.

4 Select the Output Operation from the display, and click Details, if necessary.
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5 Enter a value in the File Name Mask field.

The flags are used to specify how the OptiInk output filename is created.

%F = original filename, unmodified

%X = extension associated with the output file format, one of tif, jpg, pdf, 
eps, or bmp

%N = job id of the job creating the file

%D = date the output file was created in the format yyyymmdd

%T = time the output file was created in the format hhmmss

%f   = The original filename with the extension removed only if the extension 
exactly matches one of tif, tiff, jpg, jpeg, pdf, eps, bmp

%g  = The original filename with any extension removed

%% = the % character

NOTE: These flags may be combined in any order. Any intermediate literal 
strings are preserved.

A blank field (the default) is internally interpreted as %f.%X, which is the 
original basename + the output filetype extension. Refer to “File Name 
Mask” on page 184.
:ARKITEX QUALITY OptiInk User’s Guide



 

2 QUICK TOUR OF OPTIINK 145
Any other parts of the mask appear as they are in the output name. For 
example, the mask %F_%N could produce a filename myimage_100.jpg if the 
original file was called myfile and the job number is 100. 

6 Click OK.

7 Close the Workflow display.

8 Close the image. Changes will be applied.

Proofer

Named proofing folders can be set up to proof source and image files. These 
folders are entry points into particular proofing systems.

A proofing request is then fulfilled by copying the relevant image file (source or 
result) to the folder associated with a proofer's name. The image file used will be 
either the original source file as entered into the system, or the result file as 
processed by the system.

The filename placed in the Proofer destination is OriginalImage-
Name[_out]_JobNumber.FileTypeExtension, where the optional _out indicates 
that it is a result image that is being proofed.

The contents of the file do not have to be modified in anyway before being sent 
to the proofer destination.

NOTE: Proofing folders are configured under System Preferences. Refer to 
“Proofer” on page 44.

Proofer Menu items

Two Job menu items have been added to the Job right click menu and made 
available from all the Job list views where the menu can be used.
:ARKITEX QUALITY OptiInk User’s Guide



146 PROOFER
Proof Source Image - Used to send one or more source images to the 
selected proofer

Proof Result Image - Used to send one or more result images to the 
selected proofer

These menu items are enabled when at least one proofer has been defined. 
The Proof result image is enabled when a result image is available.

If multiple jobs are selected, then the menu items are enabled, and whether 
a particular job image is sent will depend upon its availability.

Job Edit buttons

When a Job edit window is displayed, the Proof Image button appears next 
to the Photoshop edit button, providing at least one Proofer has been 
defined.
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Proofer Selection

When either a Proofer menu item is selected, or a Job Edit Proofer button is 
pressed, a pop up menu appears with the list of defined Proofers, and a 
Cancel item.
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When a valid Proofer is selected, the Job image(s) are sent to that location.

Logging

When a Job Image is sent to a Proofer, a log message is added to the Job Log 
and LogViewer output detailing the Job Image, the Machine name where the 
operation was initiated, and the Proofer output selected.
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View in Acrobat

Selecting View in Acrobat launches a reader to view the result in PDF form.

To View in Acrobat

1 Open an image from the job list.

2 Click View in Acrobat to view the PDF in Acrobat.
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3 The Acrobat reader will display the PDF.
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152 DEFAULT INSTALLATIONS
Default Installations

OptiInk comes with pre-installed hotfolders and workflows, and workflow 
operations. The operations have predefined settings that can be added to new 
workflows.

Hot Folders

The Coldset Standard hot folder is linked to the Coldset Standard 
workflow.

The Coldset_SISR hot folder is linked to the Coldset_SISR workflow.

The Heatset_SISR hot folder is linked to the Heatset_SISR workflow.

The Heatset Standard hot folder is linked to the Heatset Standard 
workflow.

Workflows

The Coldset Grayscale workflow contains the operation Color Manage-
ment--CMYK Coldset.

The Coldset RGB workflow contains the operations Color Management--
RGB Coldset and GCR--Coldset_Standard.
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The Coldset SISR workflow contains the operations Color Management--
CMYK Coldset SISR, Output--Compressed Output, PDF--Coldset SISR, 
GCR--Coldset Standard, and PostProcess--Coldset_SISR.

The Coldset Standard workflow contains the operations Color Manage-
ment--CMYK Coldset, Output--Compressed Output, PDF--Coldset 
Standard, GCR--Coldset Standard, and PostProcess--Coldset_Standard.

The Heatset Grayscale workflow contains the operation Grayscale 
Heatset Commercial.

The Heatset RGB workflow contains the operations Color Management--
RGB Heatset Commercial and GCR--Heatset Standard.

The Heatset SISR workflow contains the operations Color Management--
CMYK Heatset SISR, Output--Compressed Output, PDF--Heatset SISR, 
GCR--Heatset Standard, and PostProcess--Heatset_SISR.

The Heatset Standard workflow contains the operations Color Manage-
ment--CMYK Heatset, Output--Compressed Output, PDF--Heatset 
Standard, GCR--Heatset Standard, and PostProcess--Heatset_Standard.
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Workflow Operations

“Select” on page 155

“CMYK USM” on page 158

“CMYK/Gray Min Max Dot” on page 162

“CMYK/Gray Min Max Dot” on page 162

“Artifact Removal” on page 163

“File Size” on page 166

“Color Management” on page 168

“CMYK Coldset” on page 175

“CMYK Coldset SISR” on page 176

“CMYK Heatset” on page 177

“CMYK Heatset SISR” on page 178
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“CMYK Heatset Commercial” on page 179

“Grayscale Coldset” on page 180

“Grayscale Heatset Commercial” on page 181

“RGB Coldset” on page 182

“RGB Heatset Commercial” on page 183

“Output” on page 184

“Compressed Output” on page 188

“Uncompressed Output” on page 188

“GCR” on page 189

“Coldset Standard” on page 195

“Heatset Standard” on page 195

“PDF” on page 196

“Coldset SISR” on page 210

“Coldset Standard” on page 211

“Heatset SISR” on page 212

“Heatset Standard” on page 213

“Approve” on page 214

“PostProcess” on page 218

“Coldset SISR” on page 221

“Coldset Standard” on page 221

“Heatset SISR” on page 221

“Heatset Standard” on page 221

Select

You can apply conditions to PDFs and send them to a different workflow when 
the condition is met.
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The Select function is activated when it is put into a workflow.

Enabled Enables the Select operation.

Select Sequence Identifies the selected move to workflow.

Move To Workflow Identifies the workflow that files will be moved to based on the conditions that 
match the incoming files. By checking a workflow, you are redirecting the file’s 
path.

Conditions The following conditions are available as filters.

NOTE: Not all conditions listed apply to OptiInk because only PDFs are processed

Condition Field Operator Field

True (Always) N/A N/A N/A

File Name N/A Ends With
Starts With
Match String With Wildcards

Fill in Variable

File Type N/A Is
Is Not

TIFF
JPEG
JPEG2000
PDF
EPS

Color Space N/A Is
Is Not

RGB
CMYK
Gray
DeviceN
LAB
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To configure Select

1 Turn on Edit mode.

Resolution N/A Is
Is Not
Is Greater Than
Is Less Than
Is Not Greater Than
Is Not Less Than

Fill in Variable

Image Width N/A Is
Is Not
Is Greater Than
Is Less Than
Is Not Greater Than
Is Not Less Than

Fill in Variable

Image Height N/A Is
Is Not
Is Greater Than
Is Less Than
Is Not Greater Than
Is Not Less Than

Fill in Variable

Image Size N/A Is
Is Not
Is Greater Than
Is Less Than
Is Not Greater Than
Is Not Less Than

Fill in Variable

Number of Channels N/A Is
Is Not
Is Greater Than
Is Less Than
Is Not Greater Than
Is Not Less Than

Fill in Variable

Number of Bits N/A Is
Is Not
Is Greater Than
Is Less Than
Is Not Greater Than
Is Not Less Than

Fill in Variable

Specific File Types N/A Is
Is Not
Is Greater Than
Is Less Than
Is Not Greater Than
Is Not Less Than

TIFF
JPEG
JPEG2000
PDF
EPS

Condition Field Operator Field
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2 Right-click on the Select operation, and select New.

3 Enter a name, and select OK.

4 Check Enabled to turn on the Select operation.

5 Click Automatic Selection to activate Selection Conditions.

6 Click the Plus sign to activate Selection Conditions.

NOTE: To delete the condition, click the Minus sign.

7 Click OK to make the sequence display in the sequence list.

8 Under Move To Workflow, check the desired workflow box.

9 Select the desired condition.

To add additional conditions, click the Plus sign.

To delete a line, click the Minus sign.

10 Set the Select operation in the appropriate workflow.

CMYK USM

This operation allows you to set various USM settings and saturation values on 
CMYK images.
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USM CMYK The USM CMYK main function is to alter the contrast and brightness levels of 
adjacent pixels to create a perception of increased sharpness, and to sharpen 
image details of CMYK images. Select the USM CMYK check box to activate the 
Image Quality - USM CMYK settings.

Auto USM Select the Auto USM check box to have OptiInk automatically detect if your 
image is already sharp enough. If this is the case, the Auto USM function will 
automatically reduce the amount of sharpness requested.

NOTE: Select Auto USM as the default.

Kernel The Kernel value defines the thickness of the sharpness of the lines. The 
minimum value is 3.0, and this is also the recommended value.

Set the Kernel value by entering a value in the value box.

Strength The sharpening strength value defines the desired sharpness for each image to 
reach.

Set the Strength value by doing dragging the slider to the left or right within the 
specified range of 0 and +20.00. Or enter a value between 0 and +20.00 in the 
value box.

Enter the recommended value of 4.0 for CMYK color images.
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Enter a strength value equal to zero to leave the image unchanged.

Enter a higher strength value to increase sharpness.

Grain Removal A higher grain removal value results in less sharp low contrast image areas and 
puts less emphasis on the graininess of an image.Set the Grain Removal value 
by dragging the slider to the left or right within the specified range of 0 and 
+100. Or enter a value between 0 and +100 in the value box.

Fringe Black/Fringe White A higher value protects the image more from black/white fringes. A lower value 
protects the image less from black/white fringes. Set the Fringe Black and 
Fringe White values by dragging the respective slider to the left or right within 
the specified range of 0 and +100. Or enter a value between 0 and +100 in the 
respective value box.

Input Weights Input Weights define how much of the specific channel is used to calculate 
sharpening, which is then applied to the different channels.

Set the Input Weights for all channels by entering a value between 0 and+100 
in the respective channel value box.

NOTE: Lower the Input Weight value for a specific channel if it contains a lot of 
noise.

Tonal Range USM Strength These settings define the percentage used of USM strength in the different tonal 
ranges of the image. You can specify the ranges for the master channel or all 
channels separately. Up to 6 channels can be defined. Five field ranges can be 
used: Shadows, 3 Quarter Tones, Mid Tones, Quarter Tones, and Highlights.

Channel: Select Master to define the settings for all channels.

Master: The Master settings are always used for all channels. The specific 
channel settings are only used when the Enable Per Channel check box is 
selected.

Enable Per Channel: Select Enable Per Channel to define the settings per 
channel.

Shadows: The darkest areas in an original or an image, represented in a halftone 
by the largest dots. The dot area of shadows ranges from about 80% to 100%.

3 Quarter: The 3 Quarter tone layer.

Midtones: Tonal values are midway between highlight and shadow.

Quarter: The Quarter tone layer.
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Highlights: The lightest areas in an original or an image. The maximum value is 
255 (fully white) of a 0 - 255 range.

Low values means no unsharp masking (USM) in that tonal range. High values 
means full unsharp masking (USM) in that tonal range.

To Configure CMYK USM

1 Select the USM CMYK check box to activate the USM CMYK settings.

2 Select the Auto USM check box to have OptiInk automatically detect if your 
image is already sharp enough.

3 Set the Kernel value by entering a value in the value box.

4 Set the Strength value.

1 Set the Sharpening strength so that each image reaches the desired 
sharpness.

2 Enter the recommended value of 4.0 for CMYK color images.

3 Enter a Strength value equal to zero to leave the image unchanged.

4 Enter a higher Strength value to increase sharpness.

5 Set the Grain Removal value.

6 Set the Fringe Black and Fringe White values.

7 Set the Input Weights for all channels by entering a value between 0 
and+100 in the respective channel value box.

8 Select the channel you wish to define.

1 Select Master to define the settings for all channels.

2 Select Enable Per Channel to define the settings per channel.

3 Set the Shadows value.

4 Set the 3 Quarter value.

5 Set the Midtones value.

6 Set the Quarter value.

7 Set the Highlights value.
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CMYK/Gray Min Max Dot

CMYK/Gray MinMax Dot control allows the limitation of CMYK dot values after 
main processing.

NOTE: When writing XML, use the syntax "cmykminmaxdot."

CMYK/Gray min max dot Enables overall CMYKMinMax operation. Determines the minimum and 
maximum values of dot gain for CMYK/Gray images per channel.

Minimum dot Cyan: 0 to 100.

Maximum dot Cyan: 0 to 100.

Minimum dot Magenta: 0 to 100.

Maximum dot Magenta: 0 to 100.

Minimum dot Yellow: 0 to 100.

Maximum dot Yellow: 0 to 100.

Minimum dot Black: 0 to 100.

Maximum dot Black: 0 to 100.

To Configure CMYK/Gray Min Max Dot

1 Check CMYK/Gray min max dot to enable these options.
:ARKITEX QUALITY OptiInk User’s Guide



 

3 OPTIINK OPERATIONS SETTINGS 163
Change Minimum dot Cyan by moving the slider or entering a value.

Change Maximum dot Cyan by moving the slider or entering a value.

Change Minimum dot Magenta by moving the slider or entering a value.

Change Maximum dot Magenta by moving the slider or entering a value.

Change Minimum dot Yellow by moving the slider or entering a value.

Change Maximum dot Yellow by moving the slider or entering a value.

Change Minimum dot Black by moving the slider or entering a value.

Change Maximum dot Black by moving the slider or entering a value.

Artifact Removal

This operation allows you to select a number of artifact removal settings, such as 
Color Fringe Removal, Destair, Despeckle, Descreen, and JPEG Compres-
sion Artifacts.

Color Fringe Removal Select Color Fringe removal, and unnatural colored lines surrounding high 
contrast transitions (misregistration) in an image are removed.

Destair Select Destair to smooth a staircase effect, or the square bit maps. Photographs 
taken with digital cameras often have blocky pixels. Destair repairs it. Use the 

o
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slider to set the Amount between -10 and +10, or enter a value between -10 and 
+10 in the value box.

JPEG Removal Select JPEG Removal to remove JPEG compression artifacts that were intro-
duced when converting the image to a JPEG format. JPEG compression artifacts 
can be defined as the number of horizontal and vertical lines on a grid of 8x8 
pixels.

To change the JPEG removal setting, set the JPEG Removal value by dragging 
the slider to the left (weak) or right (strong) to define how many JPEG lines will 
be removed. Or enter a value between -10 and +10 in the value box.

NOTE: A high (strong) JPEG Removal value can distort the image, and the JPEG 
compression feature will remove some detail. With a low or weak setting, the 
artifact can produce a suitable contrast. Suppose you have a grainy image. Use a 
high JPEG removal value to diminish the grains.

Noise Removal By selecting Noise Removal, noise is removed from dark and low contrast areas 
of an image. If you want OptiInk to first remove noise before removing JPEG 
compression artifacts, select Noise Removal.

Negative: Select Negative Noise to remove noise in the highlights from negative 
images, which have been processed to positive.

Pattern Noise: Select Pattern Noise to remove pattern noise in the image. 
Pattern noise is often visible on digital photographs taken indoors.

Protect Skin: Select Protect Skin to protect skin tone areas and to avoid losing 
subtle facial details.

Despeckle(Matte Photo’) Scanning photographs may result in excessive white dots on the scanned image. 
Select Despeckle to remove white spotmarks.

To change the setting, set the Despeckle value by dragging the slider to the left 
or right within the specified range of -30 and +10. Or enter a value between -30 
and +10 in the value box.

Descreen Select Descreen to remove the pattern of scanned printed originals.

Screen: Enter the Lines per Inch value of the original image. The scanned 
resolution should be at least two times the Lines per Inch to remove the pattern.

NOTE: When no value is entered, default values will be used.

Moire: A higher value will lead to more descreening; a lower value will filter less.
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To define the Moire value, dragging the slider to the left or right within the 
specified range of -10 and +10. Or enter a value between -10 and +10 in the 
value box.

To configure Artifact Removal

1 Select Color Fringe removal to activate the Artifact Removal settings.

2 Select Destair.

3 Use the slider to set the Amount between -10 and +10, or enter a value 
between -10 and +10 in the value box.

4 Change the JPEG removal setting.

5 Select Noise Removal.

1 Select Negative Noise.

2 Select Pattern Noise.

3 Select Protect Skin.

6 Select Despeckle to remove white spotmarks.

7 Select Descreen to remove the pattern of scanned printed originals.

1 Enter the Lines per Inch value of the original image.

2 To define the Moire value.
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File Size

You can control resizing, dimensions, and resolution.

Enable Resize Click Enable Resize to activate Column Width, Gutter Width, Extra Space, and 
Span Number Of Columns.

Use Pixel Dimensions Activates Maintain Proportions, Width, and Height.

Maintain Proportions: Maintains the proportions of the original image.

Width: The image width.

Height: The image height.

Column Width Specifies the column width of your newspaper columns.

Gutter Width Specifies how much space should be left between two columns.

Extra Space Specifies an extra margin for pictures. This is sometimes done to avoid optical 
illusion and to have some flexibility in placing the pictures.

Span Number Of Columns Image will span the selected the number of columns entered.
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Change Resolution Click Change Resolution to activate the New Resolution and Preserve Dimen-
sions parameters.

New Resolution: Use to change the image resolution in ppi.

Preserve Dimensions: Select this option if you want to maintain the width and 
height of your image when downsampling or upsampling. Your file size will, 
however, increase or decrease.

NOTE: When this option is not selected, your file size will be maintained. Your file 
dimensions (width and height), however, can change.

To configure File Size

1 Click Enable Resize to activate the File Size settings.

2 Click Use Pixel Dimensions.

1 Set Maintain Proportions.

2 Enter a value for Width.

3 Enter a value for Height.

3 Click Enable Resize.

1 Enter a value for Column Width

2 Enter a value for Gutter Width

3 Enter a value for Extra Space

4 Enter a value for Span Number Of Columns.

4 Click Change Resolution.

1 Enter a value for New Resolution.

2 Click Preserve Dimensions.
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Color Management 

CAUTION: Only Pure Black Options, Pure CMYK Options, and Preserve 
Overprint Behavior are enabled in OptiInk Essentials.

The Color Management Input property allows you to work with ICC profiles. 
You can: specify an input RGB Colorspace and respective rendering intent; 
override default input CMYK Colorspace and respective rendering. This function 
applies to both color and grayscale images.

The Color Management Output property allows you to work with ICC profiles. 
You can: specify not to convert a CMYK image to a working space by making a 
CMYK to CMYK link on the fly; specify an output profile and respective 
rendering intent; allow for grayscale conversion; and specify a CMYK to CMYK 
Device Link without going over the working space intent.

The Color Management Input property allows you to work with ICC profiles. 
You can: specify an input RGB colorspace and respective rendering intent; 
Override your default input CMYK colorspace and respective rendering intent.
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Override Default Working
Space

Allows the user to override the default Working Space profile. When this check 
box is disabled (off), the processor will replace the working space profile with 
the one specified in the System Preferences at run time. When the checkbox is 
enabled, the provided working space profile will override the default value 
specified from System Preferences (refer to “Working Space” on page 43).

Input RGB Colorspace Select Input RGB Colorspace if the input profile of the images is known, but not 
embedded. OptiInk will use this profile to convert the RGB images into the RGB 
working space.

NOTE: If no input RGB profile is defined and no profile is embedded, OptiInk will 
consider the image in the RGB working space. Embedded profiles are recognized 
in PDF files.

ICC Profile: A list of available profiles will be displayed when Choose is selected.
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Rendering Intent: Open the Rendering Intent list, and select the rendering 
intent best suited for the images.

When the gamut of source color space exceeds that of the destination, saturated 
colors are liable to become clipped (inaccurately represented). The color 
management operation can deal with this problem in several ways. The ICC 
specification includes four different rendering intents: absolute colorimetric, 
relative colorimetric, perceptual, and saturation.

Override Default Input
GRAY Colorspace

Select Override Default Input GRAY Colorspace to have OptiInk use another 
Input GRAY Colorspace than the one defined in the default settings.

ICC Profile: A list of available profiles will be displayed when Choose is selected.

Rendering Intent: Open the Rendering Intent list, and select the rendering 
intent best suited for the images.

Override Default Input
CMYK Colorspace

Select Override Default Input CMYK Colorspace to have OptiInk use another 
Input CMYK Colorspace than the one defined in the default settings.

ICC Profile: A list of available profiles will be displayed when Choose is selected.

Intent Description

Default Intent as supplied in the original file.

RelativeColorimetric The default rendering intent on systems. Corrects for the media 
while staying truthful to the specified color.

Perceptual Recommended for color separation.

Saturation A measure of the amount of gray in color in the HSL and HSV 
color models. The less gray in a color, the higher the saturation.

AbsoluteColorimetric Obtains an exact specified color, or quantifies the mapping 
method accuracy.

RestoreDynamicRange Restores the range of luminances between the lightest and 
darkest areas of an image.

Intent Description

Default Intent as supplied in the original file.

Perceptual Recommended for color separation.

RelativeColorimetric The default rendering intent on systems. Corrects for the media 
while staying truthful to the specified color.

Saturation A measure of the amount of gray in color in the HSL and HSV 
color models. The less gray in a color, the higher the saturation.

AbsoluteColorimetric Obtains an exact specified color, or quantifies the mapping 
method accuracy.
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Rendering Intent: Open the Rendering Intent list, and select the rendering 
intent best suited for the images.

Saturation Boost: When selecting Rendering Intent, you can define the Satura-
tion Boost value. The default value is 30.0.

Use Output Profile Select Use Output Profile to convert processed images from the RGB working 
space to another output color space (for example CMYK).

NOTE: Depending on the Output Profile chosen, if RGB, the View options under 
the Image Tab will be All, Red, Green, and Blue. If CMYK, the options will be All, 
Cyan, Magenta, Yellow, Black, and CMY.

ICC Profile: A list of available profiles will be displayed when Choose is selected.

Rendering Intent: Open the Rendering Intent list, and select the rendering 
intent best suited for the images.

CAUTION: PDF processing requires that you check Use Output Profile and select 
a CMYK profile. Refer to “Output Profile Options” on page 201.

Intent Description

Default Intent as supplied in the original file

Perceptual Workflow list

RelativeColorimetric Workflow list

Saturation Browse to folder

AbsoluteColorimetric Browse to folder

Restore Dynamic Range N/A

Intent Description

Default Intent as supplied in the original file.

Perceptual Recommended for color separation.

RelativeColorimetric The default rendering intent on systems. Corrects for the 
media while staying truthful to the specified color.

Saturation A measure of the amount of gray in color in the HSL and HSV 
color models. The less gray in a color, the higher the satura-
tion.

AbsoluteColorimetric Obtains an exact specified color, or quantifies the mapping 
method accuracy.
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Use Blackpoint Compensation: Check Use Blackpoint Compensation to 
generate images corresponding to the most common editing applications.

Use Embedded Profile Select to use the embedded profile in the images.

eq RGB to K Check if you want the RGB color to equal K (black).

Do Not Convert CMYK to
Working Space

Select Do Not Convert CMYK to Working Space to convert the CMYK image 
directly to an output profile (usually CMYK, but may also be a Gray profile or 
RGB) without specific OptiInk editing or processing except for USM on CMYK 
and scaling.

CAUTION: PDF processing requires that you check Use Output Profile and select 
a CMYK profile. Refer to “Output Profile Options” on page 201.

Pure Black Options Select Pure Black to keep the exact black (K) value from the input profile in the 
output profile (i.e., 0-0-0-K remains 0-0-0-K).

Convert Pure Black: This will convert a pure color to the new profile, where 0, 0, 
80, 0 might translate into 2, 0, 69, 0.

Dotgain Pure Black + Keep 100%: This will keep a pure color as is and does not 
convert to the new profile.

Dotgain Pure Black: This will calculate the dot gain difference between the input 
and output profile, and will only compensate the lightness value for a color, not 
chroma. The color 0, 0, 80, 0 might translate into 0, 0, 69, 0.

Pure CMYK Options Select Pure CMYK colors to keep the exact CMYK values from the input profile 
in the output profile (i.e., 0-0-80-0 remains 0-0-80-0).

Convert Pure Colors: This will convert a pure color to the new profile, where 0, 0, 
80, 0 might translate into 2, 0, 69, 0.

Convert Pure Colors + Keep Solid Primaries: This will keep a pure color as is and 
does not convert to the new profile.

Dotgain Pure Colors Only: This will calculate the dot gain difference between the 
input and output profile, and will only compensate the lightness value for a 
color, not chroma. The color 0, 0, 80, 0 might translate into 0, 0, 69, 0.

The Color Management Input property allows you to work with ICC profiles. 
You can:

Specify an input RGB Colorspace and respective rendering intent.
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Override default input CMYK Colorspace and respective rendering. 

This function applies to both color and grayscale images.

The Color Management Output property allows you to work with ICC profiles. 
You can:

Specify not to convert a CMYK image to a working space by making a CMYK 
to CMYK link on the fly.

Specify an output profile and respective rendering intent.

Allow for grayscale conversion.

Specify a CMYK to CMYK Device Link without going over the working 
space.intent.

The Color Management Input property allows you to work with ICC profiles. 
You can:

Specify an input RGB colorspace and respective rendering intent.

Override your default input CMYK colorspace and respective rendering 
intent.

Preserve Overprint
Behavior

Some PDFs containing white objects on top of an image can trigger a change in 
the overprint behavior in the output PDF when processed by OptiInk. Selecting 
an option forces the current overprint behavior to be preserved.

Don’t Preserve Zeroes: This allow changes to values even when one of the CMYK 
values is zero. This may result in changes in overprint behavior for these regions.

Preserve Zero CMY: This prevents changes when one or more of the CMY values 
are 0.

Preserve Zero CMYK: This prevents changes when one or more of the CMYK 
values are 0.

Preserve Zero CMYK: This prevents changes when one or more of the CMYK 
values are 0.

To configure Color Management

1 Select Input RGB Colorspace.

2 Browse and select an Input RGB Profile.
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3 Open the Rendering Intent list, and select the rendering intent best suited 
for the images.

4 Select Override Default Input GRAY Colorspace.

5 Browse and select an Input GRAY Colorspace.

6 Open the Rendering Intent list, and select the rendering intent best suited 
for the images.

7 Select Override Default Input CMYK Colorspace.

8 Browse and select an Input CMYK Colorspace.

9 Open the Rendering Intent list, and select the rendering intent best suited 
for the images.

10 Define the Saturation Boost value.

11 Select Use Output Profile.

12 Browse and select an output profile.

13 Open the Rendering Intent list, and select the rendering intent best suited 
for the images.

14 Check Use Blackpoint Compensation to generate images corresponding to 
the most common editing applications.

15 Select Use Embedded Profile to use the embedded profile in the images.

16 Check Do Not Convert CMYK to Working Space.

17 Select a Pure Black value (Convert, Keep, Dotgain).

18 Select a Pure CMYK value (Convert, Keep, Dotgain).

19 Check Preserve Overprint Behavior, if necessary.

Color Management Default Operations

Color management comes with seven predefined operations.
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CMYK Coldset
o
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CMYK Coldset SISR
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CMYK Heatset
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CMYK Heatset SISR
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CMYK Heatset Commercial
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Grayscale Coldset
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Grayscale Heatset
Commercial
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RGB Coldset
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RGB Heatset Commercial
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Output 

This operation allows you to choose ICC profiles for image color conversions 
from a working space to a chosen profile, or to specify a CMYK to CMYK device 
link (without going over a working space).

PDF Compression Method Select the PDF Compression Method. Choose jpg or Flate.

Jpg Quality A Jpg Quality of 10 (minimum compression) will result in a high quality image 
with a large file size. Conversely, a value of 0 (maximum compression) will 
result in a lower-quality image with a small file size. A compression value of 8 is 
recommended, but a lot depends on the quality of your output media.

Drag the slider until you reach the desired value for Jpg Quality.

CMYK jpg saved as YCCK Enables or disables YCCK transforms.

Byte Order As MacIntosh If checked then Tiff files will be written in Motorola byte order. If unchecked 
then they will be written in Intel byte order. This option may be used to write 
compatible Tiff files for older applications that do not support both reading both 
formats.

File Name Mask If you need to apply a File Name Mask, enter it in the Mask value box. The flags 
are used to specify how the OptiInk output filename is created.

%F = original filename, unmodified
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%X = extension associated with the output file format, one of tif, jpg, pdf, eps, 
or bmp

%N = job id of the job creating the file

%D = date the output file was created in the format yyyymmdd

%T = time the output file was created in the format hhmmss

%f = The original filename with the extension removed only if the extension 
exactly matches one of tif, tiff, jpg, jpeg, pdf, eps, bmp

%g = The original filename with any extension removed

%% = the % character

A blank field (the default) is internally interpreted as %f.%X, which is the 
original basename + the output filetype extension.

Any other parts of the mask appear as they are in the output name. For example, 
the mask %F_%N could produce a filename myimage_100.jpg if the original file 
was called myfile and the job number is 100. 

Values entered in Output operations can be changed in a completed image. To 
do this, open an image in Advanced, and make necessary changes. Refer to 
“Advanced Edit” on page 138.

Read PS Jpeg Resolution Controls reading the resolution in a .jpg file from the Photo Shop data.

Read Exif Jpeg Resolution Controls reading the resolution in a .jpg file from the Exif data. When checked 
the values from the Exif will override the values from the workflow.

NOTE: Jpeg images from Adobe Photoshop have their resolution information 
stored on a standard and a private place.

Use Exif Orientation Overrides rotation with the job's Exif orientation. When checked the values from 
the Exif will override the values from the workflow.

Embed Profile Profiles can be embedded for TIFF, JPEG, and EPS files.

Make Thumbnail To display thumbnails in Thumbnails view, check the Make Thumbnail check 
box. A thumbnail preview is saved together with your image.
:ARKITEX QUALITY OptiInk User’s Guide



186 OUTPUT
NOTE: The Make thumbnail control when enabled will require a render of the 
result file independent of the Ink Mode control.

NOTE: Disabling Make Thumbnail with Ink Mode set to Max Speed or Fast Edit 
will not create the result Tiff when processing PDF jobs. This feature is 
recommended when processing large PDF jobs, as well as when the user will not 
likely make frequent job edits. Make Thumbnail does not have any effect with 
jpg or Tiff files.

Ink Mode Implements Ink calc control (ISCEnable) from Output workflow. A drop-down 
menu controls the mode levels: Max Speed, Fast Edit, and Ink Report. Ink Report 
must be selected to generate ink values.

Max Speed: Max Speed will optimize performance by doing the minimum 
rendering and no preparation of colour managed source files.

Fast Edit: Fast Edit will prepare the colour managed source file at the same time 
as processing the result but will do extra rendering.

Ink Report: Ink Report will prepare the colour managed source file, render both 
source and result and perform an ink save calculation.

When a Job is viewed / edited, then any necessary source color management and 
rendering will be performed if the necessary view files do not exist. Reviewing 
the job (either by the same user, or a different client) will not require re-
rendering.

NOTE: Multiple output settings with different Ink Modes may be defined and 
deployed in different workflows.

To Configure Output

1 Select the PDF Compression Method.

Choose jpg or Flate.

2 Drag the slider until you reach the desired value for Jpg Quality.

3 Check CMYK jpg saved as YCCK, if necessary.

4 Check Byte Order As MacIntosh, if necessary.

5 To apply a File Name Mask, enter it in the Mask value box.

6 Check Read PS Jpeg Resolution, if necessary.
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7 Check Read Exif Jpeg Resolution, if necessary.

8 Check Use Exif Orientation, if necessary.

9 Check Embed Profile.

10 Check the Make Thumbnail check box. A thumbnail preview is saved 
together with your image.

11 Set the Ink Mode.
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Output Default Operations

Output comes with two predefined operations.

Compressed Output

Uncompressed Output
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GCR 

CAUTION: Only Apply GCR, and Max K are enabled in OptiInk Essentials.

The substitution process of the gray component of a color by black is known as 
Gray Component Replacement (GCR). GCR can be applied over the entire tonal 
range and in all colors. Black will be used as the equivalent result to what would 
be printed as product of the neutral or achromatic component of C, M, and Y.

This operation applies to images when using an output profile. The Gray Compo-
nent Replacement (GCR) specifications replace partly or totally the gray (or 
neutral) color components of a color by an appropriate amount of black.

GCR is expressed as a percentage of the neutral component replaced by black.

You can:

Define OptiInk to apply GCR.

Define maximum ink coverage values, overriding the profile.

The Gray Component Replacement function has a positive impact on the 
printing process as one ink (K) does the job of three (CMY):

GCR improves printability

GCR economizes on ink usage and drying time

GCR improves better ink transfer, which results in a more uniform color 
quality throughout the print process

GCR improves and stabilizes the gray neutrality, enhancing detail and 
contrast in an image

Use Apply GCR to substitute calculated amounts of Cyan, Magenta, and Yellow 
ink by Black ink. A high GCR value enforces ink saving.
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Repurposing Repurposing creates web-ready PDF output. If you check GCR Repurposing, the 
other options will be disabled.

Apply GCR If you check Apply GCR, the other options will be enabled.

with Minimum Delta E Calculates the minimum distance for two colors that are not touching to be 
placed near each other.

In Neutrals

Start K Start K defines the actual start point of the replacement of CMY by K on the light-
ness axis within the Lab colorspace, requesting a curve from that point on the 
neutral axis to the GCR Blackpoint value set. Since all ISO standard profiles 
already apply a certain amount of GCR, using a higher value than 0 for Start K 
will lower the possible ink save, or even result in a negative ink save compared 
to the original separation if extreme, and unwanted, high values are used. Since 
the GCR algorithm has been designed to calculate smooth curves for banding 
free results, requesting a Start K higher than 0 forces the software to plot CMY 
curves from 0 onwards instead. This is the reason why you see a hugh difference 
between a Start K 0% and Start K 5%.

Set the Start K value by dragging the slider to the left or right within the speci-
fied range of 0 and +100. Or enter a value between 0 and +100 in the value box.
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NOTE: Enter the recommended value of 0. Enter a higher value to avoid applying 
GCR in the (near neutral) highlights.

GCR Midtones GCR Midtones can be used to change the amount of maximum GCR set at the 
GCR Blackpoint. GCR Midtones describes the steepness or angle for the curve 
between Start K and GCR Blackpoint. When Start K is set to 0%, and GCR Black-
point to 100%, a GCR Midtones setting of 100% equals to a 900 curve, which is 
Full GCR. Putting a lower number for GCR Midtones will reflect in a lower angle 
in the curve created between Start K and GCR Blackpoint.

By default, a GCR Midtones setting of 100% is advised, since highest graying 
agents are found in this area. Lowering this setting can be useful in cases where 
a separation closer towards the profile used is required, or when jpeg artifact is 
more pronounced in the inksaved results. This is always at the expense of 
possible ink savings. However the GCR algorithm tries to prevent the user from 
creating negative ink save compared to the original separation where possible. 
It is possible to generate situations which seems to do the opposite. The GCR 
algorithm always calculates a smooth curve between Start K and GCR Black-
point to prevent banding issues in the results. This is the reason why over a short 
range a low setting of GCR Midtones might produce a higher GCR than a 
somewhat higher setting for GCR Midtones. The bandwidth of GCR Midtones is 
0 to 100.

Set the GCR Midtones value by dragging the slider to the left or right within the 
specified range of 0 and +100. Or enter a value between 0 and +100 in the value 
box.

NOTE: Enter the recommended value of +50. Enter a higher value to apply more 
GCR in the (near neutral) midtones.

GCR Blackpoint This setting is used to steer the amount of GCR to the darkest neutral point as 
defined by the Output Profile used. Logically when you start to lower the GCR 
Blackpoint (GCR on darkest neutral) setting, you will lower the entire curve, and 
also influence the effect of the value set in the GCR Midtones. From a quality and 
ink savings view point, it is recommended to use the highest settings possible. 
The bandwidth of GCR Blackpoint is 0 to 100.

Set the GCR Blackpoint value by dragging the slider to the left or right within 
the specified range of 0 and +100. Or enter a value between 0 and +100 in the 
value box.

In Colors

Chroma Zone When this slider is set to 128, it is deactivated, meaning all values between 0 and 
128 on the a and b axis will get the same GCR value as applied on similar light-
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ness value for the neutrals. Lowering this value will activate Chroma Zone, 
enabling a different amount of GCR on colors by creating a threshold between 
the setting for colors and neutrals. The GCR Neutral setting will gradually 
change to the GCR set in Chroma Zone.

Set the GCR Chroma Zone value by dragging the slider to the left or right within 
the specified range of 0 and +100. Or enter a value between 0 and +100 in the 
value box.

GCR Chroma This setting is used to set an independent color GCR value from the neutrals 
settings. Typically when a different value is needed, it will be a lower value, 
taking out GCR from color areas. This value will work until the point is reached 
where the color does not contain a graying agent or a neutral component 
anymore. When GCR Chroma or Saturation Colors is set to zero (0), any value 
set for Start K will not have any effect. The bandwidth of GCR Chroma is 0 to 
100.

Set the GCR Chroma value by dragging the slider to the left or right within the 
specified range of 0 and +100. Or enter a value between 0 and +100 in the value 
box.

Ink Limitations

Max K The setting for Max K defines the highest value for K replacing CMY. This value 
should be kept to 100% when possible, which overrules the Output Profile used. 
The 100% can be kept if the printing process is stable, and the actual measured 
dot gain is exactly linearized to the pre-compensated curve in the profile.

The "Max K" value is not dependent on "Override profile" being checked. This 
feature is provided for image and vector line art. The bandwidth of Max K is 0 to 
100.

NOTE: Make sure you know the actual profile Max K setting before altering the 
slider. If you override the profile setting with a lower value, you will increase 
CMY under the color or graying agent.

Set the Max K value by dragging the slider to the left or right within the specified 
range of +90 and +100. Or enter a value between +90 and +100 in the value 
box.

NOTE: Set the Max K value to define the Max percentage of Black ink to be 
printed. The maximum value of +100 is recommended.

Override Profile When Override Profile is unchecked, it is possible to change the value for Max K. 
If K is set lower than K as set in the profile with override profile unchecked, the 
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CMY undercolor will not increase, but any TIL value higher than the profile 
setting is left as it. There are some Smooth Blends test files in the field containing 
blends up to 400% TIL. The smoothest results can be obtained when lowering 
the GCR Chroma values. With override profile unchecked, these types of files 
will stay smooth when viewed as separate channels, but will never print 
correctly since no press can hold 400%.

If Override Profile is checked, the blends will not show smooth when viewing the 
separate channels. When printed to normal densities, this effect will not be 
visible in print, and set-off problems will not show, since the total ink limit is not 
exceeded.

The only real practical use of unchecking Override Profile is when Rich Black 
must be maintained as is. Leave it selected in all other cases to avoid issues with 
TIL.

When Override Profile is checked, a different value can be set for Total Ink Limit 
(TIL). This selection is preferred, and use Max K values as high as possible. D not 
use values lower than the profile K setting since it will start to compensate for 
any loss in density by increasing CMY, causing more ink usage in these areas.

NOTE: If you convert between two colorspaces, GCR Repurposing can also be 
considered. Although it disables the GCR and ink limitations options, it still 
produces a smoother result than GCR with the Override Profile checked.

Allow k > MaxK Set the Allow k > MaxK value by checking the box. Applying GCR will change the 
colors to a maximum K value defined in Max K, but all colors above the Max K 
value will be kept when the option "Allow k > MaxK" is enabled.

Total Ink Limit This value expresses the total amount of ink built by the four process colors. 
Typically, this value must follow the TIL or TAC value set in the output profile. If 
set to a lower value, it can easily limit the color gamut of the profile since all 
values higher than this setting will be lost. Increasing the value above the TIL 
value set in the output profile will cause a lower ink savings since more color is 
allowed. There is no CMYK printing process that can hold 400% coverage. Even 
on high quality commercial presses, the paper is unlikely to accept such an 
amount of ink. The increase of density in print will be shouldered or stopped 
long before you reach such high values; or density may even decrease when you 
allow higher values.

Set the Total Ink value by dragging the slider to the left or right within the speci-
fied range of +200 and +400. Or enter a value between +200 and +400 in the 
value box.

Enter the recommended value of +240 for maximum ink cost savings without 
losing gamut. A lower value and thus less ink on paper will affect the gamut.
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NOTE: A Total Ink Limit of 400 means that each color (CMYK) can be printed at 
a full 100%.

To Apply GCR

1 Checking GCR Repurposing disables the other options.

2 Checking Apply GCR enables the other options.

3 Check with Minimum Delta E to calculate the minimum distance for two 
colors that are not touching to be placed near each other.

4 Set the Start K value.

5 Set the GCR Midtones value.

6 Set the GCR Blackpoint value.

7 Set the Chroma Zone value.

8 Set the GCR Chroma value.

9 Set the Max K value.

10 Select Override Profile to define ink limits.

11 Select Allow k > MaxK, if necessary.

12 Set the Total Ink Limit value.
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GCR Default Operations

GCR comes with two predefined operations.

Coldset Standard

Heatset Standard
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PDF 

All color profiles used by any workflow must be installed in the Windows system 
profiles folder. Any profile which needs to be available for automatic matching 
by SISR must be placed in the "processor/input profiles" folder in the OptiInk 
install area, and also in the Windows system profiles folder.

You can:

Process the RGB images within a PDF file

Process the CMYK images within a PDF file

Process the Gray images within a PDF file

Prevent specific images of being processed

Do Not Process If

Conditions can be set to prevent certain images in a PDF file from being 
processed. Conditions are determined by image size or type. Images with 
disabled processing can still be converted to the output profile.

Size Less Than Select Size Less Than, and fill in the amount of pixels to prevent small images 
from being processed. By default images with a height or width smaller than 15 
pixels will be skipped during processing.

W/H Ratio Greater Than Select W/H Ratio Greater Than, and fill in the maximum aspect ratio to prevent 
images with unusual proportions being processed. By default images with a ratio 
of width to height of more than 10 pixels will be skipped.
:ARKITEX QUALITY OptiInk User’s Guide



 

3 OPTIINK OPERATIONS SETTINGS 197
H/W Ratio Greater Than Select H/W Ratio Greater Than, and fill in the maximum aspect ratio to prevent 
images with unusual proportions being processed. By default, images with a 
ratio of height to width of more than 10 pixels will be skipped.

Contains Overlapping
Images

Select Contains Overlapping Images to avoid overlapping images being 
processed.

NOTE: Overlapping images may be generated, e.g., by Indesign, when creating a 
dropshadow on text located on an image.

Image is Logo Or Gradient Select Image is Logo Or Gradient to prevent logos and gradients being 
processed. OptiInk will not make any distinction between images and logos 
saved in an image format (e.g., JPEG, EPS, or TIFF) to be displayed in the matrix 
view, or to be processed. To prevent images and logos being displayed and/or 
processed, select the appropriate filters.

Image Is Flattened Select Image Is Flattened to avoid images composed of several parts from being 
processed as they would be treated as separate images. Overlapping Images, 
Logo or Gradient, and Flattened are configured along with Error Handling.

Other Options

Use Highest Resolution
Image

PDFs can contain the same image with different resolutions. When checked the 
highest resolution of that image will be used for processing. OptiInk renders 
default to a resolution of 72 dpi, but high rendering at 200 dpi is possible. The 
total Ink used on the page can be seen directly.

PDF Output Header Workflows attached to some older RIPs fail because the RIP does not support 
more recent PDF header formats. PDF Output Header allows the workflow to 
specify the header format of the result file. Three options are available: Original, 
PDF 1.3, and PDF 1.5.

Original: This selection will retain the format of the input file. The exception is if 
the header is simply "%!PDF". In that case the 1.3 format is enforced.

PDF 1.3: The output header will always be "%!PDF-1.3".

PDF 1.5: The output header will always be "%!PDF-1.5".

Process Gray Gray will be processed. Select a workflow from the dropdown list.

Process RGB RGB will be processed. Select a workflow from the dropdown list.

Process CMYK OptiInk can recognize and attribute a CMYK input profile to images without an 
embedded input profile (Smart Input CMYK Space Recognition - SISR). If an 
embedded profile is present, SISR will not be activated. If a matching input 
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profile is not found in the list of predefined profiles, the profile defined in the 
Default Input CMYK Color Space will be used.

NOTE: Checking Process CMYK enables Smart Input CMYK Space Recognition 
and the Recognition Mode dropdown list under Input Profile Options.

Error Handling

On Logo Or Gradient By selecting On Logo Or Gradient, all PDF files containing logos or gradients 
will be listed in the Optiink.errors file. In the Optiink.errors file only the 
filenames of those files containing logos and/or gradients will be listed. A 
manual check should be performed to determine the concerned images.

On Flattened Image By selecting On Flattened Image all PDF files containing flattened images will 
be listed in the Optiink.errors file. In the Optiink.errors file only the filenames of 
those files containing flattened images will be listed. A manual check should be 
performed to determine the concerned images.

Sometimes, a PDF image can be composed of several separate images. In this 
case, images may be processed and displayed in semiautomatic mode. Select On 
Flattened Image, and manually verify the images detected as flattened.

Error handling is now enhanced with support for flattened PDF images. 
Flattened PDF alert settings for Ignore, Warning, and Error are included in the 
:ARKITEX QUALITY OptiInk User’s Guide



 

3 OPTIINK OPERATIONS SETTINGS 199
workflow operation for PDF. The error setting works in conjunction with the 
workflow operation for Post Process to reroute a flattened PDF job to a workflow 
that is suited for these images.

On Overlapping Images By selecting On Overlapping Images, all PDF files containing overlapping 
images will be listed in the Optiink.errors file.

When a job arrives that contains overlapping, logo/gradient, or flattened 
images, a status for the job will appear in the Job list based on the settings chosen 
in the PDF operation:

Ignore (Jobs are processed without interruption. Ignore any problem conditions 
in the job.)

Warn (Jobs are processed with warnings.)

Error (Jobs fail to process, and no results appear.)

A status line will also appear in the Job log.

Input Profile Options 

Use Output Intent Check Use Output Intent for processing of PDF pages containing abutting 
vector objects and images, which depended on Use embedded being set.

Smart Input CMYK Space
Recognition

Enables the SISR profiling options. A lot of incoming files are not correctly 
separated for the intended printing process. A lot of PDFs do not contain an 
Output Intent or ICC based content, hence no color information is shared with 
the document. Sometimes even different device-CMYK spaces are combined in 
the same document while the input space is assumed to be known and correct. 
This can easily lead to problems if the separated gray balance differs from the 
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actual intended output. As a result unwanted color casts will be introduced, or 
images might look too dark or too pale on screen or in print.

OptiInk is able to intelligently assign an input profile when it is not provided in 
the PDF file. This module is called Smart Input Space Recognition or SISR.

Each image separated to such ICC profile will always carry parts of the same 
“fingerprint” hidden in the characteristics of the separation. SISR is able to 
accurately calculate which original profile was used to separate an image. This 
calculation is based on a lot of characteristics such as total ink layer, gray 
balance, dot gain, gamut, etc. As default a “match” over 90% must be found 
before such calculated profile will be reassigned. If an image is flattened in 
different parts, it will be recognized and handled as one large image.

Number of Images To
Estimate

When estimating the CMYK profile a set of images from the input file are 
selected. This value determines the maximum number of images to use.

Generally speaking, the larger the number of images, the longer it takes to 
generate an estimate. The estimate will likely be more accurate in that case. The 
default value is ten (10).

SISR

If all the different, incorrect, colorspaces in your files are confusing, enable 
Smart Input Space Recognition or SISR. SISR is capable of calculating the 
original CMYK colorspace used for your file contents by automatically assigning 
these profile(s). However in a production environment setup, typically a scaled 
SISR document profile is calculated and assigned to the entire contents. SISR is 
also capable of assigning on the object level.

SISR is capable of automatically calculating an SISR document profile based on 
a selectable amount of images in a document, and assign that profile to all 
images if the setting Use Most Recurrent For All Images is used. This is the 
default setting in a normal production environment.

If set to Use Most Recurrent For All Images, SISR will calculate and assign a 
profile for each image. If no match of 90% or better with any of the existing 
profiles in the input profiles folder is found, the most found profile is assigned 
instead.

SISR and Standard Workflows

When using SISR workflows, pay attention to the fact that by default an SISR 
document profile is calculated based on the preferences set, and content deliv-
ered in the file. Normally vector data will be color managed using the same 
calculated document profile, all meant to avoid any issues with flattened PDF 
files. If later only parts of this document, e.g., page 2 out of 10 pages are resent 
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to OptiInk, the content is different, hence the calculation could be different. To 
avoid this, it is advised to handle the documents always in the same way, by 
resending the entire document.

If it is known that pages are composed from various CMYK colorspaces, e.g., ads, 
the most accurate way is to send all ads separately before they are combined into 
one page or document. You can set a value for the amount of images calculating 
a document profile, balancing between accuracy and speed.

Recognition Mode To activate, check Process CMYK, and then check Smart Input CMYK Space 
Recognition.

Use Default For Non-Profile Images: Select Use Default For Non-Profile Images 
to use the default profile.

Use Most Recurrent For Non-Profile Images: Select Use Most Recurrent For Non-
Profile Images to apply the most recurrent recognized input profile to the 
images without a known input profile in the PDF file.

Use Most Recurrent For All Images: Select Use Most Recurrent For All Images to 
apply the most recurrent recognized input profile to all images within the PDF 
file.

NOTE: Other recognized profiles present in the PDF file will be overwritten. User-
defined and embedded profiles have priority. If the profile cannot be recognized 
by SISR, the Default Input CMYK Color Space Profile will be used as defined in 
the Default Color Settings.

Tolerance This value is used for estimating the CMYK profile to be used by the Medusa 
library. The tolerance is the delta from a named point. If the delta is larger than 
the tolerance, a particular profile will be rejected.

The default value is ten (10). The value specified will now override the default. 

Output Profile Options 

CAUTION: Only Missing Spot Strategy, Processes SpotColors (DeviceN), and 
Keep Process Colors (only DeviceN) are active in OptiInk Essentials.

Missing Spot Strategy If a given spot color name is not found, OptiInk will use a missing spot strategy 
to decide how to continue. The following strategies are available:

Replace with alternate: PDF files can include a CMYK alternative for spot colors. 
This option will take the CMYK value from the PDF file. Alternate are default 
values available in the spot color. This will never produce precise color for the 
:ARKITEX QUALITY OptiInk User’s Guide



202 PDF
output profile selected, but at least generates a generic CMYK value if speed and 
ease of use are more important than precise conversions.

Error if not found: This option will give an error if a spot in the PDF cannot be 
found in the color books.

Keep spot colors: This option will leave the spot color unchanged if it is not in the 
color books. No ink save is applied, and it is up to the RIP to sort out the CMYK 
conversion.

Process SpotColors
(DeviceN)

Converts Spot Colors to their corresponding CMYK values. To enable Spot 
Colors to CMYK, check the Output Profile Normalize Text/Vectors Options 
box.

NOTE: When OptiInk finds a spot color, if SpotColors to CMYK is unchecked, 
then ALL spot colors are left unchanged. No ink save is applied, and it is up to the 
RIP to sort out the CMYK conversion. If the box is checked, OptiInk will convert 
spot colors to CMYK and optimize whenever it can find the spot color in its color 
books.

Keep Process Colors (only
DeviceN)

Select Keep Process Colors (only DeviceN) if there are only processed colors 
and you do not want ink savings. Any DeviceN color which actually describes a 
process color (e.g., Process Cyan 20%), will not be handled as spot color, but as 
process color instead.

Output Profile Normalize
Unprocessed Images

Select Output Profile Normalize Unprocessed Images if all skipped images 
still need to be converted to the output color profile or if any skip conditions have 
been selected.

Pure Black Noise Margin % A setting to overcome issues with scanned text and other image material with a 
certain noise level in CMYK. Typically when text is scanned in as an image, text 
is not exactly 100%K. Moreover, when placed together with other content in a 
CMYK page, such scanned text is often converted to a combination of CMYK, 
where K should be 100%, and all other channels should be 0%, but is not. In 
practice, this will result in ranges where K is, e.g., 96%-100%, and CMY values 
can be found in ranges, e.g., below 4%.

When apply ink save, all image content will be color managed as long as it is not 
Pure CMYK or Pure K, set by default to be kept in the color managed settings. 
This means any combination in scanned text not exactly C0%, M0%, Y0%, 
K100%, will be color managed and ink saved to possibly quite different results 
depending on the settings used. When Max K is set to a lower value than 100%, 
CMY will be increased to keep the same appearance in print.

This is unwanted for both registration issues on press, and ink savings issues; 
more expensive CMY ink is used instead of cheaper black ink. The setting 
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Override Profile does not influence this behavior. To set the behavior of images 
containing scanned text or logos, Pure Black Noise Margin can be used.

Practical Use: Black Noise Margin consists of one parameter, which converts 
near Pure Black (e.g., C 3%, M 2%, Y 2%, K 96%) to Pure Black (C 0%, M 0%, Y 
0%, K 100%), when the option Keep Pure Black is activated. If Black Noise 
Margin is set to 0%, it is deactivated. Any value set for Black Noise Margin (K) 
is 2 times the noise value for CMY:

Black Noise Margin=2
K 98% and higher will be 100%
CMY noise 1% and lower will be 0%

Black Noise Margin=6
K94% and higher will be 100%
CMY noise 3% and lower will be 0%

NOTE: If the BNM (Black Noise Margin) is greater than zero, and the CMY values 
are less than the margin, and the K value is near 100 (greater than 100% - (2 * 
BNM)), then the values for that object are set to 0,0,0,100 (pure Black).

Output Profile Normalize
Text/Vector Options

By selecting Output Profile Normalize Text/Vector Options, you can define 
processing and output profile settings for all text, gradients, solid colors, and 
line art elements in PDF files.

Converting elements other than images in the PDF file may be of interest in order 
to save ink or to convert text, gradients, line art, etc., to the same output (CMYK) 
space as the images.

Ink saving can be obtained by choosing an output profile with a higher GCR 
percentage and lower total ink coverage, or by setting the GCR parameters.

Text & Vector Options 

CAUTION: Only Input Profile From SISR, Pure CMYK Options, Pure Black 
Options, and Preserve Overprint Behavior are active in OptiInk Essentials.
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Input Profile from SISR Check Input profile from SISR if needed.

Rendering Intent (RI): Select a Rendering Intent (RI) from the list.

NOTE: You can define a separate rendering intent for text and line art. If no 
rendering intent is defined, the RI defined for the images will be used. Refer to 
“Specifying User Preferences” on page 68.

Blackpoint Compensation (BPC): Check Blackpoint Compensation (BPC) if 
needed.

Pure CMYK Options Pure CMYK colors are colors in image or vector/lineart objects that are 
composed of a combination of a single color, and the other colors and K are zero. 

Intent Description

Default Intent as supplied in the original file.

Perceptual Recommended for color separation.

RelativeColorimetric The default rendering intent on systems. Corrects for the 
media while staying truthful to the specified color.

Saturation A measure of the amount of gray in color in the HSL and HSV 
color models. The less gray in a color, the higher the satura-
tion.

AbsoluteColorimetric Obtains an exact specified color, or quantifies the mapping 
method accuracy.

Restore Dynamic Range Select Restore Dynamic Range if images in a CMYK colorspace 
for newspaper printing needs to be processed by IntelliTune. 
Using Saturation boost in combination with the Restore 
Dynamic Range intent will increase the color gamut of the 
original CMYK image.
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Select Pure CMYK Options to keep the exact CMYK values from the input profile 
in the output profile (i.e., 0-0-80-0 remains 0-0-80-0).

Convert Pure CMYK: This will convert a pure color to the new profile, where 0, 0, 
80, 0 might translate into 2, 0, 69, 0.

Dotgain Pure Colors + Keep Solid Primaries: This will keep a pure color as is and 
does not convert to the new profile.

Dotgain Pure Colors Only: This will calculate the dot gain difference between the 
input and output profile, and will only compensate the lightness value for a 
color, not chroma. The color 0, 0, 80, 0 might translate into 0, 0, 69, 0.

Pure Black Pure Black is any K value in CMYK where the other channels are zero (e.g., 0, 0, 
0, 72). Select Pure Black to keep the exact black value from the input profile in 
the output profile (i.e., 0-0-0-K remains 0-0-0-K).

Convert Pure Black: This will convert a pure black to the new profile.

Dotgain Pure Black & Keep 100%: This will keep a pure black as is and does not 
convert to the new profile.

Dotgain Pure Black: This will calculate the dot gain difference between the input 
and output profile.

Preserve Overprint
Behavior

Some PDFs containing white objects on top of an image can trigger a change in 
the overprint behavior in the output PDF when processed by OptiInk. Selecting 
an option forces the current overprint behavior to be preserved.

Don’t Preserve Zeroes: This allow changes to values even when one of the CMYK 
values is zero. This may result in changes in overprint behavior for these regions.

Preserve Zero CMY: This prevents changes when one or more of the CMY values 
are 0.

Preserve Zero CMYK: This prevents changes when one or more of the CMYK 
values are 0.

Preserve Zero CMY + K Overprint: This prevents changes when one or more of the 
CMY values are 0 and the K value is overprinting.

Keep 400% Select the keep 400% check box if you want to retain all CMYK channels to 
100%.

eq RGB to K Check if you want the RGB color to equal K (black).
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NOTE: For PDF processing an internal flag for "HonorInkLimits" is fixed ON. 
When GCR sliders for Max K and Total Ink Limit are active, they will be 
honored. This is evident when Keep 400% is un-checked, and the ink values are 
set (Max K less than 100, and Total Ink Limit 240). Refer to “GCR” on page 189.

Pure RGB black To 100% K Check Pure RGB black To 100% K to convert RGB black (0-0-0) to pure CMYK 
black (0-0-0-100).

Keep CMYK Check Keep CMYK, and enter the values for Cyan, Magenta, Yellow, and Black 
in the corresponding boxes that should not be modified when the job is 
processed. Values of 0,0,0,0 activate the pdf_lineart_keep-cmyk_list.txt file. 
Refer to “pdf_lineart_keep_cmyk_list.txt” on page 222.

Keep CMYK Text File Enhanced control of processing for Keep CMYK colors in PDF. The PDF workflow 
operation includes a drop-down menu for selecting user-created .txt files 
containing Keep CMYK values.

Users can place any number of customized “keep CMYK" text files with extension 
.txt in the \optiink_filestore\ _scripts folder. Select one "keepCMYK" txt file for 
each workflow.

CMYK Values are extracted from the text file selected in the comboBox. The 
cmyk values in the .txt file apply to the individual workflow.

Protect Transparency Transparent objects are protected from GCR processing when this feature is 
enabled.

Spot Color Replacement

Spot Color Replacement Replaces the color of an object with the selected CMYK channel.
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NOTE: To use the Spot Color Replacement, you must check the Spot Colors To 
CMYK <replace with alternate> in the Output Profile options above. Using 
this feature will cause objects in the named Spot Color to be converted to the 
CMYK channel selected with the checkboxes. For example, selecting Replace 
Cyan Ink and entering Sky Blue as the Spot Color will convert the Sky Blue 
objects to Cyan. This would allow the press to run with Sky Blue in the Cyan slot 
and output as a 4-color rather than 5-color.

Replace Cyan Ink: Check to replace the object with the Cyan channel.

With Spot Color: Enter the name of the spot color.

Replace Magenta Ink: Check to replace the object with Magenta channel.

With Spot Color: Enter the name of the spot color.

Replace Yellow Ink: Check to replace the object with Yellow channel.

With Spot Color: Enter the name of the spot color.

Replace Black Ink: Check to replace the object with Black channel.

With Spot Color: Enter the name of the spot color.

To configure the PDF Operation

1 Select Size Less Than, and fill in the amount of pixels.

2 Select W/H Ratio Greater Than, and fill in the maximum aspect ratio.

3 Select H/W Ratio Greater Than, and fill in the maximum aspect ratio.

4 Select Contains Overlapping Images.

5 Select Image is Logo Or Gradient.

6 Select Image Is Flattened.

7 Select Use Highest Resolution Image if needed.

8 Set the PDF Output Header.

9 Check Process Gray, and select a workflow from the dropdown list.

10 Check Process RGB, and select a workflow from the dropdown list.

11 Check Process CMYK, and select a workflow from the dropdown list.

12 Select the On Logo Or Gradient radio buttons.
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13 Select the On Flattened Image radio buttons.

14 Select the On Overlapping Images radio buttons.

15 Check Use Output Intent for processing of PDF pages containing abutting 
vector objects and images, which depended on Use embedded being set.

16 Smart Input CMYK Space Recognition enables the SISR profiling options.

17 Set Number of Images To Estimate.

18 Select the type of Recognition Mode.

1 Select Use Default For Non-Profile Images to use the default profile.

2 Select Use Most Recurrent For Non-Profile Images to apply the most 
recurrent recognized input profile to the images without a known input 
profile in the PDF file.

3 Select Use Most Recurrent For All Images to apply the most recurrent 
recognized input profile to all images within the PDF file.

19 Set Tolerance by moving the slider.

20 Select a Missing SpotColors Strategy from the dropdown list.

21 Select Process Colors (DeviceN) if there are only processed colors and you 
do not want ink savings.

22 Check Keep Process Colors (only DeviceN) to convert Spot Colors to their 
corresponding CMYK values.

1 Select an action from the dropdown list (Replace with alternate, Keep 
spot colors, Error if not found).

23 Select Output Profile Normalizes Unprocessed Images if all skipped 
images still need to be converted to the output color profile.

24 Set the Pure Black Noise Margin % value.

25 Select Output Profile Normalize Text/Vector Options to activate the Text 
& Vector Options.

Text & Vector Options

26 Check Input profile from SISR if needed.

27 Select a Rendering Intent (RI) from the list.

28 Check Blackpoint Compensation (BPC) if needed.

29 Select an option under Pure CMYK.
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30 Select an option under Pure Black.

31 Select an option under Preserve Overprint Behavior.

32 Keep 400% is already checked.

33 Check eq RGB to K if the RGB color should equal K (black).

34 Check Pure RGB black To 100% K.

35 Check Keep CMYK, and enter the values for Cyan, Magenta, Yellow, and 
Black in the corresponding boxes.

36 Select the CMYK Text File from the dropdown list.

37 Select Protect Transparency, if necessary.

Spot Color Replacement

38 Check the desired CMYK channel.

39 Enter the Spot Color Replacement name.

40 Repeat for additional CMYK channels and spot color replacement names.
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PDF Default Operations

PDF comes with four predefined operations.

Coldset SISR
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Coldset Standard
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Heatset SISR
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Heatset Standard
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Approve

This operation is used to approve a processed image after comparing it with the 
original.

If approve is selected, the job stops after processing; and the user can accept it, 
reject it, or change the settings and resubmit it.

Enabled Activates the Approve settings.

Approve Mode Select from the Approve Mode check boxes.

On Success: Enable approve on success.

On Warning: Enable approve on warning.

On Error: Enable approve on error.

Allow Re-Approve This controls what happens after resubmitting (whether you have to approve the 
job again, or whether the job goes straight to complete on the second pass).

On Reject You can determine what to do with a file if it is rejected. You have the options of 
creating jobs from source files or result files, copying source and result files, 
moving result files, deleting the source and result files, purging, and saving in 
Photoshop.

Object Operand Operator

Do Nothing N/A N/A

Create Job From Source Workflow list Plus/Minus

Create Job From Result Workflow list Plus/Minus

Copy Source To Folder Browse to folder Plus/Minus

Copy Result To Folder Browse to folder Plus/Minus

Move Result To Folder Browse to folder Plus/Minus
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To configure Approve

1 Check Enabled to activate the Approve settings.

2 Select the Approve Mode.

3 Check Allow Re-Approve on Submit.

4 Select an object from the list.

NOTE: By default, Do Nothing is selected.

5 If you select the Script option. you can browse to a script.

6 If you select Copy Result To Folder, Browse and Plus buttons will display.

Script Browse to folder Plus/Minus

Delete Source N/A Plus/Minus

Delete Result N/A Plus/Minus

Purge N/A Plus/Minus

Photoshop Open Save N/A Plus/Minus

Error Retry N/A Plus/Minus

Object Operand Operator
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Click Browse.

An Output dialog box will appear.

Select a folder under Output.

The New and Delete buttons will activate.

Click New. A New dialog box displays.
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Enter the name of the folder.

The new folder appears under the parent folder.

Select the new folder, and click OK to select it.
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The folder location will display.

7 Click the Plus button to display another line.

8 To delete the line, click the Minus button.

PostProcess 

This operation is used to control processed images.

Enabled Activate the PostProcess options

Move On Error: Check Move On Error to activate a folder to hold errored result 
files.

Alert On Error: Check Alert On Error to receive an alert message if an error 
occurs. You will need to configure Email under System Preferences to get the 
alert. Refer to “Email Settings” on page 51.

Preserve input folders on output: Checking this option will use the input scan path 
below the scanning root to determine where to store the files in PostProcess 
output operations. For example, assume a file is dropped into Scan\SubScan 
where Scan is the path of the top level folder below a scanning root point. If the 
Output Path storage is configured to be optiink_output\Outfolder and Preserve 
is checked, then this file will be stored at 
optiink_output\Outfolder\Scan\SubScan.

NOTE: The Administrator must configure hfscanner.properties.

Configure hfscanner.properties

1 Stop all processes if OptiInk is running.

2 Edit the hfscanner.properties file located in Program 
Files\Agfa\OptiInk\config.
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3 Look for the variable manageFolders. The default setting at the time of 
installation for manageFolders = true.

4 Change to manageFolders = false.

5 Start all processes.

Source and Result Files You have the options of creating jobs from source files or result files, copying 
source and result files, moving result files, deleting the source and result files, 
purging. and saving in Photoshop.

Photoshop Open/Save

Sometimes image format incompatibilities can be handled by opening the image 
with PhotoShop, and saving it again without any additional processing to 
refresh the structure of the image format.

To automate this, select "PhotoShop Open Save." If this is switched on, the result 
image should automatically be opened in Photoshop, and resaved before 
continuing with any PostProcess steps.

NOTE: For this to be functional, Photoshop must be present on the server.

Error Entry

Error Retry is used to retry the job with another workflow. This also causes 
flattened image PDF files to be re-processed with another workflow, if the setup 
is there.

Object Operand Operator

Do Nothing N/A N/A

Create Job From Source Workflow list Plus/Minus

Create Job From Result Workflow list Plus/Minus

Copy Source To Folder Browse to folder Plus/Minus

Copy Result To Folder Browse to folder Plus/Minus

Move Result To Folder Browse to folder Plus/Minus

Script Browse to folder Plus/Minus

Delete Source N/A Plus/Minus

Delete Result N/A Plus/Minus

Purge N/A Plus/Minus

Photoshop Open Save N/A Plus/Minus

Error Retry N/A Plus/Minus
:ARKITEX QUALITY OptiInk User’s Guide



220 POSTPROCESS
Jobs that error in the current workflow can be rerouted to a different workflow 
for revised processing. This feature is especially useful with flattened PDF jobs.

To configure the PostProcess Operation

1 Check Enabled to activate the PostProcess settings.

2 Check Move On Error.

3 Click Choose. An Output dialog box will appear.

4 Select Heatset_Standard, Heatset_SISR, Coldset_Standard, or 
Coldset_SISR under Output.

5 Click New. The New dialog box displays.

6 Enter the name of the folder.

7 Select the new folder, and click OK.

8 Check Alert On Error.

9 Check Preserve input folders on output.

10 Select an object from the list.

11 Click the Plus sign to add another process.

12 Select Create Job from Source and a dropdown displays showing the 
current workflows.

13 Click the workflow dropdown list to select a workflow.

1 Click the Plus sign to add another process.

2 Click Minus to delete the process.
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PostProcess Default Operations

PostProcess comes with four predefined operations.

Coldset SISR

Coldset Standard

Heatset SISR

Heatset Standard
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pdf_lineart_keep_cmyk_list.txt

A single pdf_lineart_keep_cmyk_list.txt is provided in the code folder and is 
used globally in any workflow where this facility is enabled.

Keep files with a .txt extension will be kept in the _scripts folder in the filestore. 
The checkbox on the PDF tab will be replaced by a combo box showing all avail-
able .txt files. The first combo-box entry is "None", equivalent to not using a keep 
file,

NOTE: Each PDF preset can have its own keep file selected.

The UI allows a single text/vector color to be protected against change when the 
PDF is processed.

The values in the four Keep CMYK boxes identify the combination of Cyan, 
Magenta, Yellow, and Black that are to be excluded from processing. This 
provides you with a single combination.

A special case is provided when more than one combination is desired, or if a 
translation is to be enabled. That case is identified when a zero (0) is entered in 
each of the boxes.

pdf_lineart_keep_c

myk_list.txt

Protect Multiple Colors

When zeros are present in each of the four boxes next to the Keep CMYK check 
box, the system is instructed to retrieve “keep and translation” values from this 
text file in the code folder:

CAUTION: These are new locations from previous releases. Copy any customized 
files to these locations.

C:\optiink_filestore\_scripts\pdf_lineart_keep_cmyk_list.txt

or

C:\itx_filestore\_scripts\pdf_lineart_keep_cmyk_list.txt

pdf_lineart_keep_cmyk_list.txt can also be a user created .txt file that is specified 
in the workflow, and will apply only the workflow in which it is selected.
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NOTE: This is an ASCII file that describes translation and exception rules. Lines 
that start with "//" are comments. Blank lines are ignored.

The file can contain a list of CMYK values, 1 per line:

0 0 0 0

255 128 64 0

Etc…

NOTE: PDF jobs which contain an image composed entirely of pure white will 
fail. PDF jobs with >1000 images (approximately) may fail.

The general format is:

1 Three or four input values (rgb or cmyk), 4 output values (cmyk), 
"colorspace" "colorspace" "operator".

2 All values are separated by spaces. Colorspace and operator are in double 
quotes. Colorspace and operator are optional. When operator is omitted, 
"EQ" is assumed. The values for operator are: "LT", "EQ", "GT".

3 A line with only four entries is assumed to be a "Keep CMYK" definition. This 
provides a mechanism to specify multiple keep values.

4 A line with two sets of four values is assumed to be a translation from CMYK 
to CMYK color space.

The following two lines are equivalent:

20 100 100 0 20 40 60 10 // translate cmyk value 20 100 100 0 to 20 40 60 10

20 100 100 0 20 40 60 10 "cmyk" "cmyk" "EQ" // translate cmyk general form

The following example translates all CMYK values LESS THAN (1 2 3 10) to 
(5 6 7 8):

1 2 3 10 5 6 7 8 "cmyk" "cmyk" "LT"

The following example translates all CMYK values GREATER THAN (0 0 0 
90) to (10 11 12 100):

0 0 0 90 10 11 12 100 "cmyk" "cmyk" "GT"
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The following line translates all RGB values GREATER THAN (230 240 250) 
to (5 4 3 2); the range of RGB is 0 to 255:

230 240 250 5 4 3 2 "rgb" "cmyk" "GT"

SISR

If all the different, incorrect, colorspaces in your files are confusing, enable 
Smart Input Space Recognition or SISR. SISR is capable of calculating the 
original CMYK colorspace used for your file contents by automatically assigning 
these profile(s). However in a production environment setup, typically a scaled 
SISR document profile is calculated and assigned to the entire contents. SISR is 
also capable of assigning on the object level.

SISR is capable of automatically calculating an SISR document profile based on 
a selectable amount of images in a document, and assign that profile to all 
images if the setting Use Most Recurrent For All Images is used. This is the 
default setting in a normal production environment.

If set to Use Most Recurrent For All Images, SISR will calculate and assign a 
profile for each image. If no match of 90% or better with any of the existing 
profiles in the input profiles folder is found, the most found profile is assigned 
instead.

Special Conversion Options in OptiInk

Some applications create equal RGB values instead of gray in images and other 
objects. However not visible on the screen, in the final output RGB will be 
converted to CMYK. Depending on the separation in the profile, a lot of the infor-
mation will go into the CMY channels causing registration issues and color casts. 
OptiInk can detect in both image and vector content if RGB values are equal. If 
RGB values are equal, OptiInk can convert this data into gray automatically. 
Apart from the technical issues it will solve, this option again lowers the amount 
of ink used dramatically.

To be able to handle both image objects and text and lineart, check the options:
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Convert equal RGB to Gray under the Color Management output.

Pure RGB black to 100% K under PDF--Text & Vectors

Another option to convert pure RGB black to 100% (which, for example, can be 
created by Microsoft® Word) is to check the box convert pure RGB black to 
100% in PDF--Text & Vectors.
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APPENDIX
A Glossary

This glossary defines many of the terms used in this document with which the 
user may not be familiar.

B

Black Point Compensation An option 
checking the difference of the black 
points of the source and destination 
profile. When selected, the full 
dynamic range of the source space is 
mapped to the full dynamic range of 
the destination space.

C

Color Management A Color Manage-
ment System (CMS) ensures color 
uniformity across input and output 
devices so that final printed result 
match originals. The characteristics 
or profiles of devices are normally 
established by reference to standard 
IT8 color targets.

CMYK Cyan, magenta, yellow, and 
black are the four basic colors used 
in printing processes. CMY are the 
primary colorants of the subtractive 
color model. Black is usually added 
for color depth and ink 
economizing.

Coldset Presses Coldset presses are 
used for standard newspapers.

Compression Software algorithms 
that reduce the number of binary 
digits in a digital file by eliminating 
redundant information. Data 
compression reduces file sizes.

E

EXIF Exchangeable Image File 
Format, a standard for storing inter-
change information in image files.

G

Gamma (Monitor Gamma) Gamma 
describes the relationship between 
the voltage input and the luminance 
of your monitor. The preferred value 
of your gamma also depends on the 
type of monitor you are using. The 
preferred gamma value for a CRT 
monitor 1.8, whereas the preferred 
value for an LCD screen is 1.0.

Gamut The tonal range of colors that 
a device can reproduce. The gamut 
is by definition smaller than its 
corresponding color space. A color is 
"out of gamut" when its position in 
one device's color space cannot 
directly be translated into another 
device's color space. A typical CMYK 
gamut is usually smaller than a 
typical RGB gamut.

Gray Component Replacement (GCR)
A color separation technique that 

substitutes black ink for calculated 
amounts of cyan, magenta, and 
yellow ink. GCR economizes on inks 
because one ink (black) does the job 
of three (cyan, magenta, and 
yellow). It also economizes on time 
because only one ink has to dry. 
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Good printing requires economical 
use of all ink to avoid exceeding the 
capacity of the paper to absorb it. 
Using black ink brings out better 
detail and contrast in an image.

Grayscale A range of grays with 
regular density intervals from white 
to black. A gray-scale image is an 
image that contains various levels 
(or shades) of gray.

H

Heatset Presses Heatset presses are 
used for magazine-type work, or 
very high-end newspapers. They use 
profiles with greater total ink 
coverage, and are generally higher 
quality, both in terms of paper used, 
and the quality of the print. 
Commercial, magazine and high-
quality inset work might use them.

I

IPTC International Press Telecom-
munication Council.

L

.log This is the suffix used to describe 
the file created by the :Arkitex 
Director Engine if the 'LOG' option is 
turned on in the Arkitex Director 
Setup Utility. This log contains all 
the messages seen in the Engine log 
window.

P

PDF Portable Document Format. A 
file format used to describe cross-
platform documents which are 
created using Adobe Acrobat 
Exchange or Distiller, and which can 

be viewed on-screen and printed, 
using Adobe Acrobat Reader.

Pixel A pixel is a picture element. 
Digital images are composed of an 
array of pixels, each having a 
specific color or tone. The eye 
merges differently colored pixels 
into continuous tones.

Profile The color characteristics of an 
input or output device - including its 
gamut, colorants, and modes of 
operation - used by a color manage-
ment system to ensure color fidelity.

Proof A single reproduction of an 
image as a sample to verify its 
density or its color without actually 
having to print it on a printing press.

R

Rendering Intent The method a CMM 
uses for converting, i.e., mapping 
colors from one device's gamut to 
another. The four different 
rendering intents are: perceptual, 
saturation, relative colorimetric, 
and absolute colorimetric.

Resolution A measure of the fineness 
of spatial detail that a device can 
record or produce. The higher the 
resolution, the finer the detail. 
Resolution is expressed in elements 
per unit; for example, pixels per inch 
(ppi) for scanners and monitors, and 
dots per inch (dpi) for printers and 
imagesetters.

RGB Red, Green, Blue - the primary 
colors in the additive color model. 
The RGB model is used in color 
televisions, monitors, and scanners.
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S

Saturation A measure of the amount 
of gray in color in the HSL and HSV 
color models. The less gray in a 
color, the higher the saturation. 
High saturation corresponds to an 
intense, vivid color; low saturation 
to a quiet, dull grayish color.

Smart Input CMYK Space Recognition 
(SISR) Smart Input CMYK Space 

Recognition. When an embedded 
profile is present, SISR will not be 
activated. When the profile is not 

recognized and attributed, the 
default Input CMYK Color Profile 
will be used.

U

USM Unsharp Masking. Any of three 
different processes used to sharpen 
image detail with photographic, 
optical, or digital methods. USM is 
routinely applied to scanned images 
since the nature of the scanning 
process decreases image sharpness.
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APPENDIX
B :Arkitex OptiInk Toolbar

This Appendix provides specific information about the tools available in :Arkitex 
OptiInk.

Main Area

User Administration

User Preferences

System Preferences

View System Log

Close All Job Windows

List view

Details view

Thumbnail view
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232 HOT FOLDERS TAB
Hot Folders Tab

New hot folder

Delete hot folder

Collecting

Active job

Ready

Complete job

Job Aborted

Job Purged

Failed job

Warning on job

Held job

Held for approval

Job Held Rejected

Job Held Select

Job Edit

Job Abort

Job Edit Failed

Job Edit OK
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Job Edit Reject

Job View

Job View Abort

Job View Failed

Job View OK

Job View Reject

Close job

Job Log

Job being edited

Hot folder with completed jobs

Job failed

Job on hold

Job waiting for approval
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Workflows Tab

New workflow

Copy workflow

Export

Import

Delete workflow

Edit

Select

CMYK/Gray Min Max Dot

Color Management

Output

GCR

PDF

Approve

PostProcess
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Image Tab

Job Toolbar

Show previous job

Show next job

Approve job

Reject job

Held For Retouch

Hand Grab Pan

View in Acrobat

Display dual view

Show result

Show source

Show Original Pixels. For every image pixel, there is a screen pixel.

Fit to Window

Magnify

Zoom In

Zoom Out
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Subjob Toolbar

Source Toolbar

Result Toolbar

Advanced Edit

Show Original Pixels. For every image pixel, there is a screen pixel.

Fit to Window

Magnify

Zoom In

Zoom Out

Info (only active in OptiInk)

View All, View Cyan, View Magenta, View Yellow, View Black, View CMY

Advanced Edit

Interactive Edit (only active in IntelliTuneX)

Edit Image in Photoshop

Details

Apply

OK
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Edit Hot Folder 
Details

Add a wild card filter

Delete a wild card filter

Applies changes and closes dialog box.

Apply changes and keeps dialog box open.

Cancels changes.
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APPENDIX
C Keyboard Shortcuts

This chapter describes a selection of shortcuts of :Arkitex OptiInk.

Shortcut Keys

Main Area

Job List Shortcut Menu

Menu Options Description

File

Exit  Ctrl-Q

Tools

User Administration... Ctrl-A

System Preferences... Ctrl-S

User Preferences... Ctrl-M

View System Log...  Ctrl-L

Folder

New Hot Folder... Ctrl-N

Job

Job Edit... Ctrl-E

View

List Ctrl-F1

Details Ctrl-F2

Thumbnail Ctrl-F3

Help

About Ctrl-F12

Menu Options Description

Job List

Job Edit... Ctrl-E
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Image Viewer

Tools Options Shortcut

Fit To Window Alt-F

1:1 Alt-=

Zoom In Mode Alt-Z

Zoom Out Mode Alt-X

View Source Alt+S

View Result Alt+R

In CMYK Mode

Change Channels

C Alt+1

M Alt+2

Y Alt+3

K Alt+4

CMY Alt+5

All Alt+6

RGB Channels

R Alt+1

G Alt+2

B Alt+3

All Alt+4
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APPENDIX
D Contents of a License 
File

When troubleshooting Licensing issues, look inside the License File. Open it with 
an Internet browser (e.g., Internet Explorer). A number of sections can be 
collapsed or expanded for convenient reading. All information in the License File 
is protected by a CheckSum and cannot be edited.

Fingerprint File

HardwareKey Value (MAC-address of the OptiInk server network card)

Dongle LicenseID (ID of the OptiInk dongle)

Installed SWComponents (Installed OptiInk components at the time the 
Fingerprint file was created)

SystemConfiguration (Server name, hard disks, installed memory, etc.)

Satellites (Information about the additional OptiInk Server Satellites)

InstalledProduct Name (Name and version of installed OptiInk)

ReceiptCodeFile

ReceiptCodes (Information about the different Receipt Codes that are in 
the License File)

TradedInProducts (Only available when there are Series 2/3 upgrade 
Receipt Codes in the License):

TradeInComplete (False = In Transition, True = Transition Ended)

UnknownProdName (The type of Series 2/3 dongle that is traded in)

UsedForSRC (The ID of the Sales Receipt Code where the dongle is linked)

DongleID (A unique reference to the Series 2/3 dongle). There is a list of 
options read from the dongle by the Registration Utility

CompanyInfoFile (Information taken from the Customer database by the 
WebID)
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LicenseKeyFile (List of all Licenses that are in the License File)

AuditTrail (List of events that passed during the lifetime of the License 
File)

A number of these items can also be retrieved using the Registration Utility as 
follows:

View > Options = ReceiptCodes

View > System Config = General system information

View > Installed Components = Installed SWComponents

View > Licenses = LicenseKeyFile

View > Customer Details = CompanyInfoFile
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APPENDIX
E Viewing Log Files

When troubleshooting issues, look inside log files.

System Log

These logs are created using message filters and exporting to a file location. The 
System Log is located under Tools > View System Log in the :Arkitex OptiInk 
Server.

Messages are exported to the logs directory as .txt files.

They are located under Program Files\AGFA\OptiInk\server\logs.
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You can use Notepad to view the log.
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APPENDIX
F XML Import

This appendix specifies the functionality of OptiInk associated with using XML 
files to control the workflow, and operations that may be controlled by using 
associated XML files.

XML Import ........................................................................................................... 246
Styles ....................................................................................................................... 246
Data and XML operation (Mac IntelliTune Compatible) ...................... 246
XML Operation with Referenced Data ........................................................ 248
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Multi Job XML Files .................................................................................... 249
Configuration ................................................................................................ 249
Miscellaneous Requirements ................................................................. 250
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User Interface ............................................................................................... 251

XML Structure and Processing Features .................................................... 251
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Job Definition Features ............................................................................. 260
Example XML Files ..................................................................................... 263
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XML Import

In many uses OptiInk works by presenting a number of hot folders where the 
data files may be placed by external applications. Workflows / processing steps 
and settings are associated with these hot folders. Additionally, selection criteria 
based on filename or image parameters may be used to change the workflows 
used for files.

There are cases where it is desirable for external applications to provide more 
explicit control for particular files. This is what the XML import interface is 
designed to achieve. Each file processed may have an associated XML control file 
that provides override information to control the details of how the data file is 
processed.

Styles

Two styles of operation are supported. The first provides backwards compati-
bility with the Mac Intellitune XML operation (where the data file and associated 
XML are imported together using the hot folder mechanism).

The second style of operation provides a greater degree of control over the data 
file association by just importing XML instructions (which themselves contain 
reference to the data file that should be processed). The XML file contains an 
external reference to the file to be processed. This gives some extra flexibility 
and avoids any timing problems associated with the first technique. The third 
mode is an extension of the second mode. In the third mode, multiple files are 
specified and fetched for processing by the XML settings.

Data and XML operation (Mac IntelliTune Compatible)

The diagram shows the overall system operation in this mode.
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Data files that are dropped into Hot Folder B without an associated XML file, 
have been set up to be processed by the steps and parameters associated with 
Workflow B.

When a data file has been recognized as stable and ready to be processed, 
OptiInk will perform a check for the presence of an associated XML file in the 
same hot folder. The XML file must have exactly the same name as the data file, 
but with an .xml extension. This XML extension may either replace an existing 
data file extension, or be appended to it. For example, when a data file called 
image.jpeg is found, OptiInk will associate that with an XML file called 
image1.jpeg.xml or image1.xml. Conversely, an XML file called image1.xxx.xml 
will be associated with data file names like image1.xxx or image1.xxx.yyy, 
where yyy is a regular image extension name like jpg, tif, etc.

XML names and image filenames are compared in a case insensitive fashion so 
that, for example, iMaGe1.jpg is associated with ImAgE1.xMl.

If no corresponding XML file is found, processing will continue as normal using 
the steps and parameters normally configured (e.g., workflow B).

If a corresponding XML file is found, it will be imported. The settings contained 
within it will control how the data file is processed.

1 Firstly, it may contain a reference to a different workflow name (e.g., A); and 
if this is present, that workflow and settings will be used instead of the 
default associated with the folder.

2 Secondly, the XML may contain some override settings to control some 
parameters used within the workflow.

If a Mac compatibility XML is detected (and no corresponding data file is found 
within 1 minute), the file should be ignored.

If a Mac compatibility XML is detected (but has errors), the corresponding data 
file should be picked up, if present, and placed in the error state.

NOTE: Not all features described here are fully supported in the current 
application. In particular, some of the individual control of attributes under 
presets are not implemented yet. Refer to the table in process step presets to see 
which of these are currently supported. 
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XML Operation with Referenced Data

The diagram shows the overall system operation.

An XML file is dropped into the Hot Folder associated with Workflow B.

ITX or OptiInk will import the XML file and extract the external reference to a 
data file to be processed and the settings contained within it to control how the 
data file is processed. Note the external reference is not a Hot folder itself, it is 
just a location where to find the data file to be processed. The other settings may 
contain a reference to a different workflow name (e.g. A) and if this is present 
then that workflow and settings will be used instead of the default associated 
with the hot folder used to import the XML control. The XML may contain some 
override settings to control some parameters used within the workflow.

Styles Operation

The handling of xml processing is governed by the following processes and rules 
that determine which style of operation is used for any file and how it is handled.

Any xml file dropped into a hot folder is first stabilized and then parsed to 
determine whether it contains an external file reference.

If there is no reference then it is potentially used for the Data plus xml style. 
If an associated data file is found within a time out period then its settings are 
used as described in section 2.1. Once an XML has been used with its associ-
ated job then it is not used again even if a subsequent matching data file 
arrives. If no data file is found within this period then the xml is deleted and 
an error logged.

If there is an external reference within the xml then this is used to create a job 
using the data file referenced. The scheduler will check for the availability of 
the referred file and fetch it for subsequent processing using its settings as 
described in section 2.2 If the file is not available at this point then this is 
logged as an error. The control XML can have a setting to control whether the 
source file is deleted or left in place.
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Unmatched workflow name references or known settings errors in the XML 
files are regarded as fatal errors and will cause the job to abort and be logged 
as failed. Settings in the XML file which are unknown to the system will be 
effectively ignored and not affect processing.

For effective use of the data plus xml into hot folder method, the xml must be 
placed in the hot folder first before the data file. Otherwise there is a risk that the 
system will data file will be processed as normal without an xml control and the 
subsequent recognition of the xml will be ignored.

For effective use of the xml with external reference method, the data file must be 
in position in its external folder before the xml file is dropped into the hot folder. 
If not then the xml job may fail and the external file never processed.

External folders used for referenced files must have the right permissions from 
the application. This must be at least read for fetching the file. Write permission 
is needed if the xml requests the source to be deleted.

Multi Job XML Files The XML files can contain references to multiple job files to allow the creation of 
several job files from one xml. This will only work for the external data file refer-
ence model.

Each job reference in the xml can contain its own unique settings. Any job 
without an external data file reference will be ignored and logged but will not 
prevent other valid jobs in the xml from processing as instructed.

Configuration The only configuration option associated with XML import is a per hot folder 
enable / disable option. This is set using Edit Hot Folder Details.
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The only configuration option associated with xml import is a per hot folder 
enable / disable option.

When this is true then both styles of xml operation are allowed for data entering 
this hot folder.

When it is false then neither xml operation is allowed for data entering this 
folder. Any xml files appearing will be logged and deleted.

Miscellaneous 
Requirements

XML entered Jobs should behave like standard file entry jobs going through the 
normal processing sequence and obeying approval settings.

Any job specific workflows created for management purposes should be deleted 
automatically when the job is deleted or purged.

XML Jobs should be editable using the normal editing facilities starting from the 
settings dictated by the base workflow with any override settings included in the 
XML. If a specific workflow has been created for this XML job then this should be 
retained during editing rather than creating a further edit specific workflow as it 
does not effect any of the base configured workflows.

Job retries should be allowed which should apply the current workflow settings 
associated with the job.
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PDF Jobs The XML workflow method is primarily intended for use with image files not 
PDF. Where a PDF file is associated with an XML then only the ITScript selection 
should be applied to select a workflow. The processing parameters should be 
ignored.

Logging Any Job arising from a XML entry should have a Job log item with the xml source 
file name.

Errors arising from XML processing should be logged. These will include bad 
XML, missing required parameters, mis-matched workflow names, and Job 
source data that can't be found or can't be deleted if the XML signals a delete.

User Interface XML entered Jobs should look and behave like standard file entry jobs.

Where a workflow name is shown then it should be displayed as Workflow_ 
JobNumber_xml where workflow is the base workflow being used as defined in 
the XML file or by the Hot folder if not present and JobNumber is the internal Job 
Number.

Any job specific workflows created to hold the job processing characteristics 
should not appear in the workflow or process tree.

XML Structure and Processing Features

Also in the Multiple Image Window (choose folder) corresponding XML files will 
be used to set the crop rectangle, etc. Of course those settings can then still be 
changed by the user via the normal UI controls. This allows to easily check and 
debug XML files coming in.

Structure Two basic structures of xml are supported. The underlying processing instruc-
tions are identical.

In the first case just the processing instructions are included within a container 
Intellitune element. This structure is compatible with the existing Mac version 
and is only appropriate for the data plus xml style of working.
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In the second case a job element is included together with the processing instruc-
tions defining the source file and extra instructions. This structure is used to 
define an xml plus externally referenced file style of operation. Both Job and 
Processing elements are held within an Intellitune block.

In the third case multiple Intellitune blocks may be held within an Intellitune-
Jobs element to allow multiple Jobs to be defined. Each of these must have a Job 
Element to be valid; i.e., it can only be used in the externally referenced mode. 
Different Jobs within the xml could refer to the same source file and they will 
create independent Jobs, but care must then be taken with the DeleteSource 
option to ensure the source file is not deleted.
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A job with Production ID and ProcessStep definitions would look like this.
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XML Format Extension

The XML Save format allows multiple presets and multiple preset types with 
appropriate extra identifiers to define what is being saved. A workflow name has 
been set to Null when there is no associated workflow.

The top level container is called Processes. This can contain one or more 
Processing elements. Each of these has an attribute called ITScript, which identi-
fies the workflow name, or is set to null if there is no associated workflow name.

Each Processing element can contain one or more ProcessStep elements. These 
have an attribute Name which identifies the type of ProcessStep, and an 
attribute Preset which names the particular instance. The ProcessStep then 
contains a plist element, which contains the settings specific to that ProcessStep. 
Multiple ProcessSteps of the same Name but different Preset values may be 
present, as well as ProcessSteps for different types (Names).

Supported ProcessStep Names are preProcess, tonalGradation, castRemoval, 
usm, cmykUsm, vfd, artifactRemoval, size, selectiveColor, colorManagement, 
output, gcr, pdf, approve, postProcess, ace, and cmykMinMaxDot.

Processing 
Features

Processing settings are contained within the processing element. This element 
may be completely absent in which case the default workflow and settings 
associated with the hot folder will be used.

ITScript (Attribute)

This attribute, if present, should contain the name of a configured workflow. 
The application will then use this workflow as the basic flow to process this 
file. If it is present but there is no corresponding workflow defined then this 
is a fatal job error. If it is not present then the workflow corresponding to the 
hot folder entry point will be used.
:ARKITEX QUALITY OptiInk User’s Guide



 

 XML IMPORT 255
Crop (Element)

The Crop element, if present, contains attributes that control the cropping 
process in the application. If no crop element is present then the image is still 
processed but without cropping.

XBeg, YBeg define the offsets to the first pixel of a rectangular crop. XEnd, 
YEnd define the last pixel of the rectangular crop. If XEnd, YEnd extend 
beyond the image then the image boundaries will be used instead. All values 
must be present and contain numeric values if the crop element is used. If any 
values are missing or do not contain numeric data then the file is processed 
without any crop operation and logged that no crop has been used.

CropBeforeAnalyse determines whether the cropping takes place before or 
after the analysis of the image for enhancement. It can take true / false 
values. Note that if it is set to true and the crop area is small then there may 
not be enough image area to perform an effective analysis. If not present then 
this attribute defaults to false.

Use of this element is now deprecated and the preferred method is to pass the 
attributes described here via the ProcessStep crop element.

AnalysisCrop

The AnalysisCrop element is an alternative version of to the Crop Element 
and is positioned in the same way in the XML. If present, it contains attributes 
that control the analysis region for processing in the application. No cropping 
actually is performed and the image is processed using results based on just 
analyzing the definition region.

It is intended for use in XML jobs where the external system has defined a 
logical crop region and wants the image processing based on this, but the 
external system wants back an un-cropped image and will do the physical 
cropping itself.

Normally there should not be a Crop and an AnalysisCrop element for the 
same job. If both are present then the Crop element will be ignored in favour 
of the AnalysisCrop element.

XBeg, YBeg define the offsets to the first pixel of a rectangular analysis 
region. XEnd, YEnd define the last pixel of the rectangular region. If XEnd, 
YEnd extend beyond the image then the image boundaries will be used 
instead. All values must be present and contain numeric values if the Analy-
sisCrop element is used. If any values are missing or do not contain numeric 
data then the file is processed without any AnalysisCrop operation and 
logged that no AnalysisCrop has been used.

Use of this element is now deprecated and the preferred method is to pass the 
attributes described here via the ProcessStep analysis element.
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Rotation (Element)

This element, if present, contains a single attribute Angle. This can contain a 
floating point rotation angle from -180 to + 180. "." Must be used for the 
decimal point not ",". Note that this is retained for backwards compatibility. 

Use of this element is now deprecated and the preferred method is to pass the 
attributes described here via the ProcessStep rotate element.

ImgSizeOut (Element)

This element, if present, controls the sizing of the output image. It is now 
deprecated and the preferred method is to pass the attributes described here 
via the ProcessStep size element.

The ImgSizeOut element, if present, contains attributes that determine the 
sizing of the output file. Width and Height, Resolution attributes set the size 
and resolution of the final output image. Resolution is expressed in dpi. If the 
Value is not present in the XML then the value associated with the underlying 
workflow should be used (ITScript if present or Default Folder workflow if 
not).

Optionally a Unit attribute can determine the units Width and Height are 
expressed in. If Unit is not present or does not have a value of "mm" or "in", 
then Width and Height are in Pixels. If Unit is present, then it can have a value 
of  "mm" or "cm" or "in" or "pt"; then Width and Height are in those units and 
should be converted to pixels using the Resolution value. If Unit is defined as 
one of the supported values and no Resolution is available, either from the 
XML or underlying workflow, then this is an error. If Unit is not recognized 
or is not present then pixels is assumed.

The attributes may be present in the following combinations, where Width 
and Height must both be present if one is, and Unit is effectively not present 
if it has a value other than one of the defined values.
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Process Step Presets

In addition to the Crop, Rotate and ImgSizeOut Elements there may option-
ally be ProcessStep elements for the available process steps available in a 
workflow.

If an element is present then it is may be used to select a named 'preset' set of 
parameters for this process step and enable/disable the processing step 
within the workflow. It is legitimate to not define the 'preset' and just enable/
disable the existing process step. It is legitimate to just define the preset 
which will then be enabled or disabled as defined by the preset itself. 

If the processing step is already defined within the nominated workflow then 
the element changes the preset parameters used when performing it. If the 
processing step is not already defined within the workflow then it is added 
with the preset parameters. 

Crop, Rotate and ImgSize elements in the xml job definitions are applied 
after any process steps are selected by the xml job definition.

Each Element can contain three main attributes and a number of attribute 
parameter overrides. PostProcess can also add elements defining additional 
PostProcess steps

Name - The name of a supported Process step

Enable - An optional attribute with a value 0 (disabled) or 1 enabled. Note 
that some ProcessSteps have several underlying functions without a 
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global enable. In this case Enable means use the functions as defined and 
disable means disable or remove all of them.

Preset - An optional attribute containing the name of a preset which exists 
within the configuration of the server.

Overrides - These are named attributes which can override the value of a 
specific value in the process step

Process step elements which have a Name that is not one of the supported 
steps or a Preset that does not match an existing configured item in the server 
for that Process step are ignored but logged as a warning. 

Supported Process Step Names together with supported attribute overrides 
are defined in the following table. In particular, note select is not an allow-
able process step name. The Mac and PC columns show the current status of 
what is supported in Mac Intellitune 5 and PC ITX.
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PostProcess Operation Elements

The PostProcess ProcessStep element can contain one or more "Operation" 
elements which define additional Operation PostProcess steps, which will be 
added on to the end of those that exist in the named PostProcess operation. 
Note that the named PostProcess step must exist. If it is desired to control all 
operations from the XML then a named PostProcess step with just a Do 
Nothing operation should be used.

Each Operation element can have the following attributes:
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Index (mandatory) - controls the order in which the operations will be 
performed after any existing ones. Starts at 1 and increments for succes-
sive operations.

Name (mandatory) - controls the type of Operation (Case Sensitive); 
"CreateJobFromSource"; "CreateJobFromResult"; "CopySourceTo-
Folder"; "CopyResultToFolder"; "MoveResultToFolder"; "ErrorRetry"; 
"Script"; "DeleteSource"; "DeleteResult"; "Purge"; "PhotoshopOpenSave";

OutPath - Needed for CopySourceToFolder, CopyResultToFolder, 
MoveResultToFolder. Can be defined in File URL or PC UNC format.

OutFileName (Optional) - If present then controls the name of the output 
file for operations creating files. If absent then the internally controlled 
filename is used.

ITScript - Needed for CreateJobFromSource, CreateJobFromResult, 
ErrorRetry, must be Name of existing defined Workflow (Case Sensitive)

ScriptName - Needed for Script, must be Name of a vbs script present in 
the _scripts folder

Attributes that are present but irrelevant to the Operation defined should just 
be ignored.

Job Definition 
Features

Job definition is contained within the Job element. If this element is missing then 
it is assumed that the xml is for use within a data plus xml style of working.

SourceFileName (Attribute)

This attribute must be present for the Job to be valid. Three styles of refer-
ence may be used

File URL - SourceFileName=" file://Server/Folder/Image1.jpg"

PC UNC - SourceFileName="\\Server\Folder\Image.jpg"

HTTP URL - SourceFileName="http://Server/Folder/Image1.jpg"

File URL will give better portability across platform types. 

The PC UNC style is only supported on PC platforms but may include PC 
mapped drive references.

File and HTTP URLs may be Case sensitive in the non-server part of the refer-
ence depending on the platforms in use.
:ARKITEX QUALITY OptiInk User’s Guide



 

 XML IMPORT 261
This attribute must be present for the Job to be valid. It may contain either a 
fully qualified UNC reference to the source file to be used, or an http refer-
ence. PC mapped drive references may also be used. OptiInk must have the 
requisite permissions to access the file. An example of a UNC reference would 
be SourceFileName="\\Server\Folder\Image.jpg". An example of an http 
reference would be SourceFileName = "http://Server/Folder/Image1.jpg".

NOTE: The UNC fetch of the SourceFileName should work even when the case 
of the actual filename is different; e.g., for the example, above the actual 
filename may be \\SERVER\FOLDER\IMAGE.jpg. For http fetch, the case 
sensitivity will be determined by the characteristics of the Web server.

DeleteSource (Attribute)

This optional attribute determines what happens to FILE URL or PC UNC or 
Drive mapped Source files after being processed. It defaults to 0 (false) if not 
present. If 1 (true) then the Source file is deleted when the file has been 
accepted by the system irrespective of whether the job succeeds or fails. If 0 
then the Source file is left in its original position. If the file is referenced by an 
http connection then this attribute is ignored and the file is left alone.

Priority (Attribute)

This optional attribute determines the priority of the Job when processed. It 
defaults to the standard Priority associated with the folder when not present.

PublicationInfo (Element)

This optional element within a Job element contains identification of the use 
of the file within a production environment. It does not change the 
processing of the file in any way, but the application may use this information 
for reporting back to external workflow systems. For example, OptiInk would 
include this information in XML Ink Save reports.

FromSite - An Attribute containing the site where this publication info origi-
nates from

PubDate - An Attribute containing the publication date in yyyy mm dd 
format

PubName - An Attribute containing the publication name

Press - An Attribute containing the press name

Edition - An Attribute containing the edition name

Zone - An Attribute containing the zone name
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Section - An Attribute containing the section name

Page - An attribute containing the page name

Component - Attribute containing a reference to a sub-page element. Blank 
or missing if the object is a page.

Version - An attribute containing the version of the component

Comment - An attribute containing a comment on this object
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Example XML Files

NOTE: Xml names and image filenames must be compared in a case insensitive 
fashion so that, for example, iMaGe1.jpg is associated with ImAgE1.xMl.

If no corresponding xml file is found, then processing will continue as normal 
using the steps and parameters normally configured (e.g., workflow B).

If a corresponding xml file is found, then it will be imported and the settings 
contained within it will then control how the data file is processed. Firstly, it may 
contain a reference to a different workflow name (e.g., A); and if this is present, 
then that workflow and settings will be used instead of the default associated 
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with the folder. Secondly, the XML may contain some override settings to 
control some parameters used within the workflow.

If a Mac compatibility XML is detected and no corresponding data file is found 
within 1 minute, then the file should be ignored.

If a Mac compatibility XML is detected but has errors, then the corresponding 
data file should be picked up if present and placed in the error state.
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CSV Events

Event Message

26001 Exception getting initial context: {0}

26002 Exception while trying to get DS connection

26003 Usupported encoding error purging {0}

26004 Error purging {0}

26005 Edit

26006 OK (Changed)

26007 Cancel

26008 Abort

26009 Hold

26010 Release

26011 Job Expired

26012 Reject

26013 Purge

26014 Start Processing

26015 Processing Complete

26016 Processing Failed

26017 Processing Complete With Warning

26018 OK (No Change)

26019 Retry

26020 Failed to load {0}

26021 Failed to load {0}, {1}

26022 Failed to extract images from PDF file, message: {0}

26023 Failed to process PDF file, message: {0}

26024 Failed to restore images to PDF file, message: {0}

26025 Failed to extract PDF metadata, message: {0}

26026 Failed to wrap TIFF file, message: {0}

26027 Unsupported Job Filter field: {0}

26028 Unsupported Job Sort field: {0}

26029 Failed to create SHA digest

26030 User already exists

26031 User {0} already exists

26032 Unknown user (or invalid password)

26033 Unknown user {0} (or invalid password)

26034 Incoming

26035 Held for Select

26036 Waiting
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26037 Held

26038 Active

26039 Held for Approval

26040 Completed

26041 Failed

26042 Purged

26043 Created job

26044 Moved job to Arrived state

26045 Job failed while incoming, job moved to Purged state

26046 Processing {0} to {1}

26047 Job aborted by user

26048 Failed to process job

26049 Failed to read item from database, ignoring it

26050 Failed to read {0} from database

26051 Unexpected transition {0} requested in state {1}

26052 Scheduler version {0} started on {1}

26053 Processor version {0} started on {1}

26054 License Expired

26055 No source file details found for job

26056 Image job {0}, child of this PDF job has failed, failing PDF job

26057 Unsatisfied link - missing Medusa DLL's

26058 Unexpected Throwable caught - missing Medusa DLL's

26059 Thumb creation failed

26060 Failed to get parameters for {0}

26061 Output rejected, performing automatic reject actions

26062 Job {0} was deleted, but job files might not have been successfully 
removed

26063 Processor communication failed

26064 PDF is encrypted and does not have modification permissions set

26065 PDF is pre-separated

26066 Unsupported image type found in PDF job, the image will not be processed

26067 Unsupported image file format found in PDF job, the image will not be pro-
cessed

26068 Logo or gradient detected

26069 Logo or gradient detected, will not be processed

26070 Failed to parse EXIF data, {0}

26071 Unrecognised tag type {0} in EXIF data

26072 Failed to parse IPTC data, {0}

26073 Preflight failed for image {0}

26074 Failed to create medusa parameter file
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26075 Processed job in {0} s

26076 Failed to locate database backup area, possibly incorrect entry in server 
configuration: {0}

26077 Invalid input file {0}

26078 Invalid output file {0}

26079 Source and destination are the same {0}

26080 Output file type not found, defaulting to tiff

26081 Failed to get parameters for image {0}, failed to get jni instance

26082 Failed to get parameters for image {0}, error {1}

26083 Image type is not supported

26084 Image format {0} is not supported

26085 Failed to get capabilities for file format {0}, error {1}

26086 Save EXIF required but not supported by file format

26087 Save IPTC required but not supported by file format

26088 Embedded profile required but not supported by file format

26089 16 bit output required but not supported by file format, defaulting to 8 bit 
output

26090 No working space profile defined

26091 Working space profile {0} cannot be found

26092 Output profile {0} cannot be found

26093 Input RGB profile {0} cannot be found

26094 Image is CMYK but no CMYK input profile defined

26095 Input CMYK profile {0} cannot be found

26096 Received abort message

26097 Aborting job

26098 Failed to created backup ZIP file, no database backup performed

26099 Item {0} not found in database

26100 Copying {0} to {1}

26101 Failed to copy {0} to {1}

26102 Folder does not exist: {0}

26103 lattened image found in PDF

26104 Logo or gradient found in PDF

26105 Overlapping images found in PDF

26106 Bad embedded profiles found in PDF

26107 Spot colors not found in PDF

26108 Extracting images from PDF file

26109 Extracted {0} images for processing

26110 Processing failed due to error in PDF

26111 Exception reading pdf parameters

26112 PDF file is encrypted, copying to destination
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26113 Failed to copy encrypted PDF file

26114 Timing message {0}

26115 Cannot delete workflow item while it is still in use

26116 Processor is shutting down

26117 Scheduler is shutting down

26118 Scanner is shutting down

26119 No file actions specified

26120 ImageProcess failed, returned error {0}

26121 PDF job had too many images, the job was passed through unprocessed

26122 Failed to copy file {0} to {1}

26123 Failed to read settings approval settings, approval disabled

26124 There are {0} jobs older than {1} and eligable for automatic deletion

26125 {0} jobs have been queued for automatic deletion

26126 {0} log messages older than {1} have been deleted

26127 Processor received message {0}

26128 Sent message {0} to processor {1}

26129 Performing file processing operation: {0}

26130 Check Point {0}

26131 Bad_url {0}

26132 failed to add invalid folder {0}

26133 failed to resolve folder path {0}

26134 failed to create folder {0}

26135 folder setup succeeded {0}

26136 deleted folder {0}

26137 Failed to create cache folder {0}

26138 Failed to move {0} to job cache

26139 scanner notified completed file {0}

26140 Scanner failed to notify completed file {0}

26141 Exception trying to notify completed file {0}

26142 Scanner notified incoming file {0}

26143 Scanner failed to notify incoming file {0}

26144 Scanner notified aborted file {0}

26145 Scanner failed to notify aborted file {0}

26146 Scanner version {0} started

26147 scanner aborted transfer of {0}

26148 Scanner configuration error, invalid root data

26149 Scanner received Start command

26150 Scanner received Stop command

26151 Scanner received Setup command
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26152 Scanner configuration error, bad hot folder structure

26153 Scanner cleaning up unconfigured folders

26154 Some unconfigured hot folders are still populated

26155 Some unconfigured job cache folders are still populated

26156 Scanner configuration successful for share {0}

26157 Scanner completed Setup command

26158 Scanner received Status command

26159 Scanner configuration error, invalid root path

26160 Scanner configuration error, root folder does not exist

26161 scanner failed to create job cache

26162 Failed to process pdf, failed to parse parameter

26163 Failed to process pdf, initialization error

26164 Failed to process pdf, open file error

26165 Failed to process pdf, process aborted

26166 Failed to process pdf, processing error

26167 Failed to process pdf, file save error

26168 Failed to process pdf, encrypted file

26169 Failed to process pdf, missing spot colors

26170 Failed to process pdf

26171 Spot color {0} not found

26172 Number of images in document has exceeded limit

26173 Failed to copy file to filestore

26174 Failed to read pdf parameters

26175 Failed to extract images from pdf

26176 Failed to create pdf thumbnail

26177 Could not load properties file

26178 Collect completed in {0} seconds

26179 Failed to send email to {0} via smtp host {1}, NoSuchProviderException

26180 Failed to send email to {0} via smtp host {1}, MessagingException

26181 Failed to send email to {0} via smtp host {1}, UnsupportedEncodingExcep-
tion

26182 To use Alert On Error, please set up the SMTP server and email address in 
System Preferences

26183 Sent error report email to {0} via smtp host {1}

26184 Invalid processor license

26185 Invalid product license

26186 Invalid server license

26187 Invalid Client license

26188 Invalid PDF license

26189 Invalid PDF text/vector processing license
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26190 Invalid Spot color processing license

26191 Invalid SISR processing license

26192 Invalid GCR processing license

26193 Invalid image processing license

26194 Invalid license options

26195 failed to send license request

26196 failed to acquire license

26197 invalid license, retrying

26198 Failed to acquire valid processor license

26199 invalid reply to license request

26200 The file is not PDF format

26201 Processor status message {0} arrived for job {1}

26202 Error sending email: {0}

26203 Error writing color processing parameters {0}

26204 Error writing pdf processing parameters {0}

26205 Performing Ink Savings Calculation using CR={0}

26206 Ink Savings Calculation failed ({0})

26207 Failed to create PDF filestore

26208 Failed to collate image parameters

26209 Failed to read processed data results {0}

26210 Failed to find workflow {0} to process {1} images, using default

26211 Grace period expired

26212 Invalid dongle

26213 Invalid encryption

26214 Invalid hardware key

26215 Invalid license file

26216 Invalid license file generation date

26217 Invalid license file type

26218 Invalid version

26219 License checked out

26220 License checked out in grace period

26221 License checked out trial

26222 Sales License expired

26223 Trial License expired

26224 No entry in license file

26225 No license available

26226 No license server found

26227 License state is undefined

26228 Valid license
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26229 No license file loaded

26230 Unknown state

26231 Source image not found in filestore, possibly due to failed Collect opera-
tion. The job must be resubmitted.

26232 TimeLogger: {0} took longer than expected, {1} seconds

26233 Deleting orphaned {0} item id {1}

26243 Scanner configuration error, share {0} cannot be found

26235 Deleting orphaned file {0}

26236 Scanner configuration failed for share {0}

26237 Output profile has not been specified

26238 CMYK input profile has not been specified

26239 RGB input profile has not been specified, working space profile will be 
used

26240 Input file {0} has zero length

26241 Scheduler is shutting down, could not load database

26242 Resize is greater than maximum scale factor {0}

26243 Can't delete temp dir [{0}]

26244 temp dir [{0}] existed

26245 temp dir [{0}] created

26246 temp dir [{0}] used

26247 validateAllLicenses failed

26248 validateAllLicenses succeeded

26249 ReleaseOldLicenses succeeded

26250 ReleaseOldLicenses failed

26251 Licenses in pseudo-grace

26252 Can't delete profile cache [{0}]

26253 Viewing(held)

26254 Editing(held)

26255 Viewing

26256 JobLogWrite jobID [{0}]

26257 JobLogWrite message sent {0}

26258 JobLogWrite message received {0}

26259 Checking for log write conditions {0}

26260 JobLogWrite file path formed {0}

26261 HandleMessage handling {0}

26262 JobLogWrite log msg [{0}]

26263 Job failed because no workflow available

26264 XML import not enabled in hotfolder [{0}], File {1} is deleted

26265 Missed Job element in multifile XML import file [{0}]

26266 No data file found for imported XML file [{0}] within {1} miniutes
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26267 One or more Licenses is invalid

26268 no licenses loaded

26269 license service is not responding

26270 Restart now

26271 license service failed

26272 license service needs restart

26273 license service is responding

26274 checking license service

26275 license service restarted

26276 failed to restart license service

26277 restart license service

26278 license info

26279 OK (Changed, PreApproved)

26280 Can't save workflow [{0}] to job

26281 Job state change failed in XML import

26282 Job is going to be processed by {0}.xml

26283 Job failed because ImportXMLException:{0}

26284 Job source data can not be deleted

26285 Job source data not deleted because file is not writable

26286 Tiff creation failed

26287 Ink Calculation failed

26288 No resolution for mm/inch unit

26289 Import XML error: ImportXMLException:{0}

26290 Failed to render PDF to Tiff

26291 Skipped making thumbnail

26292 Created PDF from PostScript input

26293 Distiller error while creating PDF

26294 Ink Saving XML export failed

26295 Ink Saving XML export failed because [{0}] is not a directory

26296 Ink Saving XML export failed because can't create the directory [{0}]

26297 Ink Saving XML export failed because source/result tiff not exist

26298 no network

26299 resolving share host[{0}], shareName[{1}]

26300 failed to resolve share

26301] URLtoNative, URL[{0}]->result[{1}]

26302 Can't save approved name [{0}] to job

26303 Failed to release Processor License

26304 Failed to get license parameters

26305 Failed to get Client license
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26306 Failed to release Client License

26307 Failed to check out server license [{0}]

26308 Failed to connect to License Service

26309 Hot Folder Script failed for file [{0}]

26310 User login validated. Machine: {0}, Username: {1}, User level:{2} 

26311 User login not valid. Machine: {0}, Username: {1}

26312 User logout. Machine: {0}, Username: {1}

26313 User disconnected due to timeout. Machine: {0}, Username: {1}

26314 Processor license checked out. Machine: {0}

26315 Processor license checked in. Machine: {0}

26316 Processor license timed out. Machine: {0}

26317 ImageProcess failed because itprocessor timed out after {0} seconds

26318 Item {0}, type {1} not found in database

26319 Exception close context

26320 Extracting images from EPS file {0} to {1}

26321 Moving {0} to {1}

26322 Invalid ACE processing license

26323 Reprocess job [{0}]

26324 Job state change failed in Reprocess

26325 TPDFProcess failed because itpdfprocessor timed out after {0} seconds

26326 Job Source File Opened in Photoshop by User: {0}

26327 Job Result File Opened in Photoshop by User: {0}

26328 New Job Source File Submitted via Photoshop by User: {0}

26329 New Job Result File Submitted and Approved via Photoshop by User: {0}

26330 New Job Result File Submitted for Postprocessing via Photoshop by User: 
{0}

26331 Job Aborted By User {0}

26332 Job Rejected By User {0}

26333 Job Approved By User {0}

26334 Assigned license to processor hostid: {0} processor id: {1}

26335 Valid license for processor hostid: {0} processor id: {1}

26336 Invalid license for processor hostid: {0} processor id: {1}

26337 Failed to get license for processor hostid: {0} processor id: {1}

26338 Invalid hostid for processor hostid: {0} processor id: {1}

26339 Purge process started ; found {0} jobs to be purged

26340 Purge process ended ; purged {0} jobs

26341 Purge job

26342 Auto Expire job

26343 Job delete requested by User: {0}

26344 Job input parameters {0}
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26345 Job output parameters {0}

26346 Job ink parameters {0}

26347 Thumb creation completed in {0} seconds

26348 Ink calculation completed in {0} seconds

26349 FileSync started from {0} to {1}

26350 FileSync ended. Deleted={0}; Added={1}; Updated={2}

26351 Scheduler received shutdown

26352 Scheduler releasing License

26353 Licensing in Grace!!!

26354 Purging {0}

26355 Purge Thread started

26356 Changing state from {0} to {1}

26357 Licensing recovered from Grace

26358 Ink Saving TXT export failed because [{0}] is not a directory

26359 Ink Saving TXT export failed because can't create the directory [{0}]

26360 Failed to rename XML Status file

26361 Failed to rename XML Status file

26362 Recovered from pseudo-grace

26363 PostProcess completed in {0} seconds

26364 Total process time {0} seconds
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External PDF Rendering

By default OptiInk will use an inbuilt PDF render library to produce the soft-
proof images needed for viewing jobs and obtaining thumbnails, and also when 
performing ink cost saving calculations.

OptiInk also supports the use of external PDF rendering tools instead of the in-
built libraries. These may be useful under some circumstances. Some external 
renderers will perform better / faster for some PDF constructs than the in-built 
version. Some customers may wish to use the same Render mechanism that they 
will use for RIPping the final PDFs to ensure that the result they view is identical 
to the end result.

External Render 
Mechanisms

Three different External Render mechanisms are supported: Ghostscript, Grafix 
RIP, and Other third party RIPs supporting folder-based job submissions with 
page setups associated with the folders.

OptiInk needs to render PDF files to CMYK or RGB composite images under 
some circumstances. The performance is optimized by only rendering when 
configured or necessary. So by default in OptiInk with Output settings set to Max 
Speed and no thumbnails, then no rendering is done during normal job 
processing. Rendering will, however, be done when either a Job is opened for 
viewing, if thumbnails are desired, or if Ink Reporting is configured.

By default all PDF rendering is done by the internal PDF processing libraries. A 
system Preference setting "Use External Rendering" together with an associated 
parameter box allow all rendering to be done by an external process.

To maximize flexibility in how External Rendering is done, the process is 
actually controlled by a script called RipRenderTiff.vbs. A default version of this 
script is in the code folder; but the working copy is kept under the filestore in the 
_scripts folder. When External Rendering is turned on, then every time a render 
operation is required, this script will be called with the following parameters:

Source file path - This is the full path to the source PDF file to be rendered.

Result file Path - This is the full path to the result TIFF file, which should be 
created by the rendering process.

Parameters - This is the parameter string as configured by System Prefer-
ences. It may be used in different ways by the script.

DPI - This is the suggested resolution at which the rendering operation 
should be done. This renderer may choose to do the operation at a number of 
presets nearest to the requested value. 
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ColorSpace - This is the needed colorspace of the TIFF file, and may take the 
value RGB or CMYK.

TimeOut - This is a timeout value in seconds for the rendering operation as 
configured in System Preferences. The script should monitor the rendering 
process and abort if this time is exceeded.

The default script as supplied supports rendering using the public Ghostscript 
engine, or by using folder-based RIPS, including Grafix RIP. An install script is 
available for setting up the folder-based RIPS and for the Grafix RIP. All neces-
sary RIP configuration work is also performed.

Logging The RIPRender script has an optional logging operation. This is invoked by just 
creating an empty log file called RIPRenderLog.txt. Logging is stopped by 
removing the log file. If the log file becomes very large, it will roll-over into a 
backup log; and a new one will be started. Only one backup log is kept, but this 
will normally hold quite a significant history of operation.

Normally one would not need logs from the script, but it can be useful to turn this 
on if there is any unexpected behavior, or when testing a new or amended 
version of the script.

The OptiInk system is set up to use Ghostscript by enabling External Render 
under System Preferences/Miscellaneous, and putting the word ghost in the 
parameter box.

The Render timeout value may also be changed, if required.

On the OptiInk system, enable the External Render process; and then type in the 
path to the RIP share in the parameters box, e.g., \\RipHost\RenderIn\.

GrafixRIP 
Rendering

This default render script supports the use of GhostScript as a render engine by 
using hot folder inputs on the RIP with associated Page Setups.
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By default the script partitions Render requests into three resolution categories 
(50,100,150 dpi), and two colorspaces (RGB, CMYK). So six different input 
folders are used, and these are set up to perform the required render. All inputs 
are set up to deliver their results into a common output folder.

The Input folders are named as RIP_RES_CS (e.g., RIP_50_CMYK). The output 
folder is called RIP_OUT. These should all be under a common Rendering root. 
Two other folders (RIP_COMPLETE and RIP_ERROR) are also created for 
internal GRAFIX RIP usage.

Set Up

An ExternalRIP_Install script is available, which will create the appropriate 
folder structure, configure the Grafix RIP appropriately, and publish a share to 
allow the RenderScript to connect to the RIP.

This install script will create the input and output folders in a folder called 
RenderIn under the normal Grafix RIP install point, and publish this as share 
called RenderIn.

To perform the install, unzip the ExternalRender_Install package into any 
convenient folder on the RIP platform. Double-click the script to start it, and 
navigate using the folder browser that appears to the root of the Grafix RIP 
install. 

Click Open, and the script will create the necessary folder structures and 
configure the RIP to use this.

The Render script will now direct the PDFs to the appropriate Grafix Input, and 
collect the resulting file for usa in the system.

Third Party Third party RIPS may be used in a similar way to the Grafix RIP as described 
using hot folder inputs and outputs.

By default the script partitions Render requests into three resolution categories 
(50,100,150 dpi) and two colorspaces (RGB, CMYK). So six different input 
folders are used, and these are set up to perform the required render. All inputs 
are set up to deliver their results into a common output folder.

The Input folders are named as RIP_RES_CS (e.g. RIP_50_CMYK). The output 
folder is called RIP_OUT. These should all be under a common Rendering root. 
Two other folders (RIP_COMPLETE and RIP_ERROR) are also created, which 
may be needed for internal RIP usage.
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Set Up

The same ExternalRIP_Install package may be used to perform part of the setup 
for Third party RIPs. It will create and share the folder structure as before; but 
when it detects that this is not a Grafix RIP, then it terminates. The rest of the RIP 
set up to define appropriate configurations must be done separately.

As an example, this is shown here for a Grafix RIP, but it is emphasized this will 
vary from RIP to RIP. For the case of the Grafix RIP, this manual procedure is 
NOT required, as it will be done automatically by the install script.

Example Page Setup

Each Input hot folder needs some sort of associated Page Setup configuring the 
resolution and colorspace and format of the render operation. It also needs to 
control the output name so that it at least contains the input filename. For the 
Grafix RIP this looks like the following:
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Where the resolution has been set at 50.0 to match the input folder, the color-
space has been set to CMYK composite. A TIFF output device has been chosen, as 
the output is named the same as the input.

Example device configuration

If a device set up is used that controls the detailed formatting, then it may need 
to be configured. The example here is from Grafix RIP. This controls the output 
folder used, and details of the formatting of the output file.

Example device configuration

The inputs of the RIP may need to be set up to associate Page Setups with the 
actual Input folders. The example here is from the Grafix RIP.

OptiInk Setup

On the OptiInk system enable the External Render process, and then type in the 
path to the RIP share in the parameters box, e.g., \\RipHost\RenderIn\.

The Render script will now direct the PDFs to the appropriate Grafix Input, and 
collect the resulting file for usa in the system.
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Overview

This appendix describes the various scripting mechanisms present in OptiInk 
and IntelliTuneX and how to use them.

Hot folder conversion scripting (PS to PDF)

Image editing scripting (PhotoShop)

General PostProcess scripting

PhotoShop Open Save scripting

MoveByScript scripting

Tips on writing, editing and testing scripts.

General There are several scripting hooks used in OptiInk and IntelliTuneX. These are 
provided to allow both flexible extension of some built in functionality and also 
adding new functionality such as conversion of data both coming into the main 
product and as files are sent to the output.

The script hooks are provided at various places in the workflow and are called as 
jobs are processed or edited. The main programs will call out to the script and 
include a number of command line parameters to allow the script to do its work. 
In general the application will suspend further processing of the particular job 
until the script has completed so script operations should be kept as short as 
possible.

Scripts are expected to be written in Visual Basic scripting (.vbs). These may in 
turn call upon other system and processing resources as required. When they 
terminate they return an exit code which will normally be used to indicate just 
simple success or failure. Scripts may be edited or written using any text editor 
like Notepad.

Some script hooks have provided and installed default script actions. These will 
normally be placed in the code folder and can be identified as being named like 
Scriptname_default.vbs. When these scripts are first used then the default will 
be copied to the _scripts folder in the filestore folder with the _default part of the 
name removed. This copy will only occur if there is not already a script of that 
name in the _scripts folder. This means that the script may be edited or replaced 
in the _scripts folder and will be retained during re-installs or upgrades. If you 
wish to change a script then it is best to do this on the copy in the _scripts folder. 
You can always revert to the default version by deleting or moving the copy out 
of the _scripts folder.
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Any new scripts should also be placed in the _scripts folder of the Primary server. 
The _scripts folder will also be periodically synchronized to the Secondary 
server if one is present.

One script hook is client based and this script will be executed out of the client's 
code folder rather than the _scripts folder. This does allow different versions on 
different client machines but also means that it is the responsibility of the instal-
lation engineer to restore any modified scripts after a re-installation or upgrade 
if the whole code folder has been deleted. Normal uninstall or upgrades will 
leave edited scripts in place.

Script Logging Most of the existing scripts have an optional logging operation. Where present 
this invoked by just creating an empty log file specified at the start of the script. 
For example the MoveByScript.vbs can optionally write to a MoveBy-
ScriptLog.txt file. Logging is stopped by removing the log file. If the log file 
becomes very large it will roll-over into a backup log and a new one will be 
started. Only 1 backup log is kept but this will normally hold quite a significant 
history of operation.

Normally one would not need logs from the scripts but it can be useful to turn 
this on if there is any unexpected behavior or when testing new or amended 
scripts.

Hotfolder Conversion Scripting

Script Hook 
Description

This script hook was primarily intended for converting PS format files to PDF 
during the input process and the default script provided support for converting 
using either a Ghostscript or Acrobat Distiller based conversion process.

The script could, however, be used for any other type of input conversion or 
processing and the exit codes returned by the script allow for different actions to 
be performed after the conversion has taken place.

The Script hook has been enhanced to allow the user to choose the script associ-
ated with each folder and to specify a parameter passed to the script.

Set up for pre- 
v2.02 systems

Each hot folder set up has a check box called Convert (E)PS to PDF.
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If this option is checked then after each input data file has stabilized then the 
scanning process will call a script named PSConvertToPDF.vbs. A default 
version is stored in the code folder but the script is executed from the _scripts 
folder in filestore.

Note the PSConvertToPDF.vbs is global across all Hotfolders that is used in. If 
specific behavior per hot folder was required then it would be possible for the 
script to act differently based on the hot folder path passed into the script.

Set up for post- 
v2.1 systems

Each hot folder set up has a combo-box called Hot Folder Script and a text entry 
box called Script Parameters. The previous PS Convert to PDF check box is 
removed.

The Combo box presents a choice of up to 15 different scripts which have names 
starting with HFnn where nn is from 01 to 15. The previous PSConvert-
ToPDF.vbs is now called HF01PSConvertToPDF.vbs. Only scripts of this name 
form that are found in the _Scripts folder will be offered as a choice. The first 
choice labeled "---" means that no script will be run.

The text entry box is used to feed configuration parameters to the script. This 
will be script dependent but for the HF01PSConvertToPDF.vbs script it contains 
a conversion profile (default value ITX_Default.joboptions).
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If this option is checked then after each input data file has stabilized then the 
scanning process will call a script named PSConvertToPDF.vbs. A default 
version is stored in the code folder but the script is executed from the _scripts 
folder in filestore.

Note the PSConvertToPDF.vbs is global across all Hotfolders that is used in. If 
specific behavior per hot folder was required then it would be possible for the 
script to act differently based on the hot folder path passed into the script.

Script Adjustment The default script supports two conversion methods using either Ghostscript or 
Acrobat Distiller. The Ghostscript method is used by default. For the script to 
work properly then either Ghostscript or Acrobat Professional must be installed 
separately.

To adjust the script open in a text editor. The primary adjustment to the script is 
the line reading:

Change the number as indicated to configure the selected conversion method.

If Distiller is used then no more configuration is required and the script may be 
saved.

If Ghostscript is used then the script must be configured with the Ghostscript 
install locations.

Const CONVERT_MODE = 1 'Set 1 for Ghostscript, 2 for Distiller
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These are the default install locations for Ghostscript version 8.63. If a later 
version is used or it is installed in a different path then these two lines will need 
to be edited accordingly.

Script Operation 
and Replacement

When the conversion script is called then it is passed four command line 
arguments.

Input filename before conversion

Expected filename after conversion (normally just .pdf appended)

A conversion profile name (ITX_Default.joboptions) This is a file containing 
the distiller conversion profile. The supplied version is suitable for most 
purposes, but it is possible to edit this using Acrobat Distiller.

The hotfolder path associated with the script being processed.

After conversion the script will return an exit code to the application.

Normally the script will check the format of the file and will return 1 if it success-
fully converts to PDF or 0 if no conversion is required. If -3 is returned the 
application will mark the file as purged and not proceed further. Other returns 
will be regarded as conversion failures.

New conversion scripts may be substituted which perform different operations. 
The current script may also be extended by adding in new CONVERT_MODES 
and using these to select new functionality. This may be more convenient as it 
allows easier configuration and can then make use of the existing functions 
already defined in the script.

For scripts used with later software, the exit code may also have an additional 
flag added to its normal value.

Const GSBIN_INSTALL = "c:\Program Files\gs\gs8.63\bin"

Const GSLIB_INSTALL = "c:\Program Files\gs\gs8.63\lib"

Const EXITCODE_PSCONVERTED = 1 'input file converted to PDF

Const EXITCODE_NOCHANGE = 0 'input file not changed

Const EXITCODE_PSERROR = -1 'error during conversion

Const EXITCODE_SOURCENOTFOUND = -2 'input file not found

Const EXITCODE_SOURCEDELETED = -3 'input file was deleted (purge from workflow)

Const EXITCODE_NOOUTPUTFILE = -4 'no output after conversion
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This indicates that an XML Job description file has been created by the script for 
this Job and will be processed before the Job continues. This means that a script 
can create job instructions on the fly and can dynamically add Publication Info 
to be associated with the job.

Image Editing Scripting (ITX)

Script Hook 
Description

Two scripts are used to support external image editing from within the client job 
edit windows.

The first script PSCheck.vbs is run every time the script starts up and is used to 
return 0 or 1 dependent on whether external image editing application is avail-
able. If a 0 is returned then the image editing button in the client is enabled. The 
default script checks the list of installed programs to see if Photoshop is present.

The second script PSEditJob.vbs is run when the user presses one of the image 
edit button in the job edit screen of the client

There are separate buttons for the source image and the result image. The script 
is responsible for opening the appropriate image in Photoshop, waiting for the 
user to close the image in Photoshop and then returning to the application. The 
application will then take the appropriate action on the updated image file.

Set Up No specific set up is required for the scripts if they are used with standard Photo-
shop installations. The script actually contains the same code as the Photoshop 
Open close script described later. It has a mode control at the top which is set 
false to activate the edit functionality.

The script returns one of the following exit codes when it returns:

Const EXITCODE_XMLADDED = 65536 'Flag that XML Job Info added
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Normally it should return with 0, the other exit codes indicate an error has 
occurred.

Script Adjustment When the PSEditJob.vbs script is called it is passed a single command line 
argument which is the filename to be edited. The script itself can recursively call 
itself with a second command line argument used to set up a monitoring mode 
to watch when Photoshop closes the image.

Both PSCheck.vbs and PSEditJob.vbs can be replaced or edited to use different 
image editing programs other than Photoshop.

General Postprocessing Scripting

Script Hook 
Description

The PostProcess operations allow a number of operations to be performed on a 
result file. One of these is now the possibility to run a script to perform an opera-
tion on the result file.

To activate this hook then configure the particular Postprocess operation and 
add a new step into the postprocess sequence and select Script. This will present 
a choice of scripts which is basically all the .vbs files present in the _scripts folder 
in filestore. Select the one required.

Note that it is possible to run more than one script by adding extra steps. Also the 
steps are performed in sequence so that if a script is required to modify the result 

Const EXITCODE_OK = 0

Const EXITCODE_NOFILENAME = -1

Const EXITCODE_NOEDITOROBJ = -2

Const EXITCODE_NOFILE = -3

Const EXITCODE_OPENTIMEOUT = -4
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file before it is copied to an output then it should be placed before that in the 
sequence. This does allow. For example a pre-scripted result file to be copied out 
to one location and a post-scripted result file to be sent out to another location.

Set Up

When a Postprocess script is run then it is passed 4 command line arguments

The path and name of the result file

The original name of the source file

The name which will be used for output

An output path which is empty for general postprocess scripts

Normally the script will just need the first parameter as its intended function is 
to modify the result file that is indicated.

An example usage is the exifTool.vbs script which uses the exifTool application 
(available on the internet) to add or edit tag based information in the result file. 
This can be used to automatically edit tags on files passing through this 
workflow.

The exifTool script example works by just running the exifTool over the result 
file itself and passing in a command line to the exifTool.exe which controls the 
tags that are added. If one looks at the top of the exifTool.vbs there is a constant 
that defines the tags added.

Const EXIF_COMMAND = "Exiftool.exe -Instructions=s=Ready -SpecialInstructions=s=Ready "

In this 2 tags are being added; an "Instructions" tag with a value of "s=Ready" 
and a "SpecialInstructions" tag also with a value of "s=Ready". 

A more sophisticated version of this could dynamically create tag information.

Script Adjustment

New Scripts can be added or based on the exifTool.vbs example. If they are 
placed in the _scripts folder then they will become available for selection in the 
PostProcess selector.
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Photoshop Open Save Scripting

Script Hook Description

The Photoshop Open save script is a specific Postprocess script operation. It is set 
up and executes in a very similar way to the general purpose PostProcess scripts 
described in the previous chapter. It is designed to just open up a result file in 
Photoshop and save it which can be a useful operation to clean up the format 
into a totally Photoshop clean format.

It is set up by just adding a PhotoShop Open Save Postprocess step into the 
configuration. This will invoke the PSOpenCloseJob.vbs script (based on 
PSOpenCloseJob_Default.vbs). This is identical to the manual PSEditJob.vbs 
script but with a mode parameter set to True so that it just opens the result file 
in Photoshop and immediately closes it again.

NOTE: The PSOpenCloseScript.vbs is global across all Postprocess items where it 
is used.

Set Up

No set up is required for this script. It is actually passed the same parameters as 
the general purpose PostProcess script but just uses the first one to operate on 
the result file.

Script Adjustment

Previously this script hook was also used a place where result files could be 
generally operate don by scripts. The general purpose scripts postprocess opera-
tion is better suited for this operation as different scripts may be used for 
different purposes on a per process operation basis.

Any existing PSOpenClose.vbs scripts used for more general processing can be 
easily converted and renamed to be used by the general postprocess script hook.
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MoveByScript Scripting

Script Hook Description

The MoveByScript script is a specific Postprocess script operation. It is set up and 
executes in a very similar way to the general purpose PostProcess scripts 
described previously.

There are two separate operations in the Postprocess selection called "Copy 
Result to Folder" and "Move Result to Folder". These previously actually 
performed exactly the same function namely the result file was copied to the 
output path configured next to the operation. Moves are not allowed as it is 
necessary to keep the result file in the filestore until the job is purged or deleted.

From version 2.01 onwards if the Move Result to Folder operation is selected 
then a script function is used to perform the copy operation. With the default 
script provided the functionality is identical but now the script can be adjusted 
to perform other operations during the copy without necessarily affecting the 
result file. The supplied default script, for example allows for the file to be 
renamed further during the copy although as supplied no renaming actually 
takes place.

The Copy Result to Folder performs a copy without invoking the script and 
should be used if no scripting functionality is required.

The script is set up just by choosing Move Result to Folder as a postprocess 
operation.

NOTE: The MoveByScript.vbs is global across all Postprocess items where it is 
used.

Set Up

When the MoveByScript.vbs script is run, then it is passed 4 command line 
arguments.
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The path and name of the result file

The original name of the source file

The name which will be used for output

An output path which is the one configured next to the operation

The default operation of the supplied script (MoveByScript_Default.vbs) is to 
copy the file specified by the first parameter to the Output path of the 4th param-
eter using the 3rd parameter as the filename.

Script Adjustment

New versions of the script may be written or the current one may be edited to 
adjust the functionality.

For example, in the default script the output filename is generated by a script 
function called Rename which is passed the Original Filename and the config-
ured Output Name. Currently this just returns the Output Name but it can 
generate any other name based on this material. E.g. it could strip off un-
required characters.

It could also perform processing on the file itself without affecting the result. 
This would best be done by creating a temporary copy of the file, performing the 
processing on this and then moving the temporary copy to the output.

Script Writing Tips

General

It is easier to start from an existing script, particularly one already used for the 
existing script hook. That way the basic start up and getting the command line 
arguments are already in place.

Writing Scripts

Scripts can be written using any text editor like Notepad. For more extensive 
editing or creation it can be helpful to use a more sophisticated editor like 
Notepad+ (available on the internet) as this highlights syntax and makes it 
easier to control things like string quoting and bracket usage.

For more extensive writing and debugging specific script development environ-
ments can be used like Visual Studio but major scripts can be developed quite 
easily without such tools if care is taken.
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It is worth taking care to properly indent the material to show the logic. Scripts 
should normally be broken up into a main script and a number of supporting 
functions. Each function should have a well defined purpose and take parame-
ters that make it more generally useful. It is much harder to debug and maintain 
a script that just contains a huge monolithic block of code.

Although VB scripting allows use of variables without declaring them this is bad 
practice and allows errors to creep in just by simple spelling mistakes which are 
then difficult to find. If an "Option Explicit" statement is included at the start of 
the script then this enforces a check for all variable to be properly declared and 
is a good step to ensure that this type of error is avoided.

Using Existing Functions

Copy and use existing functions from the scripts supplied.

For example, command line arguments are extracted in existing scripts normally 
by a GetArguments function. This allows for checking the number of arguments 
and also for invoking the script manually by double clicking it and manually 
entering the arguments. This makes it more convenient to debug without having 
to run through the main application.

Logging functions are also available in most of the supplied scripts. There is an 
InitLogging function and a WriteLog function. To use just include these 
functions and then have the following calls at the top of the script

Dim Logging
Dim ScriptPath
Dim ScriptTime
Dim fso

Set fso = CreateObject("Scripting.FileSystemObject")
InitLogging
ScriptTime = Timer()

The fso object which gives access to filing system functions will be required by 
most scripts.

Debugging

When debugging scripts errors will fall into three categories; basic syntax 
problems, run time execution errors, program logic.

Basic Syntax problems will show up as soon as the script is executed. The script 
environment does a pre-check over the whole code and will normally refuse to 
start real execution if there is a basic syntax error. A dialog box will highlight the 
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line in error which should be corrected and the script run again. This may be an 
iterative procedure when first testing a script to get rid of basic errors.

Run time execution errors such as division by zero, mismatched data types or 
indexing into array beyond their bounds will also stop the script running unless 
there is explicit error trapping built into the script. These will also bring up a 
dialog box highlighting the type of error and the line on which it occurred. These 
will, however, only come up if that section of code is executed. So this type of 
error may lie in wait on rarely executed pieces of code and can make it through 
to the delivered script unless care is taken in the writing and in the testing to try 
to exercise all the code areas.

Program Logic errors are those where the scripts executes OK but doesn't deliver 
the desired functionality because the code as written is incorrect in some way. 
These do not prevent the script executing and completing but the outcome is not 
correct.

For both execution errors and Program Logic errors then two basic debug 
methods may be used outside of more sophisticated development environments 
which allow interactive execution with breakpoints and display of variable 
values.

One can insert MessageBox calls within the script at various points to show 
where in the script execution has reached and to show the value of particular 
script variables. This can get tedious if the script is tested over and over again. A 
better technique is to build in and use Logging type functionality like in most of 
the existing scripts. With the logging turned on then WriteLog statements may 
be inserted throughout the code to give a trace of execution and the variable 
values at particular stages. Even if the script terminates unsuccessfully then the 
log trace to that point will give good clues as to where the problem lies. The 
logging code can also be left in place for future support if problems subsequently 
need to be investigated. 

Examples

ExifTool ExifTool.exe is a publicly available command line utility for reading and writing 
tag data in image files.

The example script exiftool.vbs is designed as a post-process script that can use 
this utility to manipulate the tag data of image files that have been processed by 
OptiInk. It can write new tag data and can also merge or manipulate the tag data 
in various ways.
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Install

To install exiftool.vbs:

Copy Exiftool.vbs and the ExifRules.txt files to the _scripts folder under the 
filestore

Download the windows executable version of exiftool.exe from the Internet 
and copy into the _scripts folder (http://www.sno.phy.queensu.ca/~phil/
exiftool/)

Configure a Post-Process step to call Exiftool.vbs before the copy to output 
folder

Edit the ExifRules.txt to perform the operations required

If logging is required then create a text file called ExifToolLog.txt in the 
_scripts folder. The script also contains a constant called LOG_DETAILS 
which will provide extra details of tag extraction for test purposes.

Usage

The script will run and process an image during Post-Process. It is controlled by 
the ExifRules.txt file. If no ExifRules.txt file exists then a simple default 
command line from the script can be used instead.

Each line in the Rules file can contribute command line parameters to the 
exiftool.exe.

The simplest rule is just to write a Tag with a new value.

Instructions="Processed by OptiInk"

The - is the start of the parameter, Instructions is the TagName and the text is the 
new value. If the text includes spaces then it must be included in quotes.

Rules may include references to existing Tag data by enclosing them in <>. In 
this case the script will extract the current values and include that in the 
command line. For example if you wish to copy the value in the SpecialInstruc-
tions Tag to Instructions and add on new data then the rule would be like.

Instructions="<SpecialInstructions> Processed by OptiInk"

Rules may also be constructed as vbScript lines to allow more complex opera-
tions. These will be evaluated first. A line beginning with a " triggers the 
evaluation. So to add calculated data on a separate line in instructions the rule 
might be like
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"-Instructions=""<SpecialInstructions>" & vbCR & " Processed at " & Now() & """"

NOTE: When quotes are needed inside a string, then "" is used.

NOTE: See the exifTool documentation for advanced command line parameter 
usage.

Structure

The exifTool.vbs Script consists of a main routine which gets its parameters, 
parses the Rules file, runs exiftool.exe to extract tags into a dictionary if needed, 
processes the rules to construct an exiftool command line and then runs the 
exiftool program itself.

It has the following functions

GetParameters to get its own parameter.

GetRules to read the ExifRules.txt file. This also establishes whether tag 
value substitution may be needed.

ProcessRules builds an exiftool command line from each rule.

ReplaceTags substitutes tag values in rules as required.

GetTags uses exiftool to extract all tags and move them into a dictionary for 
substitution use. Tag Names are space stripped and converted to Upper case.

InitLogging initializes the logging function.

WriteLog writes a log line.

ImageMagick Conversion

ImageMagick is a publicly available utility which may be used to support a wide 
range of image formats.

The example script HF02_ImageMagick.vbs is designed to be used as a hot 
folder script or a MoveBy PostProcess script that can use this utility to convert 
formats of files and extend the range of formats supported by OptiInk.

As an input script it can be used in place of the standard PSConvertToPDF.vbs 
script or as a new selected script if used with ITX/OptiInk v2.1 or later. PS to PDF 
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conversion is also supported by this version but in addition new single image 
formats supported by ImageMagick can be converted through to formats 
supported by OptiInk.

As a PostProcess script it is used as a MoveBy script to perform format conversion 
as a file is moved to its final output.

Install

To install ImageMagick scripting

Copy PSConvertToPDF+IMageMagick.vbs to the _scripts folder under the 
filestore

To use as an input script rename it to PSConvertToPDF.vbs if using earlier 
software systems. For later versions you could for example name it 
HF02_ImageMagick.vbs and select it with the new combo-box control. 

To use as a PostProcess script rename it to MoveByScript.vbs. You may need 
to remove an existing script of this name. The CONVERT_MODE_IM 
constant at the top of the script needs to be set equal to 2. Note that input and 
PostProcess scripting may be done in the same installation.

Download the windows executable version of ImageMagick from the 
Internet and install using the default settings. (http://
www.imagemagick.org/script/index.php)

For input usage enable PS to PDF conversion on appropriate hot folders

For PostProcess usage add a Move

If script logging is required then create a text file called PSConvertLog.txt in 
the _scripts folder

Usage

The script will run and convert image formats during either scan input or post-
process.

By default it will convert .png and .gif files on input to jpg format leaving the 
original naming. On output it will convert files called png and gif back to their 
native format.

Script configuration

Extra formats and control of naming may be added by changing some script 
constants at the start of the file.
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CONVERT_MODE_PS - This controls the PS to PDF functionality. Set to 1 for 
Ghostscript, 2 for Distiller, or 0 to disable PS conversion.

CONVERT_MODE_IM - This controls the Image conversion functionality. Set 
to 1 for Input conversion, 2 for PostProcess conversion, or 0 to disable 
conversion.

EXT_CONVERT1 is a string which controls the input format conversion. It is 
a CSV list with each entry having 4 or 5 fields. These are input extension, 
input format, output extension, output format, and optional parameters. The 
default is "png:png:png:jpg,gif:gif:gif:jpg:" This means that png and gif are 
converted to jpg format but the extension name is left as the original. The 
Extension name may be set to something different; e.g., png:png:jpg:jpg 
would convert a png to a jpg. The original png job is then purged and a new 
job created using the renamed file.

Const EXT_ CONVERT2 is a string which controls the PostProcess format 
conversion. It is a CSV list with each entry having 4 or 5 fields. These are 
input extension, input format, output extension, output format, and optional 
parameters. The default is "png:jpg:png:png:,gif:tif:gif:gif:"This means that 
internal jpeg job files labelled as png or gif are converted to jpg format and 
the extension name are left as the original. 

Structure The PSConvertToPDF+ImageMagick.vbs Script consists of a main routine 
which gets its parameters, compares format types and runs appropriate conver-
sion routines.

It has the following functions:

GetArguments to get it's the input parameters from the application. This also 
supports a local test mode if the script is run by double clicking and it will 
then ask for the arguments in turn.

CheckInputFileType checks the extension of the input file type and deter-
mines what type of conversion to do. It also generates the names required for 
the rest of the script operation.

Rename is a hook function which may be used to insert extra naming of the 
output file when used as a MoveBy Script. It is passed the original filename 
and also the name as configured on the Output process. It may manipulate 
both of these to produce a final output name. If it returns an empty string 
then the operation is skipped.

ProcessOutputFile performs the file renaming and clean up after conversion 
completes
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ConvertImage performs the Imagemagick conversion

ConvertGhostscript performs a PS to PDF conversion using Ghostscript

ConvertDistiller performs a PS to PDF conversion using Distiller

ProcessDistillerLog collects logging if Distiller is used.

CleanServerName cleans up supplied UNC Names

FindCmd is used to find the location of the highest version of Ghostscript or 
Imagemagick installations. By default these are searched in the default 
Program Files folders. Additional search paths may be added by editing the 
CMD_SEARCHPATH at the top of the script.

FindCmdInFolder supports the FindCmd function to locate a version of the 
cmd in a folder

GetProgramFilesPath gets the default Program Files path

InitLogging initializes logging

WriteLog writes a single log message

ImageMagick Watermarking

ImageMagick is a publicly available utility which may be used to support a wide 
range of image processing operations including watermarking.

The example script IMWatermark.vbs is designed to be used as a MoveBy 
PostProcess script that can use this to add watermarks to processed images.

It can also be used as a selected Postprocess script but in this case the watermark 
will be added to the image file in the filestore. Care must then be taken in the 
order of operations in the postprocess if both watermarked and non watermark 
versions are required.

Install

To install ImageMagick scripting:

Copy IMWatermark.vbs to the _scripts folder under the filestore

To use as an moveby script rename it to MoveByScript.vbs.
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To use as a PostProcess then select a script operation in post processing and 
select the IMWatermark script.

Download the windows executable version of ImageMagick from the 
Internet and install using the default settings. (http://
www.imagemagick.org/script/index.php)

If script logging is required then create a text file called WatermarkLog.txt in 
the _scripts folder

Usage

The script will run and add watermarks during the post-process.

Watermark Configuration

The method and content of the watermarking process may be configured by 
changing some script constants at the start of the file.

WATERMARK_TEXT - This provides the content of any text based water-
mark. It can contain some variables described below which will be 
substituted dynamically as each watermark is produced.

WATERMARK_IMAGE - This selects the file to be used for image based 
watermarking. The filename is expected to be in the same folder as the script. 

WATERMARK_FONT is a string which controls the text formatting in text 
based watermarking commands. It actually substitutes the %%f variable in 
the watermarking control strings. It can select font name, point size and 
other controls like bold/italic. By default it is selects a 24 point version of the 
standard font.

WATERMARK_POSITION is a string which controls the positioning of the 
watermark on the image. It actually substitutes the %%g variable in the 
watermarking control strings. It can select the general area using the -gravity 
control (North, South, East, West, NorthWest, NorthEast, SouthWest, South-
East, Center). Offsets and absolute positions can also be used. 

IM_WATERMARK is the string used to control the ImageMagick water-
marking operation. A huge range of different watermark types can be 
generated by setting this string. The default script contains a number of 
different examples and one of these can be activated by un-commenting it 
(removing the ') and ensuring that all other equivalent lines are commented. 
The examples are described below.
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Example Watermark Methods

Splice Plum - this method adds a plum colored horizontal strip at the bottom 
of the image and adds the watermark text in this strip. It annotates the image 
but can be easily removed. 

Simple Outline - this method adds outlined watermark text over the image. 
It may be more difficult to read in busy images.
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Undercolour box - this method adds text inside an undercolor box over the 
image and this makes the text easily readable.

Simple image overlay - this method does a simple overlay of a watermark 
image onto the main image.
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Watermark image overlay - this method uses a watermark overlay of a water-
mark image onto the main image to make it less intrusive.

Dissolve image overlay - this method uses a dissolve overlay of a watermark 
image onto the main image to make it less intrusive.
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Bump map image overlay- this method uses a watermark image as a bump 
map onto the main image to mask using the gray scale values in the water-
mark image. By using mid tones grays in the watermark a subtle 
watermarking can be achieved.

New watermark command strings can be added if one checks out the avail-
able ImageMagick commands and parameters. It would also be possible to 
combine methods to achieve both image and text effects.

Structure

The IMWatermark.vbs Script consists of a main routine which gets its parame-
ters, formats an appropriate ImageMagick command line and then executes it.
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It has the following functions:

GetArguments to get it's the input parameters from the application. This also 
supports a local test mode if the script is run by double clicking and it will 
then ask for the arguments in turn.

WatermarkImage builds the command string by substituting parameters and 
then calls Imagemagick to perform the watermarking process

MoveToOutput performs the file renaming and clean up after the water-
marking completes

Rename is a hook function which may be used to insert extra naming of the 
output file when used as a MoveBy Script. It is passed the original filename 
and also the name as configured on the Output process. It may manipulate 
both of these to produce a final output name. If it returns an empty string 
then the operation is skipped.

GetDateString is used to format a date to be used in etxt watermarking

CleanServerName cleans up supplied UNC Names

FindCmd is used to find the location of the highest version of Ghostscript or 
Imagemagick installations. By default these are searched in the default 
Program Files folders. Additional search paths may be added by editing the 
CMD_SEARCHPATH at the top of the script.

FindCmdInFolder supports the FindCmd function to locate a version of the 
cmd in a folder

GetProgramFilesPath gets the default Program Files path

InitLogging initializes logging

WriteLog writes a single log message

XMLArchive

This script allows XML files that create jobs to be archived. It relies on a feature 
present in OptiInk/ITX that places the XML file in the filestore rather than 
deleting it after it has been read. This script will NOT work with earlier versions.

The XMLArchive.vbs script exiftool.vbs is designed as a post-process script that 
can copy the xml file in the filestore out to a new location.
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Install

To install XMLArchive.vbs:

Copy XMLArchive.vbs to the _scripts folder under the filestore.

Configure a Post-Process step to call XMLArchive.vbs. This may be done at any 
point in the sequence. Two types of configuration are possible (see usage 
below).

Edit the ExifRules.txt to perform the operations required.

Usage

The script can be run as a named PostProcess script, or by using the MoveBy-
Script method (see below).

NOTE: XML files which are matched against filenames can consist of either 
file.ext.xml or file.xml. The script does not know which method was used. By 
default, it will archive the xml as file.xml. You can change this behavior by setting 
the APPEND_XML constant at the top of the script equal to True. In this case, all 
xmls will be archived as file.ext.xml.

Script Method

Add a PostProcess script function, and select the XMLArchive.vbs script.

The script will be called and will archive any job xmls to an archive folder, which 
is defined in the script. This defaults to C:\temp\. To change to a different 
location, edit the constant XML_ARCHIVEFOLDER at the top of the script.

The script does support copying to multiple archive locations by configuring a 
list of folders as a CSV list.
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MoveByScript Method

Rename the script to MoveByScript.vbs, and select the Move Result to Folder as a 
separate PostProcess step.

NOTE: The script will NOT move the result; it will still copy any Job.xml file. You 
still need to have the normal Copy Result to Folder.

The advantage of using this message is that it will archive the XMLs to the 
storage area set up next to the Move Result function; and the script does not 
need to be configured. It can be used multiple times in different places to archive 
to different folders configured in each postprocess step.

The disadvantage is that there is only one MoveByScript function; and so if used 
for XML archiving, it cannot be used for anything else.

Structure

The XMLArchive.vbs script consists of a main routine that gets its parameters; 
constructs the XML file it expects to find in the filestore and its archive name; 
and copies this file, if present. It has the following functions:

GetArguments to get its own parameters.

CleanServerName sanitizes server names and paths from the parameters.

GetJobXMLName constructs the expected xml filename in the filestore.

GetArchiveXMLName constructs the name to be used in the XML archive.

InitLogging initializes the logging function, which will log if 
XMLArchiveLog.txt is present in the script folder.

WriteLog writes a log line.
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Testing Folder List as a CSV List

NOTE: The CSV list of folders only applies to the Script method.

1 Edit the XMLArchive.vbs script with a text editor, and change the line 
Const XML_ARCHIVEFOLDER = "C:\temp\"

For example:

Const XML_ARCHIVEFOLDER = "C:\temp\temp1,C:\temp\temp2\"

2 This will copy each xml file to the two folders in the list. The folders must 
exist. Any folder not present will be skipped.

NOTE: These add on scripts are not part of the main product installer.
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